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Chapter 1: Introduction

Infor VISUAL™ for Project-Based Manufacturers and Infor VISUAL Aerospace & Defense™ are long-
range project planning tools incorporating Infor’s standard enterprise functionality. 

In this guide, the two products are referred to collectively as Projects/A&D.

This chapter includes:

Topic Page 

What is Projects/A&D? ................................................................................................................... 1–1
Overview of Project Components and Relationships...................................................................... 1–2
Mixed Mode Accounting: Project vs. Non-Project........................................................................... 1–3

What is Projects/A&D?
The Projects/A&D components of VISUAL integrate seamlessly with the standard manufacturing 
functionality. The Projects/A&D components include: 

• Contract Management and Administration
• Program Management
• Bid and Proposal Support
• Project Planning and Control
• Integrated Work Breakdown Structure
• Microsoft(TM) Project Integration
• Material Management and Accounting by Project
• Advanced Overhead and Burdening Support
• Reporting and Analysis
• Earned Value Management
• Project Estimate to Complete
• Revenue Recognition
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This application allows you to precisely track all project data and manage costing, materials, 
resources, and suppliers. At a project level, you can quickly access engineering, shop floor, 
accounting, purchasing, and shipping information. VISUAL – Projects/A&D ensures system and data 
integrity so that you can deliver products on time and to strict specifications. 

You can also track the progress of a project through VISUAL – Projects/A&D Work Breakdown 
Structures (WBS). A WBS can be a concrete deliverable, such as the manufacture of a certain 
product, or can be a process, such as project management.

Overview of Project Components and Relationships
Because Project functionality is interwoven with standard VISUAL functionality, it is important to 
understand the relationships between the components of VISUAL’s Project and execution systems.

The figure below shows an overview of this integration.

Use the Project Window to establish the reporting structure of your contract or project. Projects 
represent contracts or any other work initiatives you need to manage, such as capital improvements, 
research and development, or product builds.

Use Work Breakdown Structures (WBSs) to break projects into manageable components. You can 
then break WBS elements into their lowest level for cost accumulation.

Customer orders represent “Contracts” and the individual lines on each customer order represent 
Contract Line Item Numbers (CLINs). As the planning system in VISUAL converts demand into 
supply, the project, WBS, and task links are maintained throughout the system.

VISUAL also:

• Links inventory transactions to projects to ensure proper asset management and control
• Establishes Project warehouses to maintain inventory by project.

Project Structure

WBS 1.0

WBS 2.0

WBS 1.1

Task

WBS 1.2

Customer Order

CLIN 001

CLIN 002

Part ID

Engineering Master

Sub Level 1Work Order 1

Work Order 3

Work Order 2Task

Task

Task

CLIN 003

Project ID

Sub Level 2

Sub Level 3

Prototype

Documentation
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Linking work orders and purchase orders to projects allows you to directly link labor and material 
purchases to those Projects and to VISUAL’s integrated Project Accounting System. In addition, you 
can charge labor or purchased goods directly to projects outside the formal planning system.

The diagram below shows the cost flow from manufacturing and purchasing.

Use the Project Summary Window or the budget tabs in the Project window to develop the project 
budget. The project manager can also use the Project Summary window to view actual project costs 
and use VISUAL's Earned Value Management Tools to determine the project's progress against plan.

The diagram below illustrates the overall flow of information within VISUAL's Project environment. 

Mixed Mode Accounting: Project vs. Non-Project
Both project and non-project accounting environments are supported within the same database in 
VISUAL. In a non-project environment, general accounting traces the following path:

1 Purchase material to inventory

2 Issue material to Work in Process

3 Transfer finished product into finished goods inventory

Project ID -
Project Structure

Inputs

WBS 1.0

WBS 2.0

WBS 1.1

WBS 1.2

Material

Labor

Outside Service PO

PO

A/P

Project
Stores

Task

Task

Task

Work
Order 1

Other Direct Charges

ECN

Project
Maintenance

Contract Entry
(Customer Order)

Project Summary

Budgets

Rate
Management

Applying
Actual Costs
 & Burdens

General
Journal
Entry

General
Ledger

Project Window

WBS
Codes

Project Stores
(Warehouse)

Lines =
Deliverables

(MRP)

RFP Info Entry

Contract and
Project

Information

Terms and
Conditions

Accounts
Payable

Entry

Earned
Value

Balances

ETC

Earned
Value

Quantity
MS

Project

Work Orders
by WBS

CLIN

Demand
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4 Upon shipment, the costs from Finished Goods are transferred into Cost of Goods Sold. At this 
point, you bill the customer and the revenue is recognized. 

During these non-project transactions, the G/L accounts are maintained at the part level, then product 
code level, and lastly via the G/L interface.

Within a project environment, the accounting rules are different:

When you bring material to a project—regardless of whether that material physically sits in project 
inventory or you issue it to a project work order—the costs are typically assigned to Project work in 
process. For internal company projects, these costs may go directly to an expense account. 

When you ship goods against a project, a billing and/or revenue recognition event and simultaneous 
booking to cost of goods sold may or may not be triggered. Therefore, the G/L accounts for project 
transactions are maintained within the Project G/L Mapping window.

While the G/L accounts used and the flow of costs within VISUAL differs for projects and non-
projects, the rates and application of overhead/burden calculations must be consistent throughout the 
system. Overhead calculations for the commercial or non-project side of your business are correctly 
processed via mappings to a project type that you mark as being Commercial. Even if all of your 
business is project oriented, you may purchase material to common inventory and then issue to 
projects as you need. If this is the case, you should handle these purchases as Commercial. You may 
also want to handle the sale of spare parts after project completion in the same manner.
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Chapter 2: Getting Started and Setting Up

In this chapter, you will learn how to set up basic information that may be common to multiple 
projects. This chapter includes:

Topic Page

Licensing......................................................................................................................................... 2–2
Setting Up Costing in Accounting Entity Maintenance.................................................................... 2–3
Setting Up Information in the Project Maintenance Window........................................................... 2–5
Setting Up Information in Direct Cost G/L Mapping and Burden Mapping Maintenance .............. 2–10
Setting Up Information in the Rate Management Window............................................................ 2–20
Setting Up Distribution Codes....................................................................................................... 2–22
Setting Up the Default Project Warehouse Template.................................................................... 2–23
Creating Project Accounts ............................................................................................................ 2–25
Specifying Project Shop Resources ............................................................................................. 2–25
Working with Purchase Requisitions............................................................................................. 2–26
Setting Up Recurring General Ledger Transactions ..................................................................... 2–27
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Licensing
In Projects/A&D databases, all accounting entities should use the Actual costing method and the By 
Part Location FIFO method. To help ensure that databases comply with these conditions, these 
conditions apply when you work with licenses:

• If you apply a project or A&D license to a new baseline database, then only the Actual costing
method and By Part Location FIFO Method are available for selecting in Accounting Entity
Maintenance. All entities that you create in the baseline database must use these costing
settings.

• If you apply a project or A&D license to an existing, standard database, then the database is
checked for these items:
• Existing inventory, labor, and service transactions. If transactions are found, you cannot apply

the new license. 
• If no inventory, labor, and service transactions are found, then accounting entities are

checked to ensure that they use the Actual costing method and By Part Location FIFO
method. 

• If any of your entities do not use these Actual costing and By Part Location FIFO method, a
message is displayed. You must update your entities to use Actual costing and By Part
Location FIFO method before applying the project or A&D license.

• If you have already applied a Projects or A&D license to your database, you can apply an updated
Projects or A&D license to your database without limitation. 

• If you apply a standard license to an existing project or A&D database, then you cannot apply the
license if there are inventory, labor, or service transactions. 

Setting Up Costing in Accounting Entity Maintenance
Use Accounting Entity Maintenance to set up the costing settings that are required for Projects/A&D 
functions and to specify the POC revenue recognition type.

Setting the Costing Method and FIFO Method
To use Projects/A&D functionality, you must use the Actual costing method and the By Part Location 
FIFO Method / Inventory Grouping setting. If you use multiple entities, all entities must use the Actual 
costing method and Part Location FIFO method. If a particular entity does not engage in project work, 
that entity must still use the Actual costing method and the Part Location FIFO method. 

1 Select Admin, Accounting Entity Maintenance.

2 Click the Costing tab.
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3 Specify these settings: 

4 Click Save.

For information about the other options on the Costing tab, see "Specifying information on the Costing 
tab" on page 3–5 in the System-wide guide. 

Setting the POC Revenue Recognition Type
Percent of Completion or POC is a method of recognizing revenue and profit based on the 
percentage of completion against the job, prior to transferring the title of the goods to your customer.

On the Costing tab of the Accounting Entity Maintenance window, select the POC Revenue 
Recognition type you want to use for your projects. If you are licensed to use multiple entities, you can 
specify a different POC Revenue Recognition method for each of your entities. If you are licensed to 
use a single entity, you can use only one revenue recognition method for your enterprise.

There are two generally acceptable methods of POC Revenue Recognition Revenue First and Cost 
to Cost. For more information on POC Revenue Recognition, refer to the American Institute of 
Certified Public Accountants (AICPA)SOP 81-1.

The primary difference between the two revenue recognition methods is how direct cost and burden 
amounts are calculated. With the Revenue First method, costs are calculated by applying the POC to 
a pro-rated share of each cost source. With the Cost to Cost method, the actual costs incurred are 
included in the revenue calculation.

To choose a POC revenue recognition method, click one of these options:

Revenue First – When you click this option, total revenue to be recognized is calculated first by 
multiplying the total price of the contract by the percentage of completion. Then, the total costs 
incurred are calculated by multiplying the total costs in the EAC by the percentage of the total cost 
each cost area represents. Then, the product is multiplied by the percentage of completion. 

For example, presume your project has these costs and fees in the Estimate at Completion (EAC):

If the POC value at the end of the first period is 25%, then these calculations are made:

Section Setting

Costing Method Click Actual. Other costing methods are not 
supported with Projects/A&D functions.

FIFO Method/ Inventory Grouping Click By Part Location. 

Cost Source EAC Amount Percentage of total cost
Labor $2,500 31.25%
Material $4,000 50%
Services/Other Direct Costs $500 6.25%
Burden $1,000 12.5%
Total Cost $8,000
Fee $2,000
Total Price $10,000
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$10,000 * 0.25 = $2,500. The total revenue recognized for the period is $2,500. The $2,500 includes 
these costs:

Labor = $8,000 * 0.3125 * 0.25 = $625

Material = $8,000 * 0.5 * 0.25 = $1,000

Services/ODC = $8,000 * 0.0625 * 0.25 = $125

Burden = $8,000 * 0.125 * 0.25 = $250

Total costs to be recognized = $2,000

To calculate the total fee recognized, the total costs recognized are subtracted from the total revenue 
recognized:

$2,500 - $2,000 = $500

In subsequent periods, the same calculations are made, then any previously recognized revenue is 
subtracted. For example, if the POC value at the end of the second period is 35%, these calculations 
are made:

$10,000 * 0.35 = $3,500. The total revenue recognized is $3,500 minus the $2,500 already 
recognized, or $1,000. The $1,000 includes these costs:

Labor = $8,000 * 0.3125 * 0.35 = $875. $875 - $625 previously recognized = $250 recognized in 
second period.

Material = $8,000 * 0.5 * 0.35 = $1,400. $1,400 - $1,000 previously recognized = $400 recognized in 
second period.

Services/ODC = $8,000 * 0.0625 * 0.35 = $175. $175 - $125 previously recognized = $50 recognized 
in second period.

Burden = $8,000 * 0.125 * 0.35 = $350 minus $250 previously recognized = $100 recognized in 
second period. 

Total costs to be recognized in second period = $800.

To calculate the total fee recognized, the total costs recognized for the period is subtracted from the 
total revenue recognized for the period:

$1,000 - $800 = $200

In summary, these are revenue amounts recognized for the two periods:

Cost Source EAC 
Amount

Percentage 
of total cost

Period 1 
Revenue 
(25% POC)

Period 2 
Revenue 
(35% POC)

Labor $2,500 31.25% $625 250
Material $4,000 50% $1,000 400
Services/Other Direct Costs $500 6.25% $125 50
Burden $1,000 12.5% $250 100
Total Cost $8,000 $2,000 $800
Fee $2,000 $500 $200
Total $10,000 $2,500 $1,000
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Cost to Cost – When you click this option, revenue recognized for a period is comprised of the actual 
costs incurred plus a fee amount based on the POC. For example, presume your project has these 
costs and fees in the EAC:

In the first period, you incur these costs:

To calculate the fee amount to recognize, the total fee specified on the EAC is multiplied by the POC:

$2,000 * 0.25 = $500

The total amount recognized is $2,000 + $500 = $2,500.

In subsequent periods, the same calculations are made, then any previously recognized revenue 
amounts are subtracted.

Setting Up Information in the Project Maintenance Window
Use the Project Maintenance window to set up the following information:

• Contract Types
• Project Types
• Terms and Conditions
• Divisions
• Priorities
• Security Classes
• Summary Codes

To access the Project Maintenance Window, from the Project Menu, select Project Maintenance.

Cost Source EAC Amount
Labor $2,500
Material $4,000
Services/Other Direct Costs $500
Burden $1,000
Total Cost $8,000
Fee $2,000
Total Price $10,000

Cost Source Actual Cost
Labor $250
Material $1,500
Services/Other Direct Costs $125
Burden $125
Total Cost $2,000
POC for period $25%
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Setting Up Contract Types
Contract Type codes represent the billing methods you use for your projects. For each type of 
contract you enter, you can select the basis on which you want your billing and revenue figures 
calculated.

To set up Contract Type codes:

1 From the Project Maintenance window, select Maintain, Contract Types....

2 Click the Insert button.

3 Enter the ID and Description you want to use for the Contract Type.

4 Click the arrow in the Contract Category column and select the contract category you want to use 
for this contract type.

Firm Fixed Price - Select Firm Fixed Price if the contact specifies a set amount.

Fixed Price/Cost Based Incentive Fee - Select Fixed Price/Cost Based Incentive Fee if the 
contract specifies a fixed price along with the potential for additional fees.

Fixed Price Award/Performance Based Fee - Select Fixed Price Aware/Performance Based 
Fee if the contract specifies a fixed price along with the potential for additional fees based on 
performance.

Fixed Price Other - Select Fixed Price Other for all other types of fixed price contracts.

Cost Plus Fixed Fee (CPFF) - Select Cost Plus Fixed Fee if your contract specifies a fixed fee 
with estimated costs. 

Cost Plus/Cost Based Incentive Fee (CPIF) - Use this contract type if your contract outlines a 
target cost, target fee, minimum and maximum fee, fee adjustment formula and cost incentives.

Cost Plus Award/Performance Based Fee (CPAF) - Use this type if your contract is made up of 
reimbursement of costs, a minimum fee, and an award fee.

Cost Reimbursable - Other - Use this type for all other cost-based contracts.

Time and Material (T&M) - Use this type if your contract charges direct labor costs and fixed 
hourly rates along with materials at cost.

5 Click the arrow in the Revenue Basis column and select the basis on which you want to collect 
revenue for this contract type.

Percentage of Completion - Select Percentage of Completion to recognize revenue at pre-
defined percentage of completion points. The POC Revenue Recognition selected in Accounting 
Entity Maintenance is used to determine on what basis the revenue will be recognized.

POC - Revenue First - If your system specifies POC revenue recognition based on Cost-to-Cost 
in Accounting Entity Maintenance, select POC - Revenue First to override the setting. 

POC - Cost-to-Cost - If your system specifies POC revenue recognition based on Revenue First 
in Accounting Entity Maintenance, select POC - Cost-to-Cost to override the setting.

For more information on setting the system-wide POC revenue recognition type, refer to “Setting 
the POC Revenue Recognition Type,” on page 2–3.

Shipment - Select Shipment to recognize revenue upon shipping deliverables.
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Billing Event - Select Billing Event to recognize revenue upon billing for the project.

Manual - Select Manual to recognize revenue at points of your choosing.

6 Click the arrow in the Billing Basis column and select the basis on which you want to bill for this 
contract type. This field is informational only and has no impact on how invoices are generated in 
Project Billing Entry. 

Cost Plus Earned Fee - Select this type if you would like to bill based on costs incurred and 
percentage of fee earned at the point of invoicing. 

Cost (Time and Material) - Select this type to bill for actual costs.

Progress (Cost Based) - Select this type for cost-based projects that you bill at specified points 
during the project. 

Shipment - Select this type if you prepare the invoice upon shipment.

Milestone (Performance Based) - Select this type to bill at the completion of milestones in 
performance-based contracts.

Miscellaneous - Select Miscellaneous for all other billing basis types.

7 Click the arrow in the Fee Basis column and select the basis on which you want to charge your 
fees for this contract type.

• Incentive (performance based)
• Fixed Percentage
• Fixed Amount
• Award

8 Click the arrow in the Invoicing Method column and select the method you want to use for 
invoicing for this contract type.

1443 Progress Payment Fixed Price - Select this type if you have successfully submitted FAR 
1443 with the government to employ progress billing on a fixed price contract.

1034 Public Voucher Cost Reimbursable - Select this type if you are using US Government 
form 1034 to bill for costs.

1034 Public Voucher Time and Material - Select this type if you are using US Government form 
1034 to bill for time and material.

Standard Invoice on Shipment - Select this type if you are going to issue a standard invoice 
upon shipment of the project deliverable.

Manual - Select this type to invoice the customer manually.

PBP Form Master - Select this type if you are using the US Government’s performance-based 
payment form.

645 Foreign Military Sales - Select this type if you are using US Department of Defense form 
645 for invoicing foreign military sales transactions.

9 Click the Save button.

10 When you have finished entering Contract Type Codes, click the Close button.
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Setting Up Project Types
Project Type Codes represent the types of projects you use, for example:

• Individual Government contract
• Long term commercial contracts that you are able to progress bill
• Capital projects such as building expansion efforts
• Indirect projects such as ISO certification efforts

Note: Because you can use Project Type codes to segregate project costs in your General Ledger, 
you should give careful consideration to the codes you define.

To set up Project Type codes:

1 From the Project Maintenance window, select Maintain, Project Types.... 

2 Click the Insert button.

The next available row in the table appears highlighted.

3 Enter the Code and Description you want to use.

4 If you will be using this project type to specify a non-project oriented job, click the Used for 
Commercial button.

Burdens are calculated using the same methodology regardless of your project or non-project 
(commercial) work. You may want to set up a project type for non-project work so that your non-
project costs can be correctly burdened and those costs can be assigned to the appropriate 
Burden G/L account.

Note: You can only mark one project type as Used for Commercial. You cannot change the Used 
for Commercial designation if there are transactions associated with any project type code.

5 Click the Save button.

6 When you have finished entering Project Type Codes, click the Close button.

Setting Up Terms and Conditions
Terms and Conditions are the policies and requirements you want to use for your projects.

To set up terms and conditions:

1 From the Project Maintenance window, select Maintain, Terms and Conditions....

2 Click the Insert button.

3 Enter a unique identifier for the new term in the ID column.

4 Click in the Description column and enter a description for this term.

5 Click in the Print On column, click the arrow and select on what you want the Terms and 
Conditions printed.

You can select:
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Traveller – Print on the Work Order Traveller only.

Purchase Order – Print on the Purchase Order only.

Traveller and Purchase Order – Print on both the Work Order Traveller and Purchase Order.

You can also leave this field blank.

6 Click the Save button.

7 When you have finished entering terms and conditions, click the Close button.

Setting Up Divisions
Division codes represent the actual divisions of your company you want to use for reporting purposes.

To set up Division codes:

1 In the Project Maintenance window, select Maintain, Divisions....

2 Click the Insert button to add a row in the table.

3 Enter the Code and Description you want to use.

4 Click the Save button.

5 When you have finished entering Division Codes, click the Close button.

Setting Up Priorities
Priority codes represent the various levels of priority you want to use for your projects. For the 
Aerospace and Defense industry, you may want to enter your DCAA priority codes.

To set up Priority codes:

1 In the Project Maintenance window, select Maintain, Priorities....

2 Click the Insert button to insert a row in the table.

3 Enter the Code and Description you want to use.

4 Click the Save button.

5 When you have finished entering Priority codes, click the Close button.

Setting Up Security Class Codes
Security Class codes represent the levels of security with which you can class the security of your 
projects, such as Classified and Unclassified.

To set up Security Class codes:
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1 In the Project Maintenance window, select Maintain, Security Classes....

2 Click the Insert button to add a row to the table.

3 Enter the Code you want to use.

4 Click the Save button.

5 When you have finished entering Security Class codes, click the Close button.

Setting Up Summary Codes
Summary codes represent the types of project work you want summarized in your project reports.

To set up Summary codes:

1 In the Project Maintenance window, select Maintain, Summary Codes....

2 Click the Insert button to add a row to the table.

3 Enter the Code and Description you want to use.

4 Click the Save button.

5 When you have finished entering Summary codes, click the Close button.

Setting Up Information in Direct Cost G/L Mapping and 
Burden Mapping Maintenance
Use the Direct Cost G/L Mapping and Burden Mapping Maintenance window to set up the following 
information:

• Business Lines
• Project Types (you can also access Project Types from the Project Maintenance window)
• Department Codes (you can also access Department Codes from Application Global

Maintenance)
• Cost Categories
• Cost Groups
• Burden Categories
• Burden Groups
• General Ledger Burden Mappings

Use the GL/Burden mapping window to specify the accounts you want to use for which departments 
and the burdens you want used for its calculations.

Note: Because you are allowed to segregate costs by general ledger account as they relate to Project 
Type/Department combinations, you should give careful consideration to how you classify Cost 
Groups and Burden Categories.
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The following flowchart illustrates G/L Burden Mapping relationships:

To access the Direct Cost G/L Mapping and Burden Mapping Maintenance window, select Project, 
G/L Burden Mapping Maintenance. 

Setting Up Business Line Codes
Business Line codes represent the different segments of your company you want to use for reporting 
purposes.

To set up Business Line codes:

1 From the Direct Cost G/L Mapping and Burden Mapping Maintenance window, select Maintain, 
Business Lines....

2 Click the Insert button to add a row to the table.

3 Enter the Code and Description you want to use.

4 Click the Save button.

5 When you have finished entering Business Line Codes, click the Close button.

Assigning Accounts to Business Line Codes
For each business line, you can assign accounts to each of the various billing and revenue types you 
use.

To assign an account to a billing or revenue type:

1 In the upper pane, select the business line to which you want to assign accounts.

2 In the lower pane, click on the revenue or billing type.

3 Double-click the Account ID column header and select the account you want to use.

4 Click the Ok button.
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5 Click the Save button. 

6 When you have finished assigning accounts to billing and revenue types, click the Close button.

Setting Up Project Types
To access the Project Types table from the Direct Cost G/L Mapping and Burden Mapping window, 
select Maintain, Project Types.... For information on how to use the Project Types table, refer to 
“Setting Up Project Types,” on page 2–8.

Setting Up Department Codes
Departments and Cost Categories determine where your costs are charged in your projects and 
general ledger.

Using the Department Maintenance table, you can create Department IDs to which you can report 
budget and actual costs “by department.” For reporting purposes, you can also set up subordinate 
departments so that you can have several departments report their budget and actual costs to one 
department.

Note: Because you are allowed to segregate costs on the general ledger through Project Type/
Department combination, take special care in deciding Project Type and Department.

Note: You cannot change a Department ID and its cost categories after it has been used in a 
transaction.

Adding Departments
To add Department IDs:

1 From the Direct Cost G/L Mapping and Burden Mapping Maintenance window, select Maintain, 
Departments....

2 Click the Insert button to add a row to the table.

3 Enter the identification you want to use for this department.

4 Press the TAB key and enter a description for this department in the Description column.

5 Click the Save button.

Note: You can also access the Department Maintenance table from the Application Global 
Maintenance window. From the main VISUAL window, select Admin, Application Global 
Maintenance. From the Application Global Maintenance window, select Maintain, Accounting 
Maintenance, Departments Table....
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Deleting Departments
You can only delete department IDs that do not have a transaction history. If a check mark appears in 
the department ID’s Has History column, you cannot delete the department ID.

To delete Department IDs:

1 Select the Department ID you want to delete by clicking on the row header.

The row appears highlighted.

2 Click the Delete button.

An X appears in the row header indicating you have marked the department for deletion.

3 Click the Save button.

If you attempt to close the table before saving, a Save Changes dialog box appears. 

4 Click the Yes button to save your changes. Click No to close the Department ID Maintenance 
table without saving your changes.

Specifying Subordinate Departments
For informational purposes, you may find it useful to have certain departments organized under a 
single, “parent” department. 

To set up subordinate departments:

1 Select the Department ID you want to use as the “parent” department by clicking on the 
department’s row header.

The row appears highlighted.

2 Click the Subordinate Departments button.

3 Click the Insert button.

4 Double-click the Department ID column header and select the subordinate department.

5 Click the Save button.

6 Click the Close button.

The Subordinate Departments table closes.

Setting Up a Default Department
The Default Department is the department used to track costs when you transfer inventory to and 
from non-project warehouses.

For project transfers, the default department specified in required WBS maintenance field is used. For 
more information, refer to “Specifying Cost Categories for Departments,” on page 2–16.
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VISUAL is designed to apply burden against initial transactions only. These transactions include: 
Inventory Adjustments In, Labor Transactions, Purchase Receipts, General Journal Entries and 
manual AP invoices linked to production.

"Move" transactions including Transfers, WIP Issues, Inventory Adjustments Out, Shipments, and 
Return transactions do not create burden in VISUAL. These transactions move costs at a summary 
level only. When the move transactions take place they create cost layers that summarize each cost 
component (Material, Labor, Burden, and Service/Other Direct Costs) on a General Ledger and Cost/
Burden Category level. 

In transfers, burden costs are assigned to only one burden category in a burden group. Costs are not 
assigned to all burden categories in a group. Not all of these transactions create project summary 
records.

Finished Goods and sub-assembly receipts from project work orders do not create burden. Inventory 
transactions for these records also display summary value for cost components. These transactions 
also do not create Project records.

The Default Department ID is used in the following places:

• Purchase Order Window
• Project Summary Window

To set up a default Department ID:

1 In the Department Maintenance table, click in the row header for the Department ID you want to 
make default.

2 Click the Set Default Department button.

A check mark appears in the appropriate Default check box.

You can only select one default department.

3 Click the Save button.

Note: You cannot change the default department after transactions exist.

4 Click the Close button.

The Department Maintenance window closes.

Setting Up Cost Categories for the Default Department
Note: You cannot perform this phase of the Default Department set up until you have completed 
setting up your Cost Categories. For more information, refer to “Setting Up Cost Categories,” on 
page 2–16.

Caution:  If you do not specify cost categories for your default department, VISUAL’s Costing 
Utilities may fail when you run WIP/FG Journal or Part Adjustment transactions.
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Setting Up User Dimensions for Departments
You can add departments to the user dimensions you created in the Accounting Window. 

To set up user dimensions for departments:

1 In the Department Maintenance dialog box, select the row containing the department you want to 
add to an existing user dimension. 

2 Click the User Dimensions... button. 

3 On the left pane of the User Dimensions for dialog box, click the user dimension you want to add 
to the department. If you want to add the department to a user dimension sub-category, click the 
user dimension, then expand the user dimension and select the sub-category.

4 In the table on the right, click the Insert button to insert a new row in the table.

Specify this information in the table:

Valid From – In the Valid From field, specify the date in which you want this user dimension to 
take effect for the department.

Debit – Double-click the Debit button, and select the user dimension debit information you want to 
add to this department.

Credit – Double-click the Credit button, and select the user dimension credit information you want 
to add to this department.

5 Click Save.

Setting Up Cost Groups
Cost groups are groups into which you place various types of costs.

Typically you should set up three types of cost groups for a department within a project—Material, 
Labor, and Other Direct Charges (ODC). 

To set up cost groups:

1 From the Maintain menu of the Direct Cost G/L Mapping and Burden Mapping window, select 
Cost Groups....

By default, the three typical cost groups are inserted.

2 To enter a new cost group, click the Insert button.

3 Enter the identification you want to use for this cost group.

4 Click in the Description column and enter a description for this cost group.

5 Click in the Type column and click the arrow that appears. Select the cost group type you want to 
use for this cost group.

You can select Labor, Material, or ODC.

6 Click the Save button.

7 When you have finished entering cost groups, click the Close button.
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Setting Up Cost Categories
Use Cost Categories to track costs by type, which helps you better budget your costs and track your 
project’s expenditures.

You will find Cost Categories in the following areas of VISUAL:

Purchase Order Lines – You can only assign material and ODC (Other Direct Costs) cost categories 
to your purchase order lines.

Shop Resource – You can only assign Labor and ODC cost categories to your shop resources.

Accounts Payable Lines – You can assign material, labor, and ODC cost categories to your 
accounts payable invoice lines.

General Journal Lines – You can assign material, labor, and ODC cost categories to your General 
Journal entry lines.

Product – When using Product Codes for your parts, you can assign cost categories to a Product ID, 
making it possible for you to budget and track your parts by category. You can only assign material 
and ODC cost categories to your Product IDs.

Labor Ticket Entry – You can only assign labor and ODC cost categories to your labor ticket entries.

Employee – You can only assign labor cost categories to your employees.

Note: You cannot change or delete Cost Categories if there are transactions associated with them. 
You also cannot change their spread types.

To set up cost categories:

1 From the Maintain menu of the Direct Cost G/L Mapping and Burden Mapping window, select 
Cost Categories....

2 Click the Insert button to add a row to the table.

3 Click in the ID column and enter an identification for this cost category.

4 Click in the Description column and enter a description for this cost category.

5 Double-click the Cost Group ID column header and select the cost group to which you want to 
associate this category.

6 Click in the Spread Type column and a drop-arrow appears. Click the arrow and select the spread 
type you want to use for this category. You can select either Hours or Amount.

7 Click the Save button.

If transactions have been processed using the cost category, the Has History check box is 
selected. Cost categories that have history cannot be changed.

8 When you have finished entering your cost categories, click the Close button.

Specifying Cost Categories for Departments
Departments and Cost Categories determine where your costs are charged in your projects and 
general ledger.
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Default Cost Categories for Transfers: 

For each department you use, establish three default cost categories: material, labor, and other direct 
charges (ODC). A default department is maintained in the WBS maintenance window for each 
project/WBS combination. When project transfers are processed, the default department is obtained 
from the associated WBS of the inventory being transferred or issued and obtains the applicable 
transfer cost categories from the Department table.

For more information, refer to “Setting Up Department Codes,” on page 2–12.

To specify Cost Categories for departments:

1 From the Maintain menu of the Direct G/L Mapping and Burden Mapping window, select 
Maintain, Departments....

2 Select the department whose Cost Categories you want to specify and adjust the table using the 
scroll bar until the Cost Category columns appear.

3 For each of the following, double-click the row header and select the Cost Category you want to 
use:

• Material Cost Category
• Labor Cost Category
• Service Cost Category

Note: Only the appropriate categories for the column you click appear.

4 When transactions have been recorded using the department ID, a check mark appears in the 
Has History column. If a check mark appears in the column, you cannot change the department 
ID’s cost categories. You also cannot delete the department.

If no check mark appears in the Has History column, you can change the cost categories 
associated with the Department ID. You can also delete the department ID if necessary.

5 Click the Save button.

6 When you have finished specifying Cost Categories, click the Close button.

Setting Up Burden Categories
Burden categories are groupings of similar burdens. Assigning burden categories helps you better 
assign specific sets of burdens for individual and multiple projects.

When your burdens are calculated, the groups of accounts from Infor VISUAL Financials are used to 
calculate a rate for each Burden Category.

The Cat Pool divided by the Cat Base is used to produce a burden percentage rate for the Burden ID. 
For example, if you select a Cat Pool of GROUP A and a Cat Base of GROUP B, the following 
calculation is performed:

To set up Burden Categories:

All of the figures from all of the G/L accounts in GROUP B
Burden
Percentage

All of the figures from all of the G/L accounts in GROUP A =
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1 From the Maintain menu of the Direct G/L Mapping and Burden Mapping Maintenance window, 
select Burden Categories....

2 Click the Insert button to add a row to the table.

3 Click in the ID column and enter an identification for this burden category.

4 Click in the Description column and enter a description for this burden category.

5 Click in the Apply Type column and select the type of burden you want to apply from the list that 
appears when you click the arrow.

Direct Overhead - Select Direct Overhead if the burden covers direct overhead costs.

Direct G & A - Select Direct G & A to assign a type of direct general and administrative costs.

COM Overhead - Select COM Overhead if the burden covers overhead related to cost of money.

COM G & A - Select COM G & A if the burden covers general and administrative costs related to 
the cost of money.

6 Click in the Cat Pool column and select the Cat Pool you want to use for this Burden Category.

Note: The accounts appearing in the Cat Pool and Cat Base drop-down lists are your VISUAL 
Financials accounting groups. For more information on Accounting Groups, refer to your Infor 
VISUAL Financials Administrative User’s Guide.

7 Click in the Cat Base column and select the Cat Base you want to use for this Burden Category.

8 Click the Save button.

9 When you have finished entering your burden categories, click the Close button.

Setting Up Burden Groups
Burden groups allow you to specify several burden categories, set up the different accounts you want 
to use for those categories, and group them together. Specifying the appropriate group allows you to 
consistently specify all of the associated burdens for several projects, thus allowing you to cost 
certain types of projects the same way.

When transferring project costs, burden costs are assigned to only one burden category in a burden 
group. Costs are not assigned to all burden categories in a group. 

Note: You cannot change or delete Burden Groups if there are burden transactions associated with 
them. The Has History check box is selected when burden transactions exist for the burden group.

To set up Burden Groups:

1 From the Maintain menu of the Direct G/L Mapping and Burden Mapping Maintenance window, 
select Burden Groups....

2 Click in the Burden Group ID field and enter an identification for this burden group

3 Press the TAB key and enter a description for this group.

4 Click the Insert button.

5 Double-click the Burden Category ID row header and select the category you want to use.
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The description automatically appears.

6 Double-click the Debit Account row header and select the debit account you want to use for this 
category.

7 Double-click the Credit Account row header and select the credit account you want to use for 
this category.

8 When you have finished entering categories for this group, click the Save button.

9 When you have finished entering groups, click the Close button.

Commercial (non-project) Burdening
Burdens are calculated using the same methodology regardless of your project or non-project 
(commercial) work. You must set up a project type for non-project work so that your non-project costs 
can be correctly burdened, and those costs can be assigned to the appropriate Burden G/L account. 
For more information on setting up the commercial project type, refer to “Setting Up Project Types,” 
on page 2–8.

Setting Up General Ledger/Burden Mapping
After you have set up your project accounts, use the GL/Burden mapping window to specify the 
accounts you want to use for which departments and the burdens you want used for calculations.

The GL/Burden mappings you set up depict how your monthly bills are calculated and to which 
accounts those figures are credited.

Note: You cannot change the cost group if any transactions reference the burden map. You cannot 
change the burden group if any burden transactions reference the G/L burden map. Burden 
transactions are generated during costing.

To set up GL/Burden mappings:
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1 Access the Direct Cost G/L Mapping and Burden Mapping Maintenance window. For more 
information on accessing this window, refer to “Setting Up Information in Direct Cost G/L Mapping 
and Burden Mapping Maintenance,” on page 2–10.

2 Click the Department ID button and select the department whose mappings you want to set up.

3 Click the Project Type button and select the project type you want to apply to this mapping.

4 To add a new mapping, click the Insert button.

5 Click the Cost Group ID button and select the Cost Group ID whose mapping you want to set up.

6 Click the Debit Account column header and select the debit account you want to use for this 
mapping.

7 Click the Credit Account column header and select the credit account you want to use for this 
mapping.

8 Click the Burden Group ID column header and select the burden group you want to use for this 
mapping.

9 To add more mappings, click the Insert button and repeat steps 5 through 8.

10 When you have finished setting up your GL/Burden mappings, click the Save button.

Setting Up Information in the Rate Management Window
Use the Rate Management window to set up the following information:

• Rate IDs
• Period IDs
• Rate Tables

To access the Rate Management window, from the Project menu select Rate Management.

Setting Up Rate IDs
If you are licensed to use multiple sites, set up rate IDs at the tenant level. The rate IDs you specify 
can be used in all of your sites. You can specify different values for each cost/burden category ID in 
each site.

To set up Rate IDs:

1 From the Rate Management window, select Maintain, Rate Table.

2 Click the Insert button to add a row to the table.

3 Enter the identification you want to use for this rate.

4 Click in the Description column and enter a description for this rate.

5 When you have finished entering Rate IDs, click the Save button.

The Maintain Rate ID window closes and the changes to your rate list are saved to your database.
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Setting Up Period IDs
Periods are the dates between which you want the rate to apply. 

If you are licensed to use multiple sites, set up period IDs on a site-by-site basis. Each site has its 
own period IDs.

To set up Period IDs:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are setting period IDs. If you are licensed to use a single site, this field is unavailable.

2 Select Maintain, Period Table....

3 Click the Insert button to add a row to the table.

4 Enter the identification code you want to use for this period.

5 Click in the Description column and enter a description for this period.

6 Click in the Start Date column and enter the date on which you want this period to begin.

7 Click in the Finish Date column and enter the date on which you want this period to end.

8 Select the Freeze Rates check box if you would like the freeze the rates used for the period. 
Selecting this option prevents the costing utilities from updating costs for the period based on the 
current active rate. For more information, refer to “Freezing Rates,” on page 5–16.

9 If you have chosen a rate to use as the actual rate for the period in the Rate Management 
window, the rate ID is listed in the Actual Rate column. 

10 Click the Save button.

Setting Up Rate Tables
When you perform budget calculations, the direct labor rates and burden factors you set up for each 
period in the Rate Management window are used. During actual cost calculations, only the burden 
factors from your rate table are used, and the labor rates from the Employee maintenance table are 
used. 

To set up rate tables:

1 From the Project menu of the VISUAL main window, select Rate Management.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are setting up rates. If you are licensed to use a single site, this field is unavailable.

3 Click the Rate ID button and select the rate whose table you want to set up. Click the OK button.

4 Click the Period ID button and select the period you want to use for this table. 

The dates for the period you select appear in the Start and Finish date fields.

5 Click the Insert Row button on the toolbar.

A new line appears highlighted in the table and the cursor appears in the Cost Cat ID column.

Note: If you use a Rate ID/Period ID combination in any of your budget spreads, Rate Table 
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Locked appears to the right of the End Date field of the Rate Management window. The Insert, 
Delete, and Save functions are also not available.

6 Double-click the Cost/Burden Cat ID column header and select the cost or burden ID you want to 
use for this line of the rate table.

7 Click in the Rate column and enter the rate you want to assign to this Rate ID/Period ID 
combination.

The description and rate type for the Category ID you selected automatically appear.

8 If you would like to use the selected rate as the rate for actual costs for the selected period, select 
the Use for period actuals check box. If you would like to use the rate for “what if” purposes, 
clear the check box.

9 When you have finished entering lines in your rate table, click the Save button on the toolbar.

Deleting Lines From Rate Tables
Note: You cannot delete Rate IDs you have previously used in any project’s budget.

To delete lines from Rate tables:

1 Open the Rate Management window and select the Site ID/Rate ID/Period ID combination that 
contains the rate you want to delete.

2 Click on the row header for the rate you want to delete.

The row appears highlighted.

3 Click the Delete Row button on the toolbar.

An X appears in the row header to indicate you have marked this Rate for deletion.

4 Click the Save button.

The Rate Management window deletes the rate information for the rate and period you selected.

Note: If you do not want to delete a Rate you have marked for deletion, click the Delete button 
again.

5 When you have finished deleting Rates, click the Close Window button, or from the File menu, 
select Exit.

Setting Up Distribution Codes
Use the Distribution Code Maintenance window to set up the budget distribution schemes you want to 
use for your projects.

Distribution intervals are the intervals on which you want your budget costs assigned to the 
appropriate budget line.
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For example, if you want to set up a simple two line 60%/40% distribution scheme, enter 60 in line 
one and 40 in line two. When you assign this to a $1000 budget line that is for two weeks, $600 for 
the first week and $400 for the second week are distributed.

If you have a ten line (10% each line) distribution scheme and assign it to a $1000, ten week budget 
line, $100 is distributed each week.

Note: Remember, your total Interval Percentages must add to 100%.

To enter Distribution Codes:

1 From the Project menu of VISUAL’s main window, select Project Summary Window.

2 From the Maintain menu, select Distribution Codes....

3 Click in the Distribution ID field and enter an identification number for this Distribution Code.

4 Press the TAB key or click in the Description field and enter a description for this Distribution 
Code.

5 Click the Status arrow and select the appropriate status for the Distribution Code.

6 Click the Insert Row button on the toolbar.

A blank row appears highlighted in the table.

7 Click in the Interval Percentage column and enter the percentage you want to use for this interval.

If you want to add more intervals, press the TAB key or click the Insert Row button on the toolbar.

A new highlighted row appears in the table where you can enter the appropriate percentage.

8 When you have completed entering all the interval percentages for this Distribution Code, click 
the Save button on the toolbar.

The Distribution Code Maintenance window saves the new code to your database.

If your Interval Percentages do not total 100%, a dialog box appears. Click the OK button and 
correct the Interval Percentages so that they add up to 100%.

9 If you want to enter more Distribution Codes, click the Clear button and repeat steps 3 through 8.

When you have finished entering Distribution Codes, click the Close button.

Setting Up the Default Project Warehouse Template
Each project you create must have its own warehouse. The name of the warehouse must match the 
name of the project. When you create a project, you will have the opportunity to create a warehouse 
at the same time. You may find it helpful to set up a default project warehouse template with common 
features that you plan to use in all of your projects. 

When you set up your default project warehouse template, designate the warehouse as 
Independently Planned. Independently planned warehouses cause the planning system in VISUAL to 
align supply with demand specific to the project.



2 – 24 | Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense 

You are not forced to select the Independently Planned check box for projects, but it is extremely 
important that you do select the check box. If you do not select the check box, you may run into 
issues as you administer the project. 

If you want to provide even stricter control and not allow one project’s inventory to be shared with 
another, you can mark the project warehouse as Does Not Share Inventory. This prevents any type 
of cross-warehouse transactions thus preventing the borrowing of inventory from one project for 
another. When you set a warehouse to Does Not Share Inventory, you can only issue the 
warehouse’s inventory to work orders related to the project. When you do not set this flag, you can 
issue parts from an alternative warehouse different from the project-associated warehouse.

Note: You can modify this control feature during the life of the project; for example, if you have 
completed a fixed price project and want the assets to be available to another project.

You can also plan for the purchase or manufacture of some parts to a project warehouse and for 
other parts to be purchased and fabricated in a common warehouse or company owned inventory. 
For more information, refer to “Linking Work Orders to Projects,” on page 4–17.

Creating the Default Warehouse Template
To create the warehouse you would like to use as the default warehouse template:

1 From the Inventory menu, select Warehouse Maintenance. The Warehouse Maintenance 
window appears.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for the template. 
You can create templates on a site-by-site basis only. A template you create in one site cannot be 
used in a second site. 

If you are licensed to use a single site, this field is unavailable.

3 Enter the new Warehouse ID.

4 Enter a description for the new warehouse in the description field.

5 If the warehouse is a VISUAL Distribution warehouse, select the VDW Installed check box. VDW 
warehouses can only be used in conjunction with VISUAL Distribution.

6 Select the Independently planned warehouse check box.

7 If you would like to exclude the warehouse from consideration during material resource planning, 
select the MRP Exempt check box. If you would like to consider the warehouse during material 
resource planning, clear the MRP Exempt check box.

8 If the warehouse supports WIP/VAS, select the WIP/VAS Supported check box. WIP/VAS must 
be activated in Accounting Entity Maintenance.

9 Click the Inventory Not Shared arrow to define whether or not the warehouse shares its 
inventory. Select Y if the warehouse does not share inventory. Select N if the warehouse does 
share inventory.

10 Click on the Insert Row button. A new entry appears in the location table.

11 Enter the Location ID for the location you are creating within the warehouse.
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12 Select the type for the location from the Type drop down section. Select from Regular, Floor, or 
Transit. The From Customer and From Vendor types are reserved for use with consignment 
warehouses. For more information on consignment warehouses, please consult your Infor 
VISUAL Manufacturing User’s Guide.

13 Enter a description for the location in the Location Description column.

14 You can continue to enter additional locations by clicking the Insert Row button and repeating 
steps 9 through 12.

15 Click the Save button to save the warehouse information.

Designating a Warehouse as the Default Warehouse Template
After you create the warehouse you would like to use as the default, designate the warehouse as the 
default through the Defaults tab of VISUAL’s Site Maintenance window. When you create a new 
project and a new project warehouse, the default warehouse’s characteristics are copied.

To set a default warehouse to copy:

1 On VISUAL’s main window, from the Admin window select Site Maintenance.

2 Click on the Defaults tab.

3 In the Projects section of the Defaults tab, click the Default Warehouse for Copy button and 
select the appropriate warehouse.

4 Click the Save button on the toolbar.

Creating Project Accounts
In order to capture the financial involvement of a project, you must set up project accounts that you 
can specify for your project’s accounting purposes.

To create a project account:

During your account set up phase, select the Project Account check box.

Note: You should treat the Fiscal Year column as the year in which the burden takes place.

For more information on Creating Accounts, refer to your Infor VISUAL Financials General Ledger 
User’s Guide.

Specifying Project Shop Resources
When you are selecting resources for the tasks in your projects, you may find it helpful if only those 
resources you have designated as Project Resources appear.
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If you are licensed to use multiple sites, specify that resources are project resources at the Tenant 
level.

Note: Any overhead rates you enter in Shop Resource Maintenance are used only for work order 
estimating purposes. These rates are NOT used when booking labor against shop resources. 
Maintain all of your burden rates and mappings in the Direct Cost G/L Mapping and Burden Mapping 
window.

Designating Project Resources
If you are licensed to use multiple sites, designate project resources at the Tenant level. You cannot 
designate the same resource as a project resource in one site and as a non-project resource in a 
second site. The project resource setting you select applies to all sites where the resource is used.

To designate a project resource:

1 Select Eng/Mfg, Shop Resource Maintenance.

2 If you are licensed to use multiple sites, click the Site ID arrow and select *Tenant*. If you are 
licensed to use a single site, this field is unavailable.

3 Click the Resource ID browse button and select the resource to designate as a project resource.

4 Click the Other tab.

5 Select the Project Resource check box.

6 Click the Save button on the toolbar.

Working with Purchase Requisitions
When you work with several vendors who supply the same product or material, you may want to give 
each company the opportunity to quote you their prices. For this reason, when you set up your 
Vendor Request For Quotes (Vendor RFQs), you can set their status to Requisition allowing you to 
track your Vendor RFQs. Additionally, when you work with defense industry contracts, you may have 
to justify the reasons why you used one vendor over another: setting Requisition status provides you 
with an audit trail.

For security reasons, it is important that you only allow certain employees to be able to change the 
statuses of your purchase requisitions. 

Changing User’s Application Permissions
Only users with system administrator privileges can access Security Maintenance. For more 
information, refer to the System Administrator guide.

1 From the main menu, select Security, Profile / User / Group Security.
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2 In the Security By section, select User.

3 Click the User ID button and select the user for whom you are setting ECN permissions.

4 Click the ECN Status tab. 

5 In the Status section on the Requisition Status tab, select all check boxes to give the user the 
ability to change the requisition status of your vendor RFQs.

6 Click the Save button.

Setting Up Recurring General Ledger Transactions
For longer and more complex projects, you may find the need to set up Recurring General Ledger 
Transactions for some or all of your transactions that occur regularly. The advantage to setting up 
recurring transactions is that after you have created a transaction, you can repeat the same 
transaction at later dates without entering the same information each time the transaction is due. You 
can also set recurring transactions to occur only when you want, allowing you to make minor changes 
before you post them to your ledger.

Setting up recurring transactions for projects is the same as for any recurring transaction in VISUAL 
with the addition of the following information:

Project ID – Click Project ID and select the project to which you want to assign this recurring 
transaction.

WBS Code – Click WBS Code and select the work breakdown structure to which you want to assign 
this recurring transaction.

Note: Only the work breakdown structures you have used in the project you selected appear in the 
list.

Proj Ref Sub ID – The project reference Sub ID for the project and WBS code you selected 
automatically appears in the Proj Ref Sub ID column.

Proj Ref Seq No – The project reference sequence for the project and WBS code you selected 
automatically appears in the Proj Ref Seq No column.

Dept ID – The Department ID is populated with the default department associated with the Project/
WBS combination.

Cost Category ID – Double-click the Cost Cat ID column header to select the Cost Category you 
would like to use for the transaction. We recommend selecting a cost category ID that is associated 
with the Department ID. 

Hours – Click in the Hours column and enter the number of hours you want to assign for this recurring 
transaction.

For more information on Recurring Transactions, refer to your Infor VISUAL Financials General 
Ledger User’s Guide.
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Chapter 3: Creating Projects

In this chapter, you will learn how to properly set up projects. This chapter first describes the 
recommended flow of entering project information, then describes in more detail each of the windows 
you use to enter information about the project. 

This chapter includes:

Topic Page

Manually Entering a New Project.................................................................................................... 3–2
Defining the Project in the Project Window..................................................................................... 3–3
Creating the Header Card............................................................................................................... 3–4
Adding Tasks to Projects................................................................................................................. 3–7
Adding Legs to Projects.................................................................................................................3–11
Choosing a Project Window Interface........................................................................................... 3–14
Modifying Projects ........................................................................................................................ 3–28
Releasing a Project....................................................................................................................... 3–34
Scheduling Projects ...................................................................................................................... 3–35
Setting Up Project Budgets........................................................................................................... 3–38
Entering Information in the Project Maintenance Window ............................................................ 3–40
Entering Contract and Billing Information in Project Maintenance................................................ 3–45
Refining or Entering Project Warehouse Information.................................................................... 3–50
Entering Contract Information in Customer Order Entry ............................................................... 3–52
Entering the Initial Formal Project Estimate at Completion and Target Costs Information ........... 3–54
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Manually Entering a New Project
Every project you create requires certain pieces of information, such as a Project ID and WBS codes. 
To ensure that you enter all the required information, we recommend creating projects using the 
process described below.

You can also use this process to set up project templates. If you know that most of your projects will 
use similar information, then a template can be very useful. After you create the template, you can 
copy the template to create a new project. For more information on copying a project from an existing 
project, refer to  “Creating Projects from Other Projects” on page 3–32.

Note: Depending on the process your company uses, you can also use the following process to enter 
your company’s response to your customer’s request for proposal (RFP). 

1 From the Project menu, select Project Window.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

3 Click the New button to open a new Project Header.

4 Enter a new ID in the Project Info field, then press the Tab key. When the system asks if you 
would like to add the project, click Yes. The system opens the Project Maintenance window.

5 At minimum, enter the Project Type and at least one WBS code to use on the Project Header. 
Make sure that the Create Project Warehouse check box is selected, then click the Save button to 
save the project. Close the Project Maintenance window to return to the Project window.

For more information on the Project Maintenance window, refer to  “Entering Information in the 
Project Maintenance Window” on page 3–40.

6 From the Project window, complete the following tasks:

• Complete the information in the Project Header. For more information, refer to  “Creating the
Header Card” on page 3–4.

• If your project involves the use of parts, assign these parts to your project warehouse.
• Add all the WBS codes for your project, then build the project master. For more information,

refer to  “Creating the Header Card” on page 3–4. As you build the project master, you can
enter budget information. For more information, refer to  “Entering Information on the Budget
Tab” on page 3–10.

• Assign a default WBS code by choosing a task to use as the project default. You can also
enter this information in the Project Maintenance window. For more information on assigning
a default WBS code, refer to  “Assigning a Default WBS Code in the Project Maintenance
Window” on page 3–44.

• Release the project. For more information, refer to  “Releasing a Project” on page 3–34.
• Schedule the project. For more information, refer to  “Scheduling Projects” on page 3–35.

7 In the Budget Maintenance window available in the Project Summary window, complete the 
following tasks:

• Enter budget figures, or review the budget figures entered in the Project window. Then,
spread the budget. For more information, refer to  “Setting Up Budgets” on page 3–38.

• Initialize the estimate to complete (ETC). For more information, refer to  “Initializing Estimate
to Complete Figures” on page 3–39.
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8 In the Project Maintenance window, complete the following tasks:

• Enter any remaining header information that you did not enter in step 4.
• If you did not assign a default WBS code through the Project window, select a default WBS

code in the Project Maintenance window.
• Enter Contractual General Information, Contractual Financial Information, and Billing

Ceilings. 

9 Open the Customer Order Entry window to complete the contract information. For more 
information, refer to  “Entering Contract Information in Customer Order Entry” on page 3–52.

10 After Customer Order Entry information is complete, enter EAC/Target Costs. For more 
information, refer to  “Entering the Initial Formal Project Estimate at Completion and Target Costs 
Information” on page 3–54.

While we recommend creating projects using the process outlined above, the system does allow you 
some flexibility in creating your own process. For example, you could choose to enter information in 
the Project Maintenance window first, then access the Project window to complete the project 
structure. In the descriptions of the windows and the processes in the remainder of this chapter, we 
have noted the possible variations to this process.

Defining the Project in the Project Window
Use the Project Window to assign tasks to the project’s WBS codes. The Project Window generates 
the sequence numbers and the project reference sub IDs that you will use in other project-related 
documents.

The Project window has a look and feel very much like that of VISUAL’s Manufacturing window, with 
a few project related differences. 

The project structure is made up of a header card, legs, and tasks. The header card contains some 
summary information for the project and can serve as the first leg. Legs are associated with WBS 
codes. Tasks are the individual actions to be performed to complete each leg or header.

Understanding Project Identification
Projects are identified by a number of key fields that form a logical structure:

Project ID – The Project ID is the top-level identification for a project.

Eng ID/Lot ID – Zero (0) is automatically used for projects. You cannot change this field.

Version – When you build a new project based on a previous project’s information, you can enter a 
version number to differentiate the new project from the old.
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Sequence Numbers
The Sequence Number identifies the task within the selected leg. By default, numbers are generated 
in increments of ten. The sequence number for a new task always defaults to ten plus the last task 
number.

Because task numbers are automatically generated by increments of ten, if you want to add the 
operation at another position, adjust the sequence number so that its number falls between the two 
surrounding task numbers.

Note: When building masters, be sure to leave enough room between operation sequence numbers. 
If you think you may need more than ten increments between your task numbers, use increments 
larger than ten.

Creating the Header Card
To build a new project master, you must first create the header card:

1 From the Project menu, select Project Window. 

2 Click the Site ID arrow and select the site to use.

3 In the Project Window dialog box, click the New button.

4 Typically, the standard project structure does not include a part ID. The individual WBS codes will 
identify the parts associated with the project. 

If you do choose to associate this project with a part, click the Part ID button and select the part to 
which you want this project to apply. The part description field is populated along with the part 
default information in the Drawing Revision, Drawing File, Product Code, and Commodity Code 
fields. 

If you have not added the part to the project warehouse, you can add the part “on-the-fly” as you 
create the project. See Adding Parts on the Fly, for more information.

5 Click the Project Info button and select the Project ID you want to use for this project.

The system inputs the appropriate project information and Warehouse ID.

Note: You must select a project ID that has not already been used in a project header. If you 
select an ID that has already been used, you will be alerted that you cannot use the ID when you 
attempt to save the record. 

If you have not yet created the project in the Project Maintenance window, enter the project ID 
you would like to use for the project in the Project Info field, then press the Tab key. The system 
asks if you want to add the project. 

Click Yes. The Project Maintenance window is opened. Enter basic project information, including 
at least one WBS code that you can use as the WBS code for the Project Header. When you are 
finished entering information in the Project Maintenance window, save the information and close 
the Project Maintenance window. You are returned to the Project window. For more information 
on the Project Maintenance window, refer to  “Entering Information in the Project Maintenance 
Window” on page 3–40.
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6 Use the Calendar buttons to select Release and Want dates.

7 Click in the Quantity field and enter 1 for one project. You can enter the number of parts or items 
you are delivering for the project in the project legs. For more information on entering project legs, 
refer to  “Adding Legs to Projects” on page 3–11.

8 Click the WBS button and select the work breakdown structure you want to use for this header.

9 If you want to enter any specification notes about this project, click in the Specifications field and 
enter the information about this project you want.

10 Click Save.

Entering Information on the General Tab
Click on the General tab to enter the following information:

Project Manager – Enter the name of the manager of this project in the Project Manager field.

Engineered Date – Use the Calendar button to select the date on which you engineered this product.

Drawing Number – Enter the drawing number in the Drawing Number field. 

Drawing Revision – Enter the drawing revision number in the Drawing Revision field.

Drawing File – If you want to include a drawing file for this project, click the navigation button and 
select the file you want to use.

If you have selected an AutoCad® drawing, you can view but not alter that drawing by clicking the 
View button.

Entered By – The method used to create the project is displayed. This field is populated by the 
system. For more information, see “Working with Information in the Entered By Field” on page 3-80 in 
the Manufacturing guide.

Product Code – If you want to include a Product Code for this project, click the arrow and select the 
appropriate Product Code from the list. This field may have already populated depending on your 
selection in the Part ID field.

Commodity Code – If you want to include a Commodity Code for this project, click the arrow and 
select the appropriate Commodity Code from the list.

Traveller Printed – If you have previously printed a traveller for this project, the appropriate date and 
time appears in the Traveller Printed field.

Forward Schedule from Release Date – If you want the Scheduler to work forward from the release 
date, trying to schedule the work order for completion as soon as possible, select the Forward 
Schedule from Release Date check box.

If you do not select the Forward Schedule option, the Scheduler attempts to schedule the work for 
completion by its want date and the want dates of all other work orders.

Treat Release Date as Hard – If you want the Concurrent Scheduler not to attempt any scheduling of 
the work order until the release date, select the Treat Release Date as Hard check box.
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Blanket Order - Select this check box if the part associated with the project is part of a larger, blanket 
order. In a blanket order, the part received can be used in any of a number of projects or non-project 
transactions.

Entering Information on the User Defined Tab
Click the User Defined tab to enter customized information about the project.

Select the user defined field layout you would like to use by clicking the User defined field layout ID 
arrow and selecting a layout from the list. For more information about defining user defined field 
layouts, please refer to Infor VISUAL System Administrator’s Guide.

After you select a layout, enter information as appropriate.

Entering Information on the WBS Codes Tab
Use the WBS Codes Tab to enter additional work breakdown structure codes for the project. You can 
also enter WBS Codes in the Project Maintenance window.

To bring the focus to the WBS Codes tab, click the WBS Codes tab.

To create a new code, click the Insert button, then enter information in the following fields:

Code - Enter the code you would like to use in the Code field.

Description - Enter a description of the WBS in the Description field

CDRL - Enter a Contract Data Requirement List in the CDRL field, if necessary.

CLIN - Enter the contract line number in the CLIN field, or double-click the browse button to select a 
CLIN from a list.

Note: You cannot enter a CLIN until you have set up the contract for the project in Customer Order 
Entry. For more information, refer to  “Entering Contract Information in Customer Order Entry” on 
page 3–52.

Customer WBS - If the customer uses a WBS code that is different from yours, enter the customer’s 
WBS code in the Customer WBS field.

Status - The current status of the project is displayed in the Status field.

Billable - Click the Billable arrow and select the billing option you want to use for this WBS. You can 
select either Billable or Non Billable.

Default Dept ID - Double-click the Default Dept ID button and select the department you want this 
WBS to use. A Default Department ID is required for each WBS.

Transfer Costs - If you want to use the transfer costs functionality, select the Transfer Costs check 
box.
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The transfer of costs between WBS elements is not normally allowed within the same project; when 
you bring inventory to a WBS and issue it to a shop order in the same project with a different WBS, 
the costs will not transfer. Selecting the Transfer Costs check box allows the transfer of costs from 
one WBS to another.

Viewing Information on the Budget Summary Tab
Click the Budget tab to view budget summary information for the project. You can enter budget 
information on the task card or in Budget Maintenance available in the Project Summary window. For 
more information on leg cards, refer to  “Adding Tasks to Projects” on page 3–7. For more information 
on entering budgets through Budget Maintenance, refer to  “Setting Up Budgets” on page 3–38.

Note: After building the project structure with budget details, you can return to the Project Header’s 
Budget Tab to review the budget totals. To go to the Budget Summary window, right-click in the 
Budget Tab and select Project Summary Budget.... From the Project Summary window, you can 
spread the budget over the life of the project.

Viewing Information on the ETC Summary Tab
Click the ETC Summary tab to view current estimate to complete figures for the project. You can 
enter ETC information on the task card or in the Maintain ETC window. For more information on leg 
cards, refer to  “Adding Tasks to Projects” on page 3–7. For more information on entering ETCs in the 
Maintain ETC window, refer to  “Initializing Estimate to Complete Figures” on page 3–39.

Adding Tasks to Projects
After you create the header card, create a task for the header card. Use the same procedure to add 
tasks to the other legs in your project. 

To add a task to a project:

1 Select the header or leg card (WBS element) to which you want to add the task.

When you select an object on a header, the header is automatically selected to which it is 
attached.

2 From the Edit menu, select Add Task.

You can also click the Add Task button on the Form toolbar, press the CTRL+K keys or, if your 
popup menu is active, right-click on the header card and select Add Task from the menu.

3 If this task is for a specific type of resource, click the Type arrow and select the type you want to 
use.

Types act as task templates and can contain all of the appropriate information you need for the 
Task dialog box.
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If you select a type, a Load Defaults dialog box appears. If you want to copy the default 
information, select the Yes button.

The appropriate information appears in the task dialog box.

4 If you want to change the Task Sequence Number, click in the Operation Seq # field and enter the 
number you want to use.

For more information on Sequence numbers, refer to  “Choosing a Project Window Interface” on 
page 3–14.

5 Click the WBS Task button and select the resource you want to perform this task.

Only the resources you have designated as project resources appear in the WBS Task list.

For more information on setting up WBS Tasks (project shop resources), "Specifying Project Shop 
Resources" on page 2–25 in the System-wide guide

6 Click in the Duration Hr/Dy field and enter the number of days it will take to accomplish this task. 
The number of hours for the task is calculated by multiplying the number of days you entered by 
8. Alternately, you can specify the Start Date and End Date for the task and the Duration Hr/Dy 
field is automatically populated. You can also specify the Start Date and duration days and the 
End Date is automatically populated.

Note: The decision to enter specific dates may be either managerial or based on contractual 
obligation with your customer. Remember, if you enter dates, the VISUAL Scheduler uses the 
dates you enter.

7 The Default task for manufacturing check box was designed for Material Planning. When creating 
a work order or purchase order for a Planned order, the task flagged as Default task for 
manufacturing will be used.

You are only allowed to have one task per WBS marked as Default task for manufacturing.

8 If you would like to use this task as the default task for the project, select the Default task for the 
project check box. The task and its associated WBS code (the WBS code in the Header or Leg 
card attached to the task) is designated as the default and the information is inserted into the 
Project Maintenance window. You can assign only one task to be the default task.

9 Click in the Specifications text field and enter any comments or specifications about this task. 

These specifications appear on the task card in the Project window.

10 Click in the appropriate fields and enter the Move information you want for this task.

In the Move Hrs field, enter the number of hours that must pass between the end of this task and 
the beginning of the next.

If you want material moved from one task to the next before the first task is complete, click in the 
Min Move Qty field and enter the minimum number of pieces you want moved. This allows 
scheduling of overlapping tasks based on a continuous quantity of material feeding from one task 
to the next.

If you do not want tasks to overlap, leave the Min Move Qty field blank.

To specify the maximum overlap possible, enter 0.0001, the smallest minimum move quantity that 
is supported.

11 Click the Save button.
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Entering Information on the Other Tab
Enter the following information on the Other tab:

Test ID – Click the Test ID button and select a Test ID to use for this task. The Test ID and Drawing 
Number information appear. If you have Infor VISUAL Quality, you can use this field to link your tasks 
to Quality tests. By testing the results of each task, you can ensure that the product is correct before 
you begin the next task.

The test is run after you enter the results in VISUAL Quality.

Drawing # – If applicable, enter the drawing # related to the test in the Drawing ID field.

Rev – Enter the drawing’s revision number, if applicable.

Drawing File - If a drawing related to the test is on file, enter its file path in the Drawing File field, or 
click the Drawing File button to specify a path.

Capacity Use – If you want to specify a minimum or maximum number of resource units needed for 
this task, click in the appropriate field and enter the number of units you want to use.

Maximum Gap From Previous Operation – Click in the Max gap from previous op field and enter the 
maximum number of hours you want to have between scheduled segments.

Begin Traceability at this operation – If you want part traceability for this operation, check this box. 

Schedule Discontinuous – If you want to override the default values for discontinuous tasks, select 
the Schedule discontinuous check box.

If you select the Schedule discontinuous check box, you can specify the minimum number of hours 
you want to use for each schedule segment. Click in the Minimum Segment Size field and enter the 
number of hours you want to use.

Obsolete – If this resource has been designated Obsolete in Shop Resource Maintenance, then this 
check box is selected. You cannot edit this check box in the Task dialog box.

Entering Information on the User Defined Tab
Use the User Defined tab to enter additional information about the task.

To bring the focus to the User Defined tab, click on the User Defined tab.

Click the User Defined Field Layout ID arrow and select the layout for the tab. Enter the information 
you want in the appropriate fields.

For more information on setting up User Defined Fields, refer to your Infor VISUAL System 
Administrator’s Guide.

When you have finished entering user defined information for this project, click the Save button on the 
toolbar.
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Entering Information on the Budget Tab
Use the Budget tab to enter budget information for the selected task.

You can also enter budget information in Budget Maintenance window, available from the Project 
Summary window. For more information on the Budget Maintenance window, refer to  “Setting Up 
Budgets” on page 3–38.

To bring the focus to the Budget tab, click on the Budget tab.

To add a budget line item, click the Insert Row button on the tool bar. Enter information in the 
following fields:

Dept ID - Double-click the Dept ID button and select the department you want to use for this budget 
setup.

Cost Cat ID - Click the Cost Cat ID button and select the cost category you want to use for this 
budget setup.

Hours/Amount - Depending on the cost category you select, enter the number of hours for this line 
item in the Hours field or enter a monetary amount in the Amount field.

Dist ID - Double-click the Dist ID button and select the active Distribution ID you want to use for this 
budget setup. The Distribution ID determines how the budgeted hours/costs are spread across the 
duration of the task.

Entering Information on the ETC Tab
Note: Before you can use the ETC Tab to enter estimate to complete figures, you must initialize the 
first ETC. For more information, refer to  “Initializing Estimate to Complete Figures” on page 3–39.

Use the ETC tab to maintain estimate to complete figures for the task. You can also maintain ETCs in 
the Maintain ETC window available from the Project Summary window. For more information, refer to  
“Manually Creating Estimate to Complete Figures” on page 7–2.

1 To bring the focus to the ETC tab, click on the ETC tab.

2 To revise ETC information, click in the Hours and Amounts fields and adjust the figures as 
necessary.

3 If you would like to enter a new department/cost category combination for the task, click the Insert 
Row button.

4 Double-click the Dept ID button and select the department you want to use.

5 Double-click the Cost Cat ID button and select the category you want to use.

6 Scroll to the period to which you want to add the cost, and add the cost you want.

7 If you would like to enter new fiscal periods, use the Insert Start Period and Insert End Period 
buttons. Click the Insert End Period to add a period to the end of the ETC. Click the Insert Start 
Period to add a period at the beginning of the ETC.
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Adding Legs to Projects
Use legs to specify the WBS elements of your projects.

Projects do not require Part IDs. If you want material automatically planned by WBS, you must specify 
the appropriate Part ID on each leg/WBS. Material Planning will use the WBS for the leg with the Part 
ID versus the higher-level WBS.

For example: You have customer demand for product A, which requires the manufacture of two 
complex sub assemblies, B and C. You have assigned the final assembly of product A to WBS 1.0 
(project header card) but you want to manage the design and production of B and C on different 
WBS’s (legs) on the Project, WBS 1.1 and 1.2 respectively. To accomplish this, you would assign 
subassembly B to the leg detail card of WBS 1.1 and subassembly C to the leg detail card of WBS 
1.2. When all the lower level requirements for product A are planned in VISUAL’s MRP engine, the 
associated project is looked at, and the appropriate WBS is automatically assigned to both planned 
demand and supply. The correct WBS’s are automatically assigned to subsequent work orders you 
release to the shop floor.

To add a leg to a project:

1 To create a new leg in the structure, select a task in the previous leg or header card. You must 
select a task to add a leg.

Note: When you select a task before creating a leg, the leg you create is not associated with the 
task you selected. After you create a leg, you can then create tasks to associate with the new leg.

2 Select Add Leg/Detail from the Edit menu.

You can also click the Add Leg/Detail button on the Form toolbar, press the CTRL+L keys or, if 
your popup menu is active, right-click on the header card and select Add Leg/Detail.

The Leg/Detail option button is automatically selected.

The leg you are adding is automatically numbered.

3 If you want to change the Piece Number or Sub ID, click in the appropriate fields and make the 
changes you want. If you choose not to enter a Sub ID, this field will populate when you save the 
leg.

4 If the leg you are adding is for a specific part, specify a Part ID for a leg by clicking the Part ID 
button and selecting the part you want to use.

If you would like to browse for a part ID by part description, click the Descr button.

Selecting a Part ID for a leg indicates that the leg corresponds to a part that is also a separate 
inventory part.

You can add the part to a project warehouse location directly from the Project Window. Refer to 
Adding Parts to Warehouses on the Fly, for more information.

5 Click the WBS button and select the WBS code that corresponds to the leg you are adding.

The description for the WBS code you select appears next to the WBS field.

6 Click the Save button.

The leg is created and it is added to your project structure and the Leg/Detail dialog box clears 
and is ready to add another leg to the same task.
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Entering Information on Quantities Tabs
If you are entering information for a manufactured part, use the Quantities tab to enter additional 
information about the part. 

Click on the Quantities tab and enter the following:

Quantity Per – Click in the Qty Per field and enter the quantity of this part per unit that you want.

To select at what point you want the Quantity Per to apply, select either the Qty per (start qty) or Qty 
per (end qty) option buttons.

Fixed Quantity – If you do not want start or finish quantities calculated based on Quantity Per and 
Scrap values, click in the Fixed Qty field and enter the value you want to use.

Scrap% – Click in the Scrap% field and enter the percentage value you want to use for the amount of 
scrap you want used in calculations.

Dimensions – If you are using dimensional inventory, click in the Dimensions field and enter the 
formula for the dimensions of this part. 

Reference # – Click in the Reference # field and enter a reference number.

Issued Quantity – Click in the Issued Qty field and enter the quantity you want to issue to this leg. 
This field is only available if the leg’s part is consumable.

Usage Unit of Measure – Click the Usage U/M button and select a unit of measure for this part.

Entering Information on Specifications Tabs
Use the Specifications tab to enter notes and comments

1 Click on the Specifications tab.

2 Click in the Specifications field and enter any comments or notes you want about this leg.

3 Enter any appropriate engineering information for the following:

Drawing Number – Click in the Drawing # field and enter a drawing number for this leg.

Rev – If the drawing number you entered has a specific revision number, enter it in the Rev # 
field.

Drawing File – If the drawing number you entered has a picture file, navigate to and select the 
appropriate file.

Viewing Information in the Costs Tab
If you selected a Part ID for the Leg, click the Costs tab to view the costs associated with the part. 
You can set up the costs for a part through Part Maintenance. Please refer to your Infor VISUAL 
Inventory User’s Guide for more information.
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Entering Information on the User Defined Tab
Use the User Defined tab to enter additional information about the task.

To bring the focus to the User Defined tab, click on the User Defined tab.

Click the User Defined Field Layout ID arrow and select the layout for the tab. Enter the information 
you want in the appropriate fields.

For more information on setting up User Defined Fields, refer to Infor VISUAL System Administrator’s 
Guide.

When you have finished entering user defined information for this project, click the Save button on the 
toolbar.

Viewing Information in the Budget Summary Tab
Click the Budget Summary tab to view the current budget for the tasks attached to the leg.

You can enter budgets on the task cards or in Budget Maintenance. For more information on entering 
budgets in task cards, refer to  “Entering Information on the Budget Tab” on page 3–10. For more 
information on entering budgets in Budget Maintenance, refer to  “Setting Up Budgets” on page 3–38.

Viewing Information in the ETC Summary Tab
Click the ETC tab to view current estimate to complete figures for the tasks attached to the leg. For 
more information on ETCs, refer to  “Initializing Estimate to Complete Figures” on page 3–39.

Assigning Parts to Warehouses
Use the Assign Parts to Project Warehouse feature to add the parts you are using in the project to 
your project warehouse. 

If you have selected the Create New Location and Assign to Part option in Site Maintenance, you can 
add locations to you project warehouse during this procedure. If you have selected the Assign 
Existing Location to Part or the Not Allowed option in the Part Location on the Fly section in Site 
Maintenance, you can only add parts to existing warehouse locations.

To add parts to your project warehouse: 

1 From the Edit menu, select Assign Parts to Project Warehouse. Specify the following 
information:

Part ID – Click the Part ID button and select the part you would like to assign to the project 
warehouse.

Part Eng ID – Click the Part Eng ID arrow and select a Part Eng ID.
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Warehouse ID – The system inserts the project Warehouse ID from the header card. 

Location ID – Click the Location ID button and select the location within the warehouse where 
you want to store the part.

If you have allowed part locations to be created on the fly, you can specify a new location ID in the 
field. The system will add the new location to the selected warehouse when you click Save.

Status – Select a status option for the part. If you specify On Hold, specify a Hold Reason ID in 
the Hold Reason ID field.

Description – If you are creating a new warehouse location, enter a description for the location in 
the Description field.

Engineering Master Material Requirement – If you have selected a fabricated part, select the 
Include Engineering Master Material Requirements check box to add the parts from the 
material requirements on the fabricated part's Engineering Master to the warehouse location as 
well. 

Include Co-Products – If you selected a fabricated part, select the Include Co-Products check 
box to add the co-products specified on the fabricated part's engineering master to the warehouse 
location as well. 

2 Click Save. If you specified a new location in the Location ID field, and you have allowed the 
creation of part locations on the fly, the system asks you if you want to create the location. Click 
Yes to continue, or No to return to the Assign Parts to Warehouse dialog box.

If you have not allowed the creation of part locations on the fly, you must select an existing 
location ID for the system to save the information.

The system adds the part ID you specified to the warehouse location. If you selected the Include 
Engineering Master Material Requirements check box or the Include Co-Products check box, the 
system adds the appropriate parts to the warehouse location.

3 Click Close to exit the dialog box.

Choosing a Project Window Interface
The Project Window offers a number of different viewing modes and options. In all cases, the same 
internal database information is displayed. The viewing modes present you with a variety of tools for 
viewing and editing the information. 

You can choose among three views: Graphical, Text, and Grid. In the Graphical display, you can 
choose to view information from the bottom of the window up or from the top of the window down.

You can also specify the colors of the various objects in the window and define up to 6 text size 
options.

You can choose an interface when you open an existing master or create a new master. You can 
change the view using the View menu.
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Graphical View
In the graphical view, each object (header, task, leg) is represented by a rectangular “index card.” The 
card shows some basic information about the object and its relation to the other objects, and is used 
to select and edit all of the object’s contents. Each header card and leg is grouped with its associated 
operations. The cards sit on a scrollable viewing area, which is always large enough to hold all the 
cards. Depending upon your size preference settings and the size of the master/work order, you may 
need to use the scroll bars to access all of the cards. Different colors highlight the different types of 
objects. See “Setting Color Preferences” later in this chapter for details.

Setting Graphical View Options
You can specify how to display the various objects in the Graphical view. To specify settings:

1 Select Options, Graphical Display Options.

2 Select from the following options:

Top Down – Select this option to position the header card of the master at the top left of the 
window. All other legs flow beneath the header card. Clear this option to position the header card 
at the bottom left of the window. All other legs flow above the header card.

Header Cards behind Other Cards – Select this option if you would like the header or leg card to 
be under the operation information. If you select this option, most of the information that is 
displayed on the header or leg card is hidden behind the operations. Clear this option if you would 
like the header or leg card to be on top of the operation and material requirements information. If 
you select this option, the information displayed on the header or leg index card is visible.

3 Click Ok.

Text View
The text viewing mode provides a more traditional view of the work order/master. Each object is 
shown as a single line of text, displaying some basic information about the object.

The header is always the first line of the display. Tasks are indented beneath the header. Legs are  
indented beneath their tasks. 

Two Window Display
In the Two Window display, the system displays materials in a separate window from the rest of the 
master. Because the Project Window does not use material cards, this feature has no practical 
application to the Project Window. 
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Grid Display
In the grid display, the master is displayed in a table. The header is displayed in the first row. 
Operations and legs are displayed in subsequent rows. Like the Text display, information in the table 
is indented to show the relationship among tasks and legs.  

The grid display shows more of the information entered in the master, leg, and task dialog boxes than 
the text and graphical displays show. 

Note: Because the grid displays more information, the system will take longer to load the grid display 
than the text and graphical displays.

Not all columns in the Grid display table apply to all of the objects in the table. For example, 
Operations do not use Part IDs, so the Part ID column does not apply to Operations. You can choose 
how you want the system to indicate that a column does not apply to a particular object using the Grid 
View Display Options dialog box.

If you use the Grid display, you can export the information from the grid into Microsoft Excel. You can 
also import information from Excel into the grid display provided that your Excel spreadsheet is 
formatted properly.

You can also edit information directly in the Grid display. Because the system does not display all 
information related to the master in the Grid display, you should still access the Header, Leg, and 
Task dialog boxes to ensure you have completed all pertinent information. If you want to create a new 
card, you must use the Add Task and Add Leg buttons, or select the Add Task and And Leg options 
from the Edit menu.

Specifying Grid View Display Options
You can specify which color you would like to use for a non-applicable column in the Grid View 
Display Options dialog box. You can also choose how you would like the system to display the Detail 
column.

To specify grid view display options:

1 Select View, Grid View Display Options.

2 Specify the following:

Non-applicable Column Color – Some columns in the Grid Display table do not apply to every 
row in the table. Specify the color to use to indicate that a column does not apply to a row. Select 
one option:

Use Specified Color – Select this option to use the same color for all non-applicable 
columns. If you select this option, click the Color button and select the color you would like to 
use. This color will be used for all non-applicable columns regardless if the row is a header, 
leg, operation, or material.

Use Faded Object Color – Select this option to use a lighter shade of the color you specified 
for the header, leg, operation, or material in Setting Color Preferences. For example, if you 
specified that operations are blue, then cells that don’t apply to operations are a lighter shade 
of blue. If you select the Use Faded Object Color option, specify a Fade Factor. The Fade 
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Factor indicates how much lighter the non-applicable column color will be than the object 
color. The higher the number, the lighter the shade. Enter a value from 0.1 to 0.9. Avoid using 
0. If you use 0, the non-applicable color will be the same as the object color.

Tree View Detail – Select this check box if you would like the Detail column to use a tree view. In 
the tree view, the system draws lines between associated objects. The system displays the Plus 
and Minus buttons used to expand and collapse the master structure directly in the Detail column. 
Clear this check box if you do not want to view lines connecting the master objects. The system 
displays the Plus and Minus buttons used to expand and collapse the master structure in the first 
column.

Using the Grid View
The Grid View table displays most of the information found on the header, leg, operation, and material 
cards. If the information is editable in a card, you can also edit it in the Grid view. For example, you 
can change the part ID associated with a material card directly in the grid view without accessing the 
material card. Place the cursor in the part ID field, double-click the part ID browse button, and select a 
part from the table. 

Refer to the Building Masters section for more information on editing objects in a master.

After you make changes in a grid line, click anywhere outside the grid line. The system prompts you 
to save your changes. The system also prompts you to save your changes if you tab out of a row.

Exporting the Grid View to Excel
You can export the master or portions of the master to Microsoft Excel.

1 To export the entire master, do not select any lines, or select all lines. You can also send selected 
lines. Hold down the CTRL button and click the lines to export. 

2 Select File, Send to Microsoft Excel.

The system launches Microsoft Excel and inserts the information from the Project Window.

3 You can edit the spreadsheet and import the information back into the Project Window.

Importing from Excel into an Existing Master in the Grid View
You can import information from a Microsoft Excel spreadsheet into the Project Window. You can 
import information to an existing master, or you can use Excel to create a new master. You can import 
information from Excel, provided that the following conditions are met:

• You are using the grid view
• The columns in the Microsoft Excel spreadsheet are named correctly. You may find it helpful to

export a master from the Project Window first before importing information to be sure that the
columns are named correctly.

• The information in the system is valid. For example, if you specified “G” in the Status column, the
system would not import the information since a status of “G” does not exist in VISUAL.
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• For existing masters, the card has no material issues or labor tickets applied against it.

To import from Excel:

1 From the Project Window Grid View, select File, Import from Excel.

2 Select the Excel file and click Open.

3 The system imports the information from the Excel file into the database. The system updates any 
existing header, leg, or task cards you edited in the spreadsheet and creates any new cards you 
added to the spreadsheet, provided that you formatted the information correctly.

Scrolling in the Project Window
You can use the scroll bars at the bottom and at the left of the Project Window to scroll to view 
information. 

In the Graphical and Text displays, you can also click and drag the window to scroll. Place your cursor 
in a blank area of the window (an area that does not contain any object cards). Click the mouse 
button. The cursor changes to a hand. With your mouse button depressed, drag the mouse to scroll 
the information in the window.

Using High Contrast Mode
High Contrast color schemes can increase legibility for some users by heightening screen contrast 
with alternative color combinations.

To turn High Contrast Mode on in Windows, select Control Panel, Accessibility Options from the Start 
menu. Select the Display tab, then select the Use High Contrast check box.

For users employing the High Contrast mode, the following changes are made to your view settings:

Text Display Mode 1 – Text and background colors are affected by the high contrast setting. You can 
change the font using the Project Window's Size Preferences option located on the Option menu.

Note: Changing the font size also affects the cards in the graphical modes.

Text Display Mode 2 – The outline text panel do not respond to the high contrast settings. The 
material panel responds to the high contrast setting but is not affected by the Size Preference 
settings—only the background and text colors are affected.

Graphic Display 1 – Graphic Mode 1 does not support high contrast mode.

Graphic Display 2 – Graphic Mode 2 only supports high contrast mode in the material panel and is 
not affected by the Size Preference settings—only the background and text colors are affected.

Grid Display – The Grid Display does not support high contrast mode.
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Selecting Objects

Selecting Objects in Graphical Viewing Mode
To select any object, simply click on the section. A left-pointing arrow is shown to the right of the 
selected section, indicating that it is the current object.

You can also use all four cursor keys to navigate the structure. Use up and down keys to move back 
and forth between operations and material requirements in a leg. Use left and right keys to move 
between legs.

Selecting Objects in Text Viewing Mode
To select any object, simply click on its line. A right-pointing arrow is shown to the left of the selected 
line, indicating that it is the current object. You can also use the up and down, left and right cursor 
keys to move around the structure.

Opening Multiple Windows
You can open multiple projects in the Project Window. Use the tile and cascade options to position 
project masters so you can drag and drop information between open windows and compare operation 
and leg details. 

Even with multiple windows open, you still have total control over each windows display and size. A 
window must have the default, however, before you can change its settings. You cannot make 
universal changes to open windows. See the previous sections for more information on changing the 
window display and selecting sizes.

Open masters one at a time using the Open dialog box.

Arranging Open Windows
With more than one window open, you may want to position the windows for ease of viewing and 
performing drag and drop operations.

Three positioning options are available from the Windows menu.

Tile Vertical – Select this option to vertically tile all open windows. If four or more windows are 
currently open, no distinction is made between a vertical tile and a horizontal tile. Select either menu 
option to position the windows.

Tile Horizontal – Select this option to horizontally tile all open windows. If four or more windows are 
currently open, no distinction is made between a vertical tile and a horizontal tile. Select either menu 
option to position the windows.

Cascade – Select this option to cascade all open windows.
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Selecting Open Windows
With multiple windows open and arranged, or with multiple windows open but hidden except for the 
current displayed window, from the Window menu select Project ID and Eng ID/Lot ID of the work 
order/master you want to have the default position.

With arranged windows, you can click anywhere in a window to make it the default.

Upon selection, the title bar of the default window becomes blue.

Selecting Windows if more than Nine Windows are Open
A maximum of nine windows can be listed in the Window menu. If you have more than nine windows 
open, select More Windows from the Window menu to view a complete list of all open windows.

1 The Selected Windows dialog box appears.

2 Select a window and click the Ok button.

The master is called and it is assigned in the default window position.

3 Click the Cancel button to exit the dialog box and return to the main display.

Minimizing & Restoring Windows
You can minimize all open windows at once. To do this, select Minimize All from the Window menu.

All windows are minimized.

To restore windows to their former arrangement, select Restore All from the Window menu.

The former window arrangement is restored.

You can also minimize windows one at a time. To do this, click the minimize button, found in the top 
right of each window.

To quickly restore a window to its former position, select Restore All from the Window menu.

Closing Windows
Instead of closing open windows one by one, you can close them all at once. To do this, select Close 
All from the Window menu.

All open windows are closed. The Project Window, however, remains open.
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Setting Size Preferences
Size preferences allow you to choose font, font size, attributes, and graphical card display 
characteristics for the Project Window. You can define six separate size preferences that you can 
change at will. You might, for example, set one preference that is useful for viewing details of objects, 
and another that displays a maximum number of objects in the viewing space. You will find that the 
combination of preferences allows you to setup an amazingly large number of different display styles.

To set size preferences:

1 From the Options menu, select Size Preference.

2 Select the radio button for the preference you want to modify.

3 Set any of the following font and size parameters:

Font – You can display all text in the Project Window in any font that is installed on your PC. 
Select the font you want to use from the list.

Font Size – You can select the size of the font. For True Type fonts, you can select any size 
desired. For non-true type fonts, you must select from the list of sizes offered for the font.

Enhancement – You can display the selected font in normal or bold style.

Lines of Text – Choose the number of lines you want to be visible in graphical mode, or the 
number of columns of information to display in text mode. This controls how much the cards 
overlap vertically.

Width – Specify the width of a card in graphical mode, in terms of the number of characters 
shown in the selected font and size.

Height – Specify the height of a card in graphical mode, in terms of the number of characters 
shown in the selected font and size.

Offset – Specify the horizontal distance between edges of successive cards, in terms of the 
number of characters shown in the selected font and size.

4 If you want, click on the Save as Default Sizes check box to indicate that you want to save these 
settings as the permanent defaults for this workstation.

5 Click on Ok to complete the operation, or Cancel to abort the changes.

The display automatically shifts to the last size preference you selected. If you selected Save as 
Defaults, your changes are permanently saved in the VISUAL.INI file for your workstation. 
Otherwise, any changes you made are only in effect for this use of the Project Window.

Using Size Preferences
To select from the current size preferences:

Select from Size Preference 1 through Size Preference 6 options in the View menu.

You can also press the SHIFT and function key corresponding to the size. For example, press 
SHIFT+F2 to use size preference 2.
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Setting Color Preferences
You can set individual colors for each of the six classes of objects shown on the Project Window. 
Unlike Size preferences, there is only one current set of colors.

1 From the Options menu, select Color Preferences.

You can set the colors for any of the following classes of objects:

Engineering Master/Work Order – This sets the color for the header line or card. The default 
color for the header is white.

Engineering Leg – This sets the color for the leg/detail line or card. The default color for legs is 
gray.

Internal Operation – Operations for which the Resource ID is for a workcenter or individual/group 
resource. The default color for internal operations is light blue.

Sub-Contracted Operation – Operations for which the Resource ID is for a subcontractor 
resource. The default color for subcontracted operations is light blue.

Material – All material requirements except tool/fixture requirements and alternate parts. The 
default color for material requirements is light green. This is not applicable to Projects.

Tool/Fixture/Consumable – Part Maintenance allows you to specify a Part ID as a Tool/Fixture/
Consumable. You can create requirements for these materials in the same way that you make 
normal inventory requirements. This option allows you to display the requirement for the Tool/
Fixture/Consumable in a different color. The default color for these requirements is light green. 
This is not applicable to Projects.

Alternate Part – All alternate parts. You can use alternate parts when the required material is 
unavailable. This is not applicable to Projects.

Borders/Lines – The color of the border lines of the cards appearing in the window.

2 Click the Change button next to the object.

The Color dialog box appears. This dialog box allows you to select any Windows RGB color.

3 Click on one of the Basic or Custom color boxes.

You can also choose a custom color by dragging the cross-hair around the large box until you find 
the color you want. You can also use the slider at the left to control the luminosity (brightness) of 
the color. The top of the range corresponds to white, and the bottom to black. These automatically 
set Hue/Saturation/Luminosity or Red/Green/Blue values. You can also enter these directly. The 
best thing to do is move the crosshair and the slider around until you find a color you like.

To add the color to the permanent list of custom colors, select the box for the color you want to 
replace, and press Add to Custom Colors. To use this color without adding it to the custom colors, 
just click Ok.

4 Click on the Ok button to change the color. You can also double click on the color box.

Click on the Cancel button to close the Color dialog box without making color changes for this 
object.

5 In the Background section, select how you want the window background to appear. You can 
select what you want the Primary color to be and if you want the background to fade to another 
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color, you can select what you want that to be by selecting the Fade To color. If you selected to 
use a Fade color scheme, you can also select how you want the fade to appear:

Fade Edge – You can select horizontal or Vertical.

Fade Diagonal – You can select up or down.

6 If you want to save the color changes you made as the permanent ones, select the Save as 
Default Colors check box. If you do not select this box, the colors remain in effect for the current 
session only.

7 Click on the Ok button to complete the operation, or the Cancel button to abort the changes.

Using the Show/Hide Options
There are various Show/Hide options, all located in the View menu, which control which objects are 
displayed and which are hidden in the Project Window.

Showing/Hiding Multi-Levels
The Show/Hide Multi-Level option controls how the other Show/Hide functions operate. If you want 
to control the display of all legs on the master/work order, select Show/Hide Multi-Level from the 
View menu. A check mark to the left of the option indicates that it is active.

If you want to set display for individual legs, select Show/Hide Multi-Level from the View menu 
again. The check mark disappears.

The remaining options operate on the entire master/work order if you select Show/Hide Multi-Level. 
Otherwise, the Show/Hide commands only apply to the selected leg.

Showing/Hiding Operations
If you want to focus on material requirements only, select Show/Hide Operations from the View 
menu or press the SHIFT+F10 keys together. This suppresses the display all of the operations. Only 
the header, legs, and material requirements appear. In text mode, this produces an indented bill of 
materials.

To redisplay operations, select Show/Hide Operations again, or select Show All.

Hiding All
If you want to focus only on the subassembly structure of the master/work order, select Hide All from 
the View menu or press the minus (-) key on the number keypad of your keyboard. This suppresses 
the display of all operations and material requirements, leaving only the header and leg details.
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Showing All
Select Show All, or press the plus (+) key on the number keypad of your keyboard to quickly 
redisplay all operations, material requirements, and legs.

Using the Jump Options
These functions control which portion of the master/work order appears on the available screen 
space. They help you navigate around a large structure that you can’t view on a single screen. All 
three Jump options place an object in the “home position.” For graphic display, home position is the 
lower left corner of the screen. For text display, home position is the top line of the screen. These 
functions are all located in the View menu.

Using Jump Home
Select Jump Home from the View menu to place the master/work order header in the home position.

Using Jump
Select Jump from the View menu to place the currently selected object in the home position. This 
allows you to pick a starting point from which to work. You can also use SHIFT+F8 to activate this 
function.

Using Jump Up
Select Jump Up from the View menu to place the parent leg header or master/work order header of 
the selected object in the home position. For example, if you select the fifth operation on a leg, and 
select Jump Up, the leg header for the leg is placed into home position. This lets you focus on a 
particular leg to work on. You can also use SHIFT+F9 to activate this function.

Popup Information Cards
Regardless of the display mode you use, you can get a more detailed information summary for an 
object by right-clicking on the object you want to view. The appropriate information appears on an 
“index card” with one to four text lines. Card information for a project differs slightly from work orders, 
engineering masters, and quote masters.

To view popup information cards, you must deactivate the popup menu. Select the Options menu. If a 
check mark appears next to Popup menu, select Popup menu to deactivate it.

Note: If you right-click on a card and hold the mouse button down and drag the cursor to another 
card, the information on the card automatically changes to reflect the current object on which you are 
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holding the cursor.

Header Information
Project header popup cards contain information about the project header. 

Line 1 – The information on the first line of the Header popup card is:

Status (R) – The status of the project appears in parentheses at the beginning of line one. Valid 
statuses are: U for unreleased, F for firmed, R for released, C for closed, and X for cancelled.

Project ID (PROJECT WIDGET/0) – The Project ID and Eng ID/Lot ID appear after the status.

If there is a Version number, it appears after the Project ID.

Part ID () – If you have specified a Part ID for your project, the appropriate Part ID appears after 
the Project ID.

Line 2 – The information on the second line of the Header card is:

Quantity (70.0000) – The quantity of the project appears at the beginning of the second line.

Specifications (Manufacture to Grade B35 Standards) – If you have entered any text in the 
Specification field for the project, the first line of the text appears after the quantity.

Line 3 – The information on the third line of the Header card is:

Days Early/Late (OT) – The difference between the scheduled finish date and the current date 
appears in the Days Early/Late field. A negative value indicates a late order, a positive value an 
early one. If your project is on time an OT appears.

Desired Want Date (Scheduled Finish Date) (3/13/2007(3/13/2007)) – The date by which you 
want the project completed appears as the second piece of information on the third line. The 
scheduled Finish Date of the project as determined by the Global Scheduler appears in 
parentheses after the Desired Want Date.

Desired Start Date (Scheduled Start Date) (2/13/2007(2/12/2007)) – The date on which you 
want to start the work order appears as the third piece of information. The scheduled start date of 
the project as determined by the Global Scheduler appears in parentheses after the Desired Start 
Date.

Line 4 – The information on the fourth line of the Header card is:

Elapsed Days (28.00 elapsed days) – The number of elapsed days between release date and 
the current date appears at the beginning of the fourth line.

True Production Hours (640.00 true prod hours) – The total setup and run time for all 
operations on all legs, irrespective of calendar time taken to perform them appears after the 
number of elapsed days. The hours are figured from the number of days for the project.

Task Information
Task information cards follow any leg detail requirement cards for that task.

To view the entire contents of the task card, right click on the card and hold down the mouse button.
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Line 1 – The information on the first line of the Task popup card is:

Sequence Number (10) – The sequence number (position number) of the task within the project 
appears at the beginning of the first line.

WBS Task ID (PRJ MGT) – The WBS Task ID appears after the Sequence number.

WBS Task Type (PROGRAM OFFICE) – The WBS Task Type appears after the Task ID.

Specifications – Any specifications you entered for this task appear after the WBS Task Type.

Line 2 – The information on the second line of the Task popup card is:

Status (R) – The status of the task appears in parentheses at the beginning of line two. Valid 
statuses are: U for unreleased, F for firm, R for released, C for closed, and X for cancelled.

Start Date (2/13/2007) – The Start date of the task appears after the task status.

Finish Date (3/13/2007) – The Finish date of the task appears after the Start date.

Line 3 – The information on the third line of the Task popup card is:

Duration (Duration 160.00 Hrs) – The duration of the task appears at the beginning of line three.

Run Type (0.00 HRS/PC) – The run time and run type appears after the duration on line three.

Quantity (Qty 70.0000) – The quantity of this task appears at the end of line three.

Leg Information
The leg information card displays similar information to the header card.

Line 1 – The information on the first line of the Leg popup card is:

Status (R) – The sequence number (position number) of the leg within the project appears at the 
beginning of the first line.

Project & Leg ID (PROJECT WIDGET-1/0) – The Project and Leg IDs appear after the Status. If 
there is a Version number, it appears after the project ID.

Part ID – If you have specified a part for this leg, the Part ID appears.

Line 2 – The information on the second line of the Leg popup card is:

Quantity (70.0000) – The quantity of this leg appears at the beginning of line two.

WBS (2.0 Widget Assembly) – The WBS number and Description appear after the quantity.

Specifications – If there is information in the specifications field, the first line of the text appears.

Line 3 – The information on the third line of the Leg popup card is:

Scheduled Finish Date (2/17/2007) – The scheduled Finish date as determined by the Global 
Scheduler appears in parentheses.

Scheduled Start Date (2/12/2007) – The scheduled Start Date as determined by the Global 
Scheduler appears in parentheses at the beginning of line three.
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Viewing Information Using Dialog Boxes
You can also view information about objects in the Project window by double-clicking on the text line 
or index card for the object you want to view.

The appropriate dialog box appears.

Customizing Cards
You can customize the information on cards. Cards are used in the graphical display. They are also 
used in the text display as pop up cards. For the leg, operation, and service cards, you can add a 
fourth line of information.

To customize pop up cards:

1 Select Options, Card Line Preferences.

2 To select the card type and line to set up, specify these options:

Object Type – Specify the card type to set up. You can select Leg, Operation, or Service.

Line # – Specify 4.

3 To specify the information to include on the line, click Insert. 

4 Specify this information:

Data Column – Click the arrow and select the data to include.

Hide If – Specify the conditions under which this information is hidden. Select Zero to hide this 
information if the value is zero. Select Null to hide this information if the value is blank. Leave this 
field blank to always show the information.

Prefix – Specify text to include before the data.

Suffix – Specify text to include after the data.

As you specify information, the text that will be displayed on the card line is inserted below the 
table. Tokens (for example, %1) are used to indicate where the information you selected will be 
displayed. The token is replaced by the value from the database when you access the pop up 
card.

While there is no limit to the number of pieces of information you can add to a line, the size of the 
pop up card is limited. If you specify too many pieces of information, some of the information may 
be truncated.

5 Click Ok. 

Completion Meters
A horizontal bar appears to the left of each line in text mode, and at the top of each card in graphical 
mode.
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Text Mode (1 Window) Completion Meters

Graphics Mode Completion Meters
This horizontal bar indicates the percentage of the total completion for the object. It begins empty, 
and fills as work progresses.

Note: For the header, the meter shows the total completion of the project. For tasks, legs, and 
materials, the meter shows the completion status of the individual object.

Using Macros in the Project Window
Macros are small script-based programs that help automate time-consuming processes and eliminate 
the chance of incorrect data entry. Macro scripts are usually developed by the application user in 
response to specific local needs. A wide variety of automation is supported: for more information on 
writing macros, refer to your Infor VISUAL System Administrator’s Guide.

Note: The Project Window supports the use of macros in headers, legs, and tasks.

To run a Project macro:

1 Open the Edit dialog box for the item where you want to run a macro.

For example, if you want to run a macro for a task, open the edit dialog box for that task by 
double-clicking the task or selecting Edit from the Macro menu.

If you want to run a macro on the main header card, click the Macro button and select the macro 
you want to run.

2 From the Macro menu, select the macro you want to run. 

The macro is run.

If the macro is successful, the macro task is completed.

If a problem occurs, a warning message appears, alerting you to the position of the offending 
syntax in the macro.

Note: If a macro fails, select the Edit option and correct the offending syntax.

Modifying Projects
If you copy projects from templates or other projects or VISUAL masters, you will need to modify them 
to meet the needs of the project or contract on which you are working.

If you modify projects and want to keep the original project information for your records, a version 
control mechanism is provided to help you track your changes. 
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Editing Information in Projects
Using the same dialog boxes and windows you used to enter the original information, you can edit 
header, leg, and task information. Because Project IDs, Leg IDs, and Sequence Numbers define 
various objects within your project, you cannot make any changes to them.

There are several methods for editing information within projects:

• Select the object and from the Edit menu, select Edit
• Select the object, and press CTRL-E keys
• Double-click the Object
• If the right-click menu is active, right-click on the object and select the Edit option.

All of these methods open the appropriate dialog box in which you can make your edits. You can 
open a task dialog and a leg dialog at the same time, but you cannot open more than one of the same 
type of dialog box (e.g., you cannot have more than one task dialog box open at the same time). If 
you open the header dialog, you cannot open any other dialog box.

Importing and Exporting Projects
Importing and exporting information as ASCII text files give you the advantage of being able to use 
your project information in other programs.

You can use Importing and Exporting to:

• Import and export to and from other systems. Many other systems create and accept text file
formats. You may be able to export information from another system and import the information
into a VISUAL Project. Sometimes you may need to reformat that text before you can import it.

• Transfer information between databases. Using the Importing and Exporting features, you can
transfer information from a project into a different database.

Exporting Project Information
Use the Export command to save the current Project to a file on your computer.

1 If the project you want to export is not open, click the Site ID arrow and select the site in which the 
project was created, then select a project.

2 From the Edit menu, select the Export option.

Caution:  Because of the many issues involved with VISUAL information, do not attempt to 
import data from an exported VISUAL file that you have modified (or from another 
system) without assistance from Infor. For example, if you are importing a project 
with new Part IDs, you must also provide for the Part IDs to be loaded into Part 
Maintenance.
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3 Enter a unique file name for the information you are exporting.

A file extension of .ENG is automatically assigned. If you want to specify a different file extension, 
enter the appropriate extension after the name.

4 If the directory where you want to save the file is not the current directory, navigate to and select 
the directory into which you want to export the project information.

5 Click the Save button.

Your project information is saved to the file you specified and a message appears, indicating that 
the information is being copied.

Importing Information Into Projects
Use the Import command to copy information from a Project you have previously exported.

To import information:

1 Position the location where you want to paste the information you are importing.

2 From the Edit menu, select Import.

The Import dialog box appears. All files with the extension of .ENG appear in dialog box.

Note: If you want files with a different extension to appear, enter an asterisk followed by the 
extension you want (for example, *.abc) then click the Open button. The Import dialog box 
automatically refreshes and any files with the extension you entered appear.

3 Select the file you want to import and click the Open button. 

4 Your information is imported to the location you specified and a message appears, indicating that 
the information is being copied.

Searching for Projects
After you have been using VISUAL — Projects/A&D for a while you will have built many projects. In 
order for you to easily find a particular project of interest, you can use VISUAL’s search function.

To search for a project:

1 Click the Site ID arrow, then open any project in the Project Window. 

2 From the File menu, select Search. A list of all of your projects appears. If this list is too large to fit 
in the dialog box, a scroll bar appears.

3 Click the Search button on the toolbar.

4 Enter the appropriate search criteria.

For more information on using the Search by Query dialog box, refer to Infor VISUAL System-
wide Guide.

5 Click the Ok button.
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If any projects meet your search criteria, they appear in the Projects dialog box. Double-click the 
project you would like to view.

If a project does not exist and you want to enter a new search, click the Search button on the 
toolbar.

Searching for Leg IDs in a Projects
Sometimes Projects can be very large and you may want to find a particular leg that is not currently 
on your screen. If you know the identification number of a Leg, using the search feature can be easier 
than manually searching for that leg.

To search for a Leg ID:

1 Select Edit, Legs, Find Sub ID.

2 Click in the Search For field and enter the Sub ID of the leg you want to locate.

If you want to select a Leg ID, click the arrow and select an ID from the list.

3 To start the search, click the Search button.

If the Leg ID is found, the leg “card” appears at the bottom left of the Project window with an arrow 
pointing to it.

Deleting Projects and Objects within Projects
From time to time you will find the need to delete an object in a project. For example, you have built a 
leg and find that the contract has changed or your (or your customer’s) needs have changed.

Note: The process for deleting a project is the same as the process for deleting an object in a project.

To delete an object in a project:

1 Select the object you want to delete.

A small arrow appears to the right of the object you selected.

2 Click the Delete button on the toolbar or from the Edit menu and select the Delete option.

The system asks for confirmation of the deletion.

3 Click the Yes button.

A progress indicator appears and the object you selected is deleted from the project.

Caution:  Deleting the main header card deletes the complete project; always double check 
to make sure you have selected and are deleting the correct object.
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Copying Projects and Parts of Projects
There are several methods you can use to copy objects within VISUAL — Projects/A&D:

• The Project window supports the drag and drop functions. You can copy projects, work orders,
and masters (or parts of them) by clicking on the object you want to copy and dragging it to its
new location. Object information is copied from the source to the new location.

Note: If you are dragging information between multiple projects, you must open and arrange side 
by side the appropriate projects or masters. For more information on working in multiple windows, 
see Infor VISUAL System-wide Guide.

• Use the Copy From option on the Edit menu. Select the object to which you want to copy, then
from the Edit menu, select the Copy From option. Select the Project you want to copy. The
appropriate information is copied to your project and it is attached to the object you selected.

• Use the Copy and Paste options on the Edit menu. Click on the object you want to copy and from
the Edit menu, select Copy. Click on the object to which you want to paste the information and
from the Edit menu, select Paste. The appropriate information is copied to your project and it is
attached to the object you selected.

A progress indicator appears and if the operation was not successful or the paste types were 
incompatible, an error dialog box appears.

If you try to drag a project to another window in which there are identical sequence numbers, a 
message box appears warning you that pasting would cause a duplicate key for a task.

It is important to remember that when a copy and paste function is performed, labor tickets or 
materials issues/links are not copied to the new project.

Creating Projects from Other Projects
You can create new projects by copying another project. The copy project function is robust: the 
header card, legs, and tasks associated with the project are copied, along with the information in the 
Project Maintenance and Warehouse Maintenance windows. You also have the option of copying 
budget information and document references.

If you are licensed to use multiple sites, you can create a project for one site from a project created in 
another site, provided that the materials and resources exist in both sites.

1 If you are licensed to use multiple sites, open a project in the site where you want to create a new 
project. You must open an existing project to select the site in which the new project will be 
created. If you are creating a project in your default site, you do not need to perform this step.

If you are licensed to use a single site, you do not need to perform this step. You can create a new 
project from a blank Project Window.

2 From the File menu, point to New Project then From Project, and select the project you want to 
copy.

3 Click the Site ID arrow and select the site that contains the project you are copying. The project 
will be copied to the site in the title bar, provided that the materials and resources exist in both 
sites.
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4 Click the Project ID button and select the project from which you want to create a project.

5 Click in the New Project ID field and enter the identification number for your new project.

You can enter the new Project ID and Version ID, or allow your new project to be auto numbered.

Note: A Lot ID of zero automatically appears in the Lot ID field. If you do not specify a new ID for 
a project, the new project is automatically numbered with the next sequential number. For more 
information on automatic numbering, refer to the Infor VISUAL System Administrator’s Guide.

6 Using the calendar buttons, select the Release and Want dates.

If you do not select Release or Want Dates, the current date is automatically entered.

7 If you want to enter a quantity of more than one, click in the Quantity field and enter the quantity 
you want.

8 If you want this project forward scheduled from the Release date, select the Forward schedule 
from release date check box. 

9 If you want this project scheduled to begin on its release date, select the Treat release date as 
hard check box. 

10 If you want to copy the budget information from the item you are copying, select the Copy budget 
information check box.

11 If you want to copy all document references that have been attached to the item you are copying, 
select the Copy All Document References check box.

12 Click the Save button on the toolbar. 

The project is created with a status of Unreleased.

Because Description field information for the Project and its warehouse is also copied, you may 
want to immediately change the descriptions to better suit the needs of the new project.

Assigning Parts to Project Warehouses
Use the Assign Parts to Project Warehouse feature to add parts to project warehouse locations 
directly from the Project Window.

You can add parts that have an engineering master and any material requirements from the master. 

If you have cleared the Not Allowed option in the Part Location on the Fly check box in Site 
Maintenance, you can add locations to your project warehouse during this procedure. If you have 
selected the Not Allowed option in the Part Location on the Fly check box in Site Maintenance, you 
can only add parts to existing warehouse locations.

To add parts to your warehouse: 

1 Select Edit, Assign Parts to Project Warehouse. 

2 Specify the following information:
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Part ID – Click the Part ID button and select the part you would like to assign to the project 
warehouse. Select a fabricated part that has an engineering master; you cannot add a non-
fabricated part. If you are licensed to use multiple sites, only the parts assigned to the currently 
selected site are eligible for selection.

Part Eng ID – Click the Part Eng ID arrow and select the engineering ID of the master you want to 
use.

Warehouse ID – The system inserts the project Warehouse ID from the header card. 

Location ID – Click the Location ID button and select the location within the warehouse where 
you want to store the part.

If you have allowed part locations to be created on the fly, you can specify a new location ID in the 
field. The system will add the new location to the selected warehouse when you click Save.

Status – Select a status option for the part. If you specify On Hold, specify a Hold Reason ID in 
the Hold Reason ID field.

Description– If you are creating a new warehouse location, enter a description for the location in 
the Description field.

Engineering Master Material Requirement – Select the Include Engineering Master Material 
Requirements check box to add the parts from the material requirements on the fabricated part's 
Engineering Master to the warehouse location as well. 

Include Co-Products – If you selected a fabricated part, select the Include Co-Products check 
box to add the co-products specified on the fabricated part's engineering master to the warehouse 
location as well. 

3 Click Save. If you specified a new location in the Location ID field, and you have allowed the 
creation of part locations on the fly, the system asks you if you want to create the location. Click 
Yes to continue, or No to return to the Assign Parts to Project Warehouse dialog box.

If you have not allowed the creation of part locations on the fly, you must select an existing 
location ID for the system to save the information.

The system adds the part ID you specified to the warehouse location. If you selected the Include 
Engineering Master Material Requirements check box or the Include Co-Products check box, the 
system adds the appropriate parts to the warehouse location.

4 Click Close to exit the dialog box.

Releasing a Project
Before you can record labor against a project, you must release it. To release a project:

1 Select the project’s Header Card.

2 From the Status Change menu, select Release.... The Change Status dialog box appears.

3 To release the entire project, select the Change status of subordinate materials and 
operations check box. 

4 Click Ok. 
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Scheduling Projects
Scheduling is the process of planning the different events of your project and visualizing how those 
events fit into your overall manufacturing timetable.

While VISUAL’s Concurrent Scheduler includes project tasks for processing, Infor recommends that 
users schedule and freeze projects through the Project Window.

Within VISUAL — Projects/A&D, you schedule a project and develop a time-phased budget plan. It is 
from this baseline schedule that Earned Value is calculated. If the project schedule is constantly 
changed, then subsequent earned value calculations become meaningless.

One exception to this rule is when contractual changes to the project or additions/subtractions to 
project scope occur. You can better manage on-going changes to these types of changes in the 
Estimate to Complete (ETC) window within Project Summary.

There are three major reasons for creating a schedule for your project:

• To understand how much of your capacity is already occupied
• To identify possible future threats to on-time deliveries
• To help your production, procurement, and sales departments to work together more successfully

To schedule a project:

1 Click the Site ID arrow and select the site in which the project was created, then open the project 
you want to schedule in the Project Window.

2 From the File menu, select Schedule Current Project.

The production schedule for the site is displayed.

3 If you want to change the Schedule ID for this project, click the Schedule ID arrow and select the 
schedule you want to use. Set up schedules in the Concurrent Scheduler window. For more 
information on setting up schedules, refer to the Infor VISUAL Manufacturing User’s Guide.

4 Click the Schedule button.

The Schedule Progress indicator appears until the scheduling of your project is complete.

Freezing Project Schedules
You can prevent your projects from being rescheduled by Freezing the project.

To freeze or unfreeze projects:

1 In the Project Window, click the Site ID arrow and select the site in which the project was created, 
then open the appropriate project.

2 From the File menu, select Freeze current project.

Note: To Unfreeze projects, select the Unfreeze current project option.
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Using WBS Code Dates as Frozen Schedule Dates
You can use the dates associated with your WBS codes in the project header card as frozen 
schedule dates. To enable this function, open the VISUAL.ini file located in directory where you 
executables are installed. In the [Scheduler] section, find the line, FreezeOpsWithWBSDates. Set the 
line to Y (the line will be FreezeOpsWithWBSDates=Y). The WBS dates will be treated as frozen 
schedule dates

If the FreezeOpsWithWBSDates does not exist in the [Scheduler] section, you can add it. Find the 
[Scheduler] section within the VISUAL.ini file, and enter the following to treat WBS dates as frozen 
schedule dates:

FreezeOpsWithWBSDates=Y.

Auditing Project Schedules
After your project has been scheduled, you can view the results of that schedule using the Project 
Audit feature.

Note: You can only view scheduling audit information for a project you have scheduled.

To view project audit information:

1 From the Project window, select Info, Show Project Audit.... The Select Schedule to Audit dialog 
box appears.

2 Select the schedule you would like to view, then click Ok.

The scheduled tasks for your project using the Schedule ID you selected appears.

3 To view additional information, select a work order, then click Show Detail.... 

4 View information in the following fields:

Work Order ID – The Work Order ID appears in the Work Order ID field.

Part ID – If there is a part associated with your project, the Part ID appears in the Part ID field.

Scheduled Rank – Because the Scheduler can schedule work orders based on their ranking, the 
appropriate rank appears in the Scheduled Rank column.

Out of – The number of ranks appears in the out of field.

Pass Count – The number of passes that the scheduler had to go through before it successfully 
was able to schedule the project appears in the Pass Count field.

Attempt No – The attempt number on which the scheduler attempted to schedule the task into a 
resource appears in the Attempt No column.

Sub ID – The Sub ID of the item on the line appears in the Sub ID column.

Seq No – The sequence number of the item on the line appears in the Seq No column.

Resource ID – The identification number or the scheduled resource appears in the Resource ID 
column.
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Unit No – The amount of the resource you have available appears in the Unit No column: this is 
the Units of Capacity of this resource.

W/O Pass No – The pass on which the scheduler successfully scheduled this line appears in the 
W/O Pass No column.

Dir – The direction in which the scheduler was able to schedule this line appears in the Direction 
column. Depending on your scheduling settings, the scheduler could plan a forward or backward 
schedule.

Result – The result of the scheduled line appears in the Result column.

Result Detail – The details of the schedule results appears in the Result column. 

Start Date – The date on which this line is due to start appears in the Start Date column.

Finish Date – The date on which this line is due to be finished appears in the Finish Date column.

Supply ID – If this line is linked to a work order or purchase order, the identification number of that 
order appears in the Supply ID column.

Early/(Late) – If this line is scheduled to be early or late, the number of days early or late appears 
in the Early/Late column.

5 Select the Show Critical Material check box to view only those materials that may prevent you 
from completing the work order.

6 Additional information appears below the table.

Desired Release Date – The desired release date of the work order.

Desired Want Date – The date the customer would like the deliverable to be completed.

Desired Quantity – The quantity of material to be produced.

Sched Start Date – The date that work is scheduled to begin.

Sched Finish Date – The date that work is scheduled to end.

Received Quantity – The amount that the customer has received.

7 When you have finished examining project audit detail information, click the X button in the top 
right corner of the window. The Work Order Audit dialog box appears.

8 When you have finished examining work order audit information, click the Close button.

Interpreting Result Codes
These result codes are used in the Work Order Audit table:

C – Insufficient capacity

D – Determinant

E – Efficiency

H – Before hard release

L – Load exists
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M – Material

V – Service

N – Not set

R – Concurrent resource conflict

S – Success

T – Before today

F – Frozen

Setting Up Project Budgets
Project budgets express how you want the various costs involved in your project distributed within 
VISUAL — Projects/A&D. 

Note: If you are setting up an RFQ, you can use the budget to reflect the amounts you have quoted.

After you have added all the required tasks to your project structure, you can set the project budget at 
the resource level. To set the project budget, define what resources are required to accomplish each 
task by selecting:

• A Department
• A Cost Category
• An estimate of the labor hours required or an estimate of the monetary cost for materials or other

direct charges such as travel expenses.
• A Distribution ID

Setting Up Budgets
Use the Budget Maintenance window to set up and maintain budgets for each task within your 
breakdown structure.

You can also set up budgets in the Project window. For more information, refer to  “Entering 
Information on the Budget Tab” on page 3–10.

To set up budgets:

1 In the Project Summary window, select Maintain, Budget....

If you selected a project in the Project Summary window, the appropriate WBS information 
appears in the Budget Maintenance window.

Note: You can limit the WBS codes that appear by selecting Starting and Ending WBS codes.

2 If you did not select a project in the Project Summary window, click the Project ID button and 
select the project whose budget you want to set up.
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When you select a project, the appropriate work breakdown structure information appears in the 
table.

3 Click the Rate ID button to select the rate to apply to the budget. For more information on rate 
IDs, refer to  “Setting Up Rate IDs” on page 2–20.

4 Click on the row header for the WBS Code whose budget you want to set up.

5 Click the Insert button to add a new row in the table.

6 Double-click the Dept ID button and select the department you want to use for this budget setup.

7 Double-click the Cost Cat ID button and select the cost category you want to use for this budget 
setup.

8 Double-click the Dist ID button and select the active Distribution ID you want to use for this 
budget setup. The Distribution ID determines how the budgeted hours/costs are spread across 
the duration of the task.

9 Depending on the type of cost category you selected, click in either the Hours or Amount column 
and enter the appropriate figure for this budget.

10 Click the Save button.

If you want to enter additional budget lines for the WBS, click the Insert button again and enter the 
appropriate information for the new budget set up.

Note: Before you can spread your project’s budget, you must first schedule that project. For more 
information, refer to  “Working with Project Inventory” on page 4–3.

Spreading Project Budgets
Dividing your costs for the tasks within a project over the life of each task is commonly known as 
“Spreading Budgets.” Because it is very important to be able to set budgets for your projects and bill 
for your costs over very specific time periods, VISUAL’s Budget window allows you to set different 
budget spreads using different rates.

To set up budget spreads, click the Save/Spread Budget button in the Maintain Budget dialog box. 
The budget spread for your project is calculated based on the budget figures you entered and the 
Distribution ID you selected. For more information, refer to  “Working with the Project Summary 
Window” on page 6–2.

Initializing Estimate to Complete Figures
When you first create the budget for a project, those budget figures are the same as your Estimate to 
Complete figures. To copy a project’s budget figures to its ETC, click the Initialize ETC button in the 
Maintain Budget dialog box. On successful completion of the copy, the system displays a dialog box 
information you that the ETC was initialized successfully.

To view the initial ETC for the project, click the Site ID arrow and select the site to use, then select 
Maintain, ETC... from the Project Summary window.
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For more information on maintaining your ETCs, refer to  “Manually Creating Estimate to Complete 
Figures” on page 7–2.

Locking Project Summaries as Baselines
When you are working with complex contracts and proposals and have established the budget for a 
contract or project, you may not want to allow any changes to that information. Selecting the Lock as 
Baseline check box on the Project Summary window prevents any further changes to your budget 
settings.

Entering Information in the Project Maintenance Window
Because the information you enter in Project Maintenance is used to manage and track your project, 
it is important that you make sure this information is as complete as possible.

You can access the Project Maintenance window in three ways:

• From the Project menu of the main window, select Project Maintenance.
• When creating a new project master in the Project window, enter a new ID in the Project Info field,

then press the Tab key. A dialog box is displayed, asking if you would like to open the Project
Maintenance window. Click Yes to open the Project Maintenance window. For more information,
refer to  “Manually Entering a New Project” on page 3–2.

• In the Project window, right-click in the Project Header and select Project Maintenance. 

To enter project information:

1 Select Project, Project Maintenance to access the Project Maintenance window.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site associated with 
the project. If you are licensed to use a single site, this field is unavailable.

3 If you want to use a custom Project ID for this project, enter a unique identifier in the Project ID 
field. Because IDs must be unique, you may want to leave the Project ID field empty and allow the 
project to be automatically numbered.

4 Click in the Description field and enter a description for this project.

5 Using the appropriate buttons, select the following information:

Project Type – Click the Project Type button and select the type of project you are entering. For 
more information on setting up project types, refer to  “Setting Up Project Types” on page 2–8. 
This is a required field.

Caution:  If you prematurely lock a summary as a baseline, you will not be able to unlock the 
summary for further adjustments. Make sure that the budget on which you are 
working is finished and approved before you lock it.
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Division – Click the Division button and select the division you want to use for this project. For 
more information on setting up divisions, refer to  “Setting Up Divisions” on page 2–9.

Business Line – Click the Business Line button and select the type of business you want to 
associate with this project. For more information on setting up business lines, refer to  “Setting Up 
Business Line Codes” on page 2–11.

Customer – Click the Customer button and select the name of the customer for this project.

Document Currency ID – Click the Document Currency ID arrow to select the currency you 
would like to use for the project.

Description – The description specified for the Project ID.

Contract Type – Click the Contract Type button and select the contract type you want to 
associate with this project. For more information on setting up contract types, refer to  “Setting Up 
Contract Types” on page 2–6.

Summary Code – Click the Summary Code arrow and select the appropriate summary code for 
this project. For more information, refer to  “Setting Up Summary Codes” on page 2–10.

SIC – Click the SIC arrow and select the appropriate SIC for this project.

Status – A status of Unreleased automatically appears in the Status field. For more information 
on how to release a project, refer to  “Releasing a Project” on page 3–34.

Default WBS – Click the Default WBS browse button and select the WBS code to use. If you 
have built your project master, the default ref Sub ID and Seq No for the task associated with the 
WBS code are inserted. 

6 Select the appropriate check boxes:

Create Project Warehouse – Because your project must have a warehouse with the exact same 
project name, the Create Project Warehouse appears automatically selected. After you create 
your project, you can further define your project warehouse in the Warehouse Maintenance 
window. For more information on the project warehouse, refer to  “Refining or Entering Project 
Warehouse Information” on page 3–50.

Note: If you clear the Create Project Warehouse, you have to use Warehouse Maintenance to 
create your project warehouse, remembering to use the same ID for the warehouse as you used 
for the project. We recommend leaving the Create Project Warehouse check box selected to 
ensure that the project warehouse has the same ID as the project.

Gov’t Related – If this project is government related, select the Gov’t Related check box.

DCM Cognizance – If you want this project to be DCM (Defense Contract Management) 
cognizant, select the DCM Cognizance check box.

7 Click the Save button on the toolbar.

Entering Information on the Terms Tab
Use the Terms tab to enter any Terms and Condition IDs you want to associate with this project.

To bring the focus to the Terms tab, click on the Terms tab.
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To enter information on the Terms tab, click the Insert button and select a Term and Condition code 
from the list that appears.

To delete a Term and Condition from the Terms tab, click the row header for the ID you want to delete 
and click the Delete button.

When you have finished inserting Terms and Conditions for this project, click the Save button.

For more information on setting up terms and conditions, refer to  “Setting Up Terms and Conditions” 
on page 2–8.

Entering Information on the Notes Tab
Use the Notes tab to enter any notes or comments about this project.

To enter notes, click on the Notes tab and enter the text you want.

When you have finished entering notes or comments for this project, click the Save button on the 
toolbar.

Entering Information on the User Defined Tab
Use the User Defined tab to enter additional information about your project.

To bring the focus to the User Defined tab, click on the User Defined tab.

Click the User Defined Field Layout ID arrow and select the layout for the tab. Enter the information 
you want in the appropriate fields.

For more information on setting up User Defined Fields, refer to the Infor VISUAL System 
Administrator’s Guide.

When you have finished entering user defined information for this project, click the Save button on the 
toolbar.

Entering Information on the WBS Codes Tab
Use the WBS Codes Tab to enter the work breakdown structure codes for the project. You can also 
enter WBS Codes in the Project window.

Work Breakdown Structures (WBS) are integral to the project environment; without them, you would 
find it difficult to provide the level of reporting necessary to complete your contractual obligations.

Work Breakdown Structures break your projects into trackable and more manageable components. A 
solid structure makes it easy to assign costs and resources to tasks and organizations. 

Work Breakdown Structures:

• Support planning, scheduling, recording, monitoring, analysis, and forecasting of your projects
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• Allow you to have a baseline schedule that can serve as a main tracking document
• Support loading resources and costs onto activities in a schedule allowing for greater planning

and control of your resources

You can automatically carry the WBS codes you assign to your projects over to your Work Orders 
and Purchase Orders.

For example, you link a product requirement to a project WBS code and you have no stock for that 
part and no existing work orders or purchase orders for that part. If you run MRP, the supply orders 
containing the appropriate project, WBS Code, and tasks links are generated. This, in turn, carries 
over links to the purchase orders or work orders you release to production.

To bring the focus to the WBS Codes tab, click on the WBS Codes tab.

To create a new code, click the Insert button on the tool bar, then enter information in the following 
fields:

Code - Enter the code you would like to use in the Code field.

Description - Enter a description of the WBS in the Description field

CDRL - If applicable, enter the Contract Data Requirement List ID you would like to use in the CDRL 
field.

CLIN - Enter the contract line number in the CLIN field, or double-click the browse button to select a 
CLIN from a list.

Note: You cannot enter a CLIN until you have set up the contract for the project in Customer Order 
Entry. For more information, refer to  “Entering Contract Information in Customer Order Entry” on 
page 3–52.

Customer WBS - If the customer uses a WBS code that is different from yours, enter the customer’s 
WBS code in the Customer WBS field.

Status – The status of the project displays in the Status field. 

Billable - Click the Billable arrow and select the billing option you want to use for this WBS. You can 
select either Billable or Non Billable.

Default Dept ID - Double-click the Default Dept ID button and select the department you want this 
WBS to use. A Default Department ID is required for each WBS.

Transfer Costs - If you want to use the transfer costs functionality, select the Transfer Costs check 
box.

The transfer of costs between WBS elements within the same project is not normally allowed; when 
you bring inventory to a WBS and issue it to a shop order in the same project with a different WBS, 
the costs will not transfer. Selecting the Transfer Costs check box allows the transfer of costs from 
one WBS to another.

Copying WBS Codes from an Existing Project
If another project uses the WBS code structure you would like to use for your current project, you can 
copy the WBS codes from the other project. 

To copy the WBS codes:
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1 Click the Site ID arrow and select the site to use.

2 In the Project ID field, enter a new ID for your project. 

3 Select Edit, Copy WBS Structure from Project.

4 Enter the ID of the project whose WBS codes you would like to copy in the Copy from Project 
field, or click the browse button to select an ID from the table. If you are licensed to use multiple 
sites, you can copy WBS structures within the same site only. You cannot copy the WBS structure 
for a project in one site to a project in a second site. 

5 Click Copy to copy the WBS codes to the project currently selected in the Project Maintenance 
window.

Viewing Information on the Customer Order Summary Tab
Click the Cust Ord Summary tab to view the totals for the customer orders associated with a selected 
Site ID and Project ID.

Totals are displayed in both the document currency you assigned for this project and in the system 
currency.

You can view the lines from the customer orders by selecting Info, View Customer Orders.... 

The Customer Orders table lists the lines from all customer orders associated with the project. To 
view an individual customer order, select one of the lines of the customer order you would like to view, 
then click the Open Customer Order button. The Customer Order Entry window opens with 
information for the selected customer order. 

Assigning a Default WBS Code in the Project Maintenance Window
Note: You can also assign the default WBS code in the Project window. For more information,refer to  
“Adding Tasks to Projects” on page 3–7.

After you set up your project master in the Project Window, assign a default WBS code/Sub ID/Seq 
No combination to your project. To assign the default WBS code:

1 From the Project Menu, select Project Maintenance. 

2 Click the Site ID arrow and select the site to use.

3 Click the Project ID browse button and select the project to which you want to assign a default 
WBS code. The information for the project appears in the window.

4 Click the Default WBS browse button to select the WBS code/Sub ID/Seq No combination you 
would like to use as the default.

Note: Only WBS codes with tasks assigned to them are eligible for selection in the Default WBS 
field. If you have not assigned a task to a WBS code, the code will not appear in the WBS browse 
table. 

5 Click the Save button.
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Creating a New Project from an Existing Project
You can create a new project in the Project Maintenance window by copying an existing project. 
When you copy a project in the Project Maintenance window, only the project information that you 
enter in the Project Maintenance window copies to the new project. You will need to finish setting up 
the project in the Project window. For more information on the Project window, refer to  “Manually 
Entering a New Project” on page 3–2.

If you are licensed to use multiple sites, you can copy projects within the same site only. You cannot 
copy a project in one site to create a new project in a second site in Project Maintenance. To copy 
project information from one site to create a new project in a second site, use the Project Window.

To copy an existing project:

1 Click the Site ID arrow and select the site in which the project was created.

2 From the File menu, select Copy Project. 

3 Type the ID of the project you would like to copy in the Copy from Project field, or click the browse 
button to select the ID from the table.

4 Enter an ID for the new project in the Copy to Project field.

5 Select the Create Project Warehouse check box to create the warehouse associated with the 
project. We recommend selecting the Create Project Warehouse check box.

6 Click Save to create the new project.

The system copies all the information in the Project Maintenance window except the default WBS/
Ref Sub ID/Ref Seq No. The system also copies the information in Contract General Information 
and Contract Financial Information.

Entering Contract and Billing Information in Project 
Maintenance
After you enter contract information through Customer Order Entry, set up your project’s financial 
parameters through Project Maintenance. You may find it helpful to keep the customer order for the 
project open so you can refer to it easily. Because some information flows from window to window, 
you should enter the information in the following order:

1 Contract General Information

2 Contract Financial Information

3 Billing Ceilings

Step 1 – Entering Contract General Information
Contract general information is the static information about the negotiated contract between you and 
your customer.
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To enter Contract General information, select Contract General Information from the Maintain menu 
of the Project Maintenance window, or right-click in the Project Maintenance window and select 
Contract General Information.

Enter the following information in the Contract General Information window:

Contract ID – Enter the identification your customer assigns to this contract—the Contract ID 
identifies this contract to your customer.

Contract Desc – Enter a description for this contract.

Contract Mod ID – Specify a modification ID. This information is used in the Contract Financial dialog 
box. Specify a modification ID even if this is the first version of the contract. 

Contract Mod Desc – Click the Contract Mod Desc button and select the file containing the specifics 
of the contract.

Prime Contract ID – If this contract is part of a larger contract, even if other companies are handling 
the other parts, enter an identification for the top level of the contract.

Prime Customer – Click the Prime Customer button and select the name of your customer.

Subcontract ID – If this contract is part of a larger contract, even if other companies are handling the 
other parts, enter an identification specifically for this part of the larger contract.

Customer PO – Enter the Purchase Order number from your customer for this contract.

Security Class – Click the Security Class arrow and select the level of security you want to use for 
this contract. 

Priority – Click the Priority button and select the priority rating you want to use for this contract.

Contract Value – Enter the total amount of your costs and profits: this is the total amount for which 
your customer is responsible.

Contract Admin – Click the Contract Admin button and select the employee who is responsible for 
the administration of this contract. All employees in your database are displayed. If you are licensed 
to use multiple sites, you can choose an employee from a different site than the project. This 
employee may not be able to access all information about the project, however.

Program Manager – Click the Program Manager button and select the employee who is responsible 
for the management of the contract. When you run material requirements planning in the Material 
Planning Window, you can choose to run MRP by program manager. If you designate the inventory 
sharing policy for your warehouse as P in Warehouse Maintenance, then only the user designated as 
the program manager can transfer inventory from the project warehouse. 

All employees in your database are displayed. If you are licensed to use multiple sites, you can 
choose an employee from a different site than the project. This employee may not be able to access 
all information about the project, however

Financial Analyst – Click the Financial Analyst button and select the employee who is responsible 
for analyzing the financial information for this contract. All employees in your database are displayed. 
If you are licensed to use multiple sites, you can choose an employee from a different site than the 
project. This employee may not be able to access all information about the project, however

RFP ID – Specify the request for proposal ID (RFP) ID for this contract. 

RFP Due Date – Use the Calendar button to select the date on which the response to the RFP is due.
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Award Date – Use the Calendar button to select the date on which you were awarded this contract.

Master Plan Date – Use the Calendar button to select the Master Plan Date. The Master Plan Date 
can be the date on which you plan on starting work on this contract or the date on which you plan to 
complete the contract.

In the Period of Performance section:

From – Use the Calendar button to select the date on which the physical work is due to start for this 
contract.

To – Use the Calendar button to select the date on which the physical work is due to end for this 
contract.

The Project window will use the dates you enter in the Period of Performance section to aid in 
scheduling the project.

When you have finished entering Contract General information, click the Save button. To close the 
dialog box, click the Close button.

Step 2 – Entering Contract Financial Information
Use the Contract Financial Information window to manage the financial billing and funding of your 
project. Depending on the type of contract on which you are working, some of the fields in this window 
may be mandatory and others may be for informational purposes. The more information you include 
in this window, the more complete your project financial analysis will be.

To enter Contract Financial Information, select Contract Financial Information from the Maintain 
menu of the Project Maintenance window, or right-click in the Project Maintenance window and select 
Contract Financial Information.

Enter the following information in the Contractual Financial Information window:

Contract Mod ID – If this contract has been modified, and you have entered a modification ID in the 
Contract General Information window, the modification ID appears in the Contract Mod ID field.

Contract Mod Descr – If you have specified a Contract Mod Description in the Contract General 
Information window, the description appears in the Contract Mod Desc field.

Project Currency – If you specified a currency in the Project Maintenance window, the currency ID 
appears in the Project Currency field.

Funded Value – The value up to which your customer is funding you at the time you enter this 
contract.

Contract Ceiling – If the contract on which you are working has a fixed price, enter the maximum 
amount you have negotiated for the contract.

Audit Agency – If this contract is to be audited, click the Audit Agency button and select the name of 
the appropriate Audit Agency.

Paying Office – Click the Paying Office button and select the office from which you can expect your 
customer to make payments on this contract.

Firm Fixed Price – If you are working with a Firm Fixed Pricing structure, enter the appropriate price.
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Fixed Fee Amount – If you are working with a Fixed Fee Amount structure, enter the negotiated fixed 
fee.

Target Cost – Enter your calculated final Cost of Goods figure in the Target Cost field.

Target Fee Amount – If you are working with a fee based pricing structure, enter the final fee amount 
in the Target Fee Amount field.

Minimum Fee – If you entered a value in the Target Fee Amount field, enter the minimum amount of 
that fee you will bill to the customer per billing cycle.

Maximum Fee – If you entered a value in the Target Fee Amount field, enter the maximum amount of 
that fee you will bill to the customer per billing cycle.

Prov Billing Rate – Click the Prov Billing Rate arrow and select the provisional billing rate you will 
use until your customer sets the final billing rate for this contract. For information on Provisional Billing 
Inquiry, refer to  “Provisional Rate Billing Inquiry” on page 6–28.

Hours Expended Fee – Enter the negotiated profit you can charge for each hour of labor for which 
you can bill your customer.

Award Fee Amount – If you have negotiated an award fee that is due upon the awarding of the 
contract to you, enter the amount of that award.

Award Fee Descr – Click the Award Fee Descr button and select the file containing a description of 
the award structure.

Perf Based Fee Amount – If you are working with a performance based pricing structure, enter the 
Fee Amount.

Perf Description – If you are working with a performance based pricing structure, click the Perf 
Description button and select the file containing a description of the Fee structure.

Progress Payment Rate – If this contract involves payment due based on your progress, enter the 
rate at which you can bill for those payments.

Liquidation Rate – Enter the rate at which you will bill your customer for products you deliver on 
progress payment type contracts. (Line 6b of form 1443.) As you make shipments you would liquidate 
previously submitted progress payment amounts. Your final liquidations occur at the conclusion of the 
contract.

For example: If you have a shipment with a value of $10,000 and the liquidation rate is 80%, you 
would bill your customer for 20% of the value of the contract line and the remainder would be an 
offset liquidation entry against the previously applied progress payments.

Loss Ratio Factor – Enter the loss ratio factor you want to use in preparation of any Form 1443, 
Request for Progress Payments forms. Normally this figure would represent the target price of the 
contract divided by the EAC.

Retainage Percent – Enter the percent that your customer withholds from your billings. 

This is the money a contractor has earned but is held by the customer to provide the funds necessary 
to complete work in the event the contractor fails to do so. The amount of retainage typically ranges 
anywhere from 5% to 15% but can be more—although it is sometimes reduced as a contract 
progresses. You will generally not release the retainage amount until the entire project is close to 
completion or finished.

In the Overrun Incentive Fee Ratio section:
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Customer Share – The percentage of the overrun for which your customer is responsible.

Contractor Share – The percentage of the overrun for which you or your contractor is responsible.

In the Underrun Incentive Fee Ratio section:

Customer Share – The percentage of the underrun for which your customer is responsible.

Contractor Share – The percentage of the underrun for which you or your contractor is responsible.

Note: When entering Overrun and Underrun Fee Ratios, make sure the totals equal 100%.

When you have finished entering Contract Financial information, click the Save button. To close the 
dialog box, click the Close button.

Step 3 – Entering Project Billing Caps and Ceilings
Caps and Ceilings are limits you can establish for your projects and contracts. You can set ceilings 
based on categories of direct and indirect expenses as well as fees and apply them to hours, costs, or 
percentages of applied burden rates.

Ceilings on hours and costs are classed as absolute ceilings. Ceilings on rates are normally 
percentages that you cannot exceed, making any amount of applied burden below the ceiling rate 
acceptable.

Because of the nature of contracts, your ceilings may be contractually stated for any burdens or fees 
associated with specific costs: normally direct costs. During contract negotiation for cost reimbursable 
type contracts, you will normally establish caps and ceilings to set limits to reduce the risk or 
exposure of the customer.

Examples of caps or ceilings representative of the Aerospace and Defense contracting environment 
are:

• The contract imposes a cap on the cost category of Travel of $20,000.
• The contract imposes a cap on engineering labor that cannot exceed 100 hours.
• The contract imposes a cap on G/A burden category in terms of percentage: the customer will not

pay for general and administrative expenses in excess of 22%.

More complex examples need to accommodate caps or ceilings based on combinations of direct and 
indirect costs and fees (profit):

• The contract imposes a G/A cap of 5% on the rate applied to travel and ODC cost categories.
• The contract does not allow fees on costs associated with Material and Subcontract cost

categories including any associated burdens.

To enter billing ceilings:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the project. If you are licensed to use a single site, this field is unavailable.

2 Click the Project ID browse button and select the project for which to create billing ceilings.

3 Select Billing Ceilings from the Maintain menu of the Project Maintenance window, or right-click 
and select Billing Ceilings.
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4 Click the Insert button.

5 Double-click the CLIN column header and select the customer line item number that the billing 
ceiling applies to from the list. 

6 Double-click the Cost/Burden Category column header and select the cost category to which 
you want this ceiling to apply.

If you select a Burden category, <ALL> appears in the Base Category column automatically. If you 
want to select a specific category to further limit where the ceiling will affect, double-click the Base 
Category column header and select the category you want.

If you select a Direct category, <N/A> appears in the Base Category column automatically. You 
cannot further limit ceilings for Direct categories.

7 If you selected a Direct cost category, select the basis for the billing cap. Your choices are Hours 
and Amount.

If you selected a Burden cost category, Percent appears in the Basis column by default. You 
cannot change it.

8 Press the TAB key and enter the value for this basis.

9 Press the TAB key and enter a description for this ceiling.

10 Click the Save button.

11 When you have finished entering ceilings for this contract, click the Close button.

Refining or Entering Project Warehouse Information
If you created a project warehouse when you created the project, you may want to alter the 
warehouse’s information through Warehouse Maintenance. Otherwise, the project warehouse you 
created will have the same information as your project warehouse template.

If you chose not to create the project warehouse when you created the project, you must create a 
project warehouse through Warehouse Maintenance with the same ID as the project.

Refining Project Warehouse Information
To alter the information for the warehouse you created through Project Maintenance:

1 From the Inventory menu, select Warehouse Maintenance. The Warehouse Maintenance window 
appears.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which the 
warehouse was created. If you are licensed to use a single site, this field is unavailable.

3 In the Warehouse ID field, enter the ID of the warehouse you created in Project Maintenance. 
This ID is the same as the project ID. Click the Warehouse ID browse button to select the 
warehouse from a table. Information for the warehouse appears in the window. Most of this 
information is based on the project warehouse template.
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4 Enter information specific to the project warehouse as necessary. You may find it helpful to enter 
a more accurate description in the description field. You may also want to add or alter the 
warehouse locations.

5 When you have finished, click the Save button. 

Creating the Project Warehouse
If you created the project warehouse through Project Maintenance, you do not need to perform this 
step. Only perform this step if you cleared the Create Warehouse check box when creating the project 
in Project Maintenance.

1 Select Warehouse Maintenance from the Inventory menu. 

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which the 
project was created. If you are licensed to use a single site, this field is unavailable.

3 In the Warehouse ID field, enter the ID of your project. Make sure that the ID you enter for the 
warehouse is identical to the project ID.

4 In the Description field, enter a description of the warehouse.

5 Click the Address button to enter the warehouse’s address.

6 In the Country ID field, enter the ID of the country where the warehouse is located. You can enter 
a country only if the Intrastat option is enabled.

7 In the Region ID field, enter the ID of the region where the warehouse is located. You can enter a 
region only if the Intrastat option is enabled.

8 If the warehouse is a VISUAL Distribution warehouse, select the VDW Installed check box. VDW 
warehouses can only be used in conjunction with VISUAL Distribution.

9 If the warehouse is an independently planned warehouse, select the Independently Planned 
Warehouse check box. Independently planned warehouses are eligible for MRP on an individual 
basis. Warehouses that are not independently planned belong to the warehouse designation 
UNIVERSAL. 

10 Select the MRP Exempt check box if you would like to exclude the warehouse from material 
resource planning. You may want to select this check box upon the conclusion of a project to 
prevent material resource planning from using the warehouse during processing. 

11 If the warehouse supports WIP/VAS, select the WIP/VAS supported check box. WIP/VAS must 
be activated in Accounting Entity Maintenance.

12 Click the Inventory Not Shared arrow to define whether or not the warehouse shares its inventory. 
Select Y if the warehouse does not share inventory. Select N if the warehouse does share 
inventory. Select P if only the program manager can transfer inventory to other warehouses. 
Specify the program manager in the Contract General dialog box in Project Maintenance.

13 To add a location to the warehouse, click the Insert Row button on the tool bar. A new line 
appears in the location table.

14 Enter the Location ID for the location you are creating within the warehouse.
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15 Select the type for the location from the Type drop down section. 

The five types are: Regular, Floor Stock, In Transit, From Customer, and From Vendor. The From 
Customer and From Vendor types are used with consigned inventory. See "Consigned Inventory" 
on page 12–1 in the Inventory guide

16 Enter a description for the location in the Location Description column.

17 You can continue to enter additional locations by clicking the Insert Row button and repeating the 
procedure.

18 Click the Save button to save the warehouse information.

Entering Contract Information in Customer Order Entry
Enter your contracts using the Customer Order Entry window.

The individual lines of your contracts are tied to their respective projects using CLINs, Contract Line 
Item Numbers. By using CLINs, you can reference each contract line to a specific leg within the 
appropriate project. By using a specific work breakdown structure (WBS) to reference the legs within 
a project and using the same WBS codes for the corresponding work orders that belong to the 
project, you can set up a system of references that enable you to track labor and expenditures for 
your contract.

Entering Project Information in Customer Orders
The process for creating customer orders related to projects is essentially the same as the process 
for your commercial customer orders. Please consult the Infor VISUAL Sales User’s Guide for a 
detailed description of entering customer orders. For projects, pay particular attention to the following 
fields:

Site ID – Click the Site ID drop-down and select the site in which the project was created. 

CLIN – If your customer has supplied you with a Contract Line Item Number (CLIN), enter it in the 
CLIN column of the line item table. For projects, entering this number is important because it is used 
elsewhere in project setup.

Warehouse ID - The Warehouse ID is an extremely important field; it links the line item in your 
customer order to a project. Double-click the Warehouse ID button to select your project from a table.

Contract Type - The Contract Type field is populated based on the Warehouse ID you selected in the 
Warehouse ID field.

Billing Basis - The Billing Basis field is populated based on the Warehouse ID you selected in the 
Warehouse ID field.

 WBS Code – Double-click the WBS Code to associate the line item with a particular WBS.

Proj Ref Seq No - Double-click the Proj Ref column header to select the Project Reference 
Sequence Number from the table. 

Proj Ref Sub ID - This field is populated based on your selection in the Proj Ref Seq No field.
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Revenue Acct ID - This field is populated based on your selection in the Warehouse ID field. You can 
change the account ID, but do so with caution. Changing the ID will affect the way the line item is 
posted to the general ledger and can have impact on revenue recognition. The description of the 
account appears in the Revenue Acct Descr field.

Link Part ID - This field is automatically populated.

Link Warehouse ID - This field is populated based on your selection in the Warehouse ID field.

DD250 – If the customer order you are entering requires a Receiving and Inspection Report (DD250), 
select the DD250 Required check box on the Other tab of the Customer Order Entry window.

Working with DD250s
DD250, or DD Form 250, is a multipurpose report you must use:

• To provide evidence of Government contract quality assurance at origin or destination
• To provide evidence of acceptance at origin or destination
• As a packing list for shipping and receiving
• As a contractor invoice for payment
• For commercial invoice support

Using the DD Form 250 as an invoice streamlines the payment process, reduces paperwork, and 
eliminates paying office problems. 

Setting up DD250s
After you have entered your Customer Order and selected the DD250 Required check box, you must 
specify the information you want to appear on the DD250.

To set up your DD250:

1 Complete the customer order and save it to your database.

For more information on completing customer orders, refer to the Infor VISUAL Sales User’s 
Guide.

2 From the Edit menu, select DD250.

3 Click the appropriate button and select the following. When you click each button, you can select 
an existing address or create a new one.:

Prime Contractor – Select the prime contractor’s name and address. This will probably be you or 
your sub-contractor, if they are shipping directly.

Administered By – Select the name and address of the person or office who is administering the 
contract. You can usually find this information in Contract Section G under Contract 
Administration Office (CAO).

Shipped From – Select the address from which you are shipping the items on this order. 
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Pay Made By – Enter the information that appears in the “Payment will be made by” block of the 
contract award form that relates to this project.

Shipped To – Select the ship to address for the assets listed in Block 15 of the contract. This 
address is usually the receiving station at the site. Your customer may not specify the shipping 
instructions in the contract, they can only specify them at the time of shipment. 

Marked For – Select the final destination at the site that is to receive the shipment. You can 
usually find this information on the shipping instruction that accompanies the contract.

4 In the Contract Quality Assurance section, select the following that apply:

CQA – If Contract Quality Assurance (CQA) is to be performed at the origin or destination, select 
the appropriate check box.

Acceptance – When the acceptance of the quality assurance is at the origin or destination, select 
the appropriate check boxes.

5 If you want to enter package level information, click in the Package Level field and enter the 
information you want.

6 In the Acceptance Point section, select the appropriate acceptance point of this shipment. The 
acceptance point is normally designated in Contract Section E – Inspection and Acceptance.

7 Click the Save button.

Entering the Initial Formal Project Estimate at Completion 
and Target Costs Information
Because the life of your contracts can span months or even years, it is probable that your costs will 
deviate from their initial estimated values. You are provided with a method of saving your changes for 
later comparison. This functionality also allows you to create several Estimates at Completion (EACs) 
in advance—perhaps based on figures you know might change—and specify the one you want to use 
as a current version.

Your first EAC typically matches the initial budget for the project, which also matches the first ETC. 

Note: You may find it easier to decide on a numbering sequence before you start so that the versions 
make sense to you in the future. For more information on setting up a numbering scheme for your 
EACs, refer to  “Setting Up Automatic Numbering for ETCs and EACs” on page 7–1.

To create the first formal EAC:

1 Select Project, Project Summary Window. 

2 Select Maintain, EAC/Target Costs. 

3 In the Project EAC/Target Cost dialog box, click in the Project ID field and enter the Project ID for 
which you would like to enter EAC information, or click the Project ID browse button and select a 
project. 

4 Click in the EAC Version field and enter the version number you want to enter for project.

5 Click the Calendar button and enter the date for this version.
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6 Click the Linked ETC Version button to select the ETC you would like to link to this EAC. When 
you link an ETC to an EAC, information from that ETC populates portions of the table in the lower 
portion of the window, allowing you to easily compare the estimate to completion to the estimate 
at completion. 

7 Since this is the first EAC, select the Baseline check box and the Current Version check box.

8 To insert the figures from the informal EAC, click the Init from Informal EAC button. The system 
will transfer the figures from the informal EAC in the Project Summary window to the formal EAC.

9 Click in the Current Formal EAC w/o Reserve column to adjust the amounts for hours, labor, 
material ODC, burden w/o COI (cost of investment) and COI (cost of investment). As you enter 
figures, the total amount appears in the Project Totals row and in the Target Cost field in the 
Summary tab.

10 Click in the Reserve column to enter reserve amounts. for hours, labor, material ODC, burden w/o 
COI (cost of investment) and COI (cost of investment). As you enter figures, the total amount 
appears in the Project Totals row.

11 In the Summary tab, view the following information:

Target Price – This amount is calculated by adding the Target Cost and the Target Profit/Fee 
Amount.

Target Cost – This is the total anticipated actual costs for the project. Enter this information in the 
Contract Financial Information window. For more information, refer to  “Step 2 – Entering Contract 
Financial Information” on page 3–47.

Target Profit/Fee Amount – This is the total anticipated profit or fixed fee for the project. Enter 
this information in the Contract Financial Information window. For more information, refer to  “Step 
2 – Entering Contract Financial Information” on page 3–47.

Target Profit/Fee Percent – This is the total profit/fee expressed as a percentage of the total 
target cost. 

12 Click the Detail tab to view the contract modification ID, the contract type, and the project type. 
You enter the contract modification ID, contract type, and project type in the Contract General 
information window. For more information, refer to  “Step 1 – Entering Contract General 
Information” on page 3–45.

13 Click the Save button.

14 When you have completed creating the initial EAC, click the Close button.
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Chapter 4: Project Execution

In this chapter, you’ll learn how to use VISUAL’s standard modules to assign labor and materials to 
projects. You’ll also learn how to close a project.

This chapter includes:

Topic Page

Creating Quotes for Existing Projects............................................................................................. 4–2
Working with Project Inventory ....................................................................................................... 4–3
Understanding Planned Supply .................................................................................................... 4–12
Assigning Labor Costs to Projects ................................................................................................ 4–17
Costing and Posting...................................................................................................................... 4–20
Setting Up the Barcode Transaction Scanner to Record Project Transactions ............................ 4–21
Setting Up Wedge Barcode Labor Entry to Record Project Transactions..................................... 4–21
Closing Projects............................................................................................................................ 4–22
About Project Statuses ................................................................................................................. 4–26
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Creating Quotes for Existing Projects
You can specify project information in the Estimating Window to link a quote to a project. The 
information you specify links the quote to the project.

In the Estimating Window header, specify information as you would in a non-project quote. Then, click 
the Project tab. Click the Project Info button and select the project to associate with the quote. The 
system inserts the Project Type, the default WBS code, and the Project Warehouse from Project 
Maintenance.

In the line table, specify information as you would in a non-project quote. If you have built the project 
structure in the Project Window, you can enter the following project-specific information:

WBS Code – Double-click the WBS Code browse button and select the WBS code to associate with 
the line. The system inserts the WBS Description and CLIN number associated with the WBS code.

Proj Ref Seq No – Double-click the Proj Ref Seq No browse button and select the sequence number 
to associate with the line. The system inserts the Proj Ref Sub ID based on your Proj Ref Seq No 
selection.

Creating a Project from the Estimating Window
You can begin project creation directly from the Estimating Window. 

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
creating the project. If you are licensed to use a single site, this field is unavailable.

2 In the Project tab, enter the project ID in the Project Info field, then tab out of the field. 

3 The system asks if you want to add the project. Click Yes to continue. 

4 The system opens the Project Maintenance window. Build the project for your request for 
proposal. At minimum, specify the project type, document currency ID, and at least one WBS 
code. For more information, refer to “Entering Information in the Project Maintenance Window” on 
page 3–40.

5 Return to the Estimating Window and refresh the window. The system inserts the information you 
specified in the Project Maintenance Window.

6 After you build the project structure in the Project Window, you can specify WBS Codes and 
Project Reference Sequence Numbers for each quote line. After you associate quote lines with 
project references, you can view the links in the Project Status dialog box. You can access the 
Project Status dialog box from the Project Summary window and the Project window.

The dialog box shows only the links to the cost source, not the costs themselves.
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Project References in Quote Masters
When you link lines in the Estimating Window to projects and specify Quote Master in the cost source 
field, the system does not update the quote master with the project references. This allows you more 
flexibility to change quotes as needed and to use quote masters as a cost source on multiple estimate 
lines.

Working with Project Inventory
Using the Universally Planned Material functionality, you can help automate part of the material 
planning process capturing the benefits of bulk purchasing and manufacturing.

You can purchase material in either of the following ways:

Directly to projects – When you purchase materials or components directly to projects, the 
associated costs are assigned to the appropriate project. You can purchase materials directly to a 
project through Purchase Order Entry.

To common or universally planned inventory – When you purchase Universally Planned material, 
the associated costs are tracked and they are not assigned to a project until you transfer the material 
into the project warehouse.

Because most material you purchase is automatically assigned to your projects—this is industry 
standard—you must specify which materials you want to be Universally Planned.

Please note that VISUAL is designed to apply burden against initial transactions only. These 
transactions include: Inventory Adjustments In, Labor Transactions, Purchase Receipts, General 
Journal Entries and manual AP invoices linked to production.

"Move" transactions including Transfers, WIP Issues, Inventory Adjustments Out, Shipments, and 
Return transactions do not create burden in VISUAL. These transactions move costs at a summary 
level only. When the move transactions take place they create cost layers that summarize each cost 
component (Material, Labor, Burden, and Service/Other Direct Costs) on a General Ledger and Cost/
Burden Category level. Not all of these transactions create project summary records.

Finished Goods and sub-assembly receipts from project work orders do not create burden. Inventory 
transactions for these records also display summary value for cost components. These transactions 
also do not create Project records.

For more information on Inventory and Material Planning, refer to the Infor VISUAL Inventory User’s 
Guide.

Ordering Parts Directly for Projects
During a project’s budgeting set up you may specify the budgeting of a material necessary to 
complete your project. Because you must attach your budget lines to specific WBS codes and specify 
appropriate Dept IDs and Cost Cat IDs, you can link the materials you have budgeted to purchase 
orders and thereby track your purchasing costs.
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When entering a purchase order for a material that relates to a project, enter the following information 
for each line within the purchase order:

1 From the main window, select Purchase Order Entry from the Purchasing menu.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the project. If you are licensed to use a single site, this field is unavailable.

3 If the entire order is associated with a project, click the Warehouse ID button to select the project 
warehouse. 

4 For each line on which you are entering material for a project, double-click the Warehouse ID 
column header and select the warehouse to which you want to receive this material. 

5 Double-click the WBS Code column header and select the WBS Code to which you want to 
reference this material.

Only the appropriate WBS Codes for the warehouse (project) you selected appear.

6 Double-click the Proj Ref Seq No column header and select the sequence number to which you 
want to reference this material.

The appropriate Sub ID appears in the Proj Ref Sub ID column.

7 Double-click the Dept ID column header and select the department to which you want this 
material’s costs collected.

8 Double-click the Cost Cat ID column header and select the cost category to which you want this 
material’s costs collected.

9 If there is a work order or base ID created for this line item, double-click the Base ID button to 
select the appropriate order,

10 If you have finished entering all of the relevant information for this purchase order, click the Save 
button on the tool bar.

Working with Project Information in the Purchase Management 
Window
Fields for WBS codes, Project Reference Sub IDs, Project Reference Sequence Numbers, 
Department ID, and Cost Category ID appear in several of the tools in the Purchase Management 
Window. These fields help to identify the resources you use for projects. The tools with project 
information include:

• Purchase Order Entry
• Part Demand
• Part Management
• Part History
• Vendor History
• Session P/O History



Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense | 4 – 5

For more information, please refer to the “Purchase Management Window” chapter of the Infor 
VISUAL Purchasing User’s Guide. 

Linking Material Planning to Projects
Note: For more information on the Material Planning, please refer to the Infor VISUAL Manufacturing 
User’s Guide.

If you are working in the Material Resource Planning window with a material you have specified on a 
project, that material’s project details appear in the material tables.

Note: In order for you to view the project details of your parts, select Show Standard in the View 
menu.

When you select parts you have specified on projects, the following information appears in the 
Material Planning window:

Required WBS – The work breakdown structure on which you specified the material or part appear in 
the Required WBS column.

Demand Order ID – The customer order on which you have specified the need for the material or part 
appears in the Demand Order ID column.

Warehouse ID – The appropriate warehouse name appears in the Warehouse ID column. For 
materials and parts on a project, this should be the same as your project warehouse name.

Note: You can assign supply and demand orders to warehouses that are exempt from material 
requirements planning (MRP-exempt). Material requirements planning, however, will ignore the 
supply and demand orders linked to MRP-exempt warehouses.

Viewing Project-Related Resources in the Material Planning Window
You can limit the warehouses that appear in the Warehouse ID drop-down list to project-only 
warehouses or project warehouses for a certain program manager. To limit the warehouses that 
appear in the Warehouse ID drop-down list, click the Warehouse Filters button. 

Select from the following options:

Exclude MRP Exempt Warehouses – Select this check box to remove MRP exempt warehouses 
from the drop-down list. You can designate a warehouse as MRP Exempt in Warehouse 
Maintenance. 

Project Warehouses Only – Select this check box if you would like to view only project-related 
warehouses in the drop-down list. If you select this check box, the Program Manager drop-down list 
becomes active.

Program Manager – Click the Program Manager arrow to select the program manager whose project 
warehouses you would like to view. Select a Program Manager in the Contract General window 
located in Project Maintenance. For more information, refer to  “Step 1 – Entering Contract General 
Information” on page 3–45.
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Active – Click the Active check box to apply the filter. Clear the check box to remove the filter from 
the list. 

Processing Project-Related Resources in Material Requirements Planning
Material Requirements Planning is an optional module that generates planned demand and supply 
orders for a part based on the part’s Order Policy, demand, and master production schedule (for a 
master scheduled part). These orders appear in material netting in the same way as actual orders. 
You can then firm and release the planned orders into real purchase and/or work orders. For more 
information on Material Requirements Planning, please refer to the Infor VISUAL Manufacturing 
User’s Guide.

Note: If you have assigned any supply or demand orders to warehouses that are MRP-exempt, 
material requirements planning will ignore these orders during processing. 

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Select the Material Requirements Planning option from the File menu.

3 To process project-related materials, select Project from the Warehouse arrow. When you select 
Project, the Program Manager field becomes active.

4 Click the Program Manager drop-down to select the program manager whose projects you would 
like to process. When you select a Program Manager, the only the projects connected to the 
Program Manager appear in the list. Select a Program Manager in the Contract General window 
located in Project Maintenance. For more information, refer to  “Step 1 – Entering Contract 
General Information” on page 3–45.

5 Select the scope of processing.

As transactions are performed, parts are marked as requiring MRP. Events that trigger this 
marking include creation and modification of purchase orders, customer order, and work orders 
for the part, as well as inventory transactions involving the part. This is done so you can process 
only those parts that might require changes, rather than all parts. The number of parts marked in 
this way is shown as Parts Requiring MRP Processing.

There are two choices for the scope of MRP processing:

Process All Top Level Parts (Regeneration) – A top-level part is one that is not required in any 
material requirement for a work order. Demand orders for top-level parts are only customer 
orders.

If you select this option, top level parts are processed on the first MRP pass whether they are 
marked for MRP or not. Non-top-level parts are processed if they are marked for MRP.

Process Parts Changed Since Last Run – Only parts marked for MRP are processed.

6 Select Single or Multiple Level Processing.

When MRP processes a set of parts, it generates two kinds of orders. Planned supply orders are 
created to meet existing demand for each part. Planned demand orders are also created to 
account for the material requirements of the newly planned orders.
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If you select the Single Pass check box, the process stops after the first pass. Otherwise, MRP 
makes a second pass, and considers the new demand orders caused by the newly planned 
supply orders. Passes are continually ran until new demand orders can no longer be created.

7 Set Exception Marking Limits.

During processing, MRP marks parts as having exceptions if a planned order is created, or if one 
of the normal netting exceptions (for example, Stockout) occurs for the part. You can use this 
marking as part of the query in the Search option. This allows you to focus on parts that may need 
your attention.

You have three options to control how this marking is done with regard to horizon:

No Horizon – Any exceptions appearing for the part mark the part as having MRP exceptions, 
regardless of how far out they are.

Fixed Horizon – Select the Fixed Horizon option and specify the number of days to look forward 
from the current date for exceptions. MRP only marks the part as having exceptions if any occur 
within this time frame. Specify Horizon in days.

Plus Part Leadtime – Select the Plus Part Leadtime option and specify the time frame you want 
to include for part. This produces a horizon that varies for each part. For a given horizon, parts 
that take longer to get are more likely to appear as MRP exceptions.

8 Select the Net on-hand quantities for master scheduled parts check box if you want netable, 
on-hand balances subtracted from planned orders generated during the MRP run for parts with an 
order policy of Master Schedule.

In order to accurately determine how many units to build for a period, most manufacturers use a 
series of calculations to determine their “net supply plan,” or build plan for a period.

In some cases, they determine the “net supply plan” by subtracting their current inventory from 
the current projected demand (forecast). By doing so, they are determining what they need to 
build or buy for the period. This calculation needs exercise at all levels of manufacture, starting at 
the finished goods level, and continuing all the way to the component piece part level. MRP 
performs this calculation for all materials with an order policy of master scheduled.

What is the Supply Plan?

In basic terms, the supply plan is what must be supplied (fabricated or purchased) in order to 
meet the demand (forecast).

The supply plan is made up of three types of supply orders: Released orders, Firmed orders, and 
Planned orders. Because you control released and firmed orders, they are not rescheduled 
during an MRP run. Planned orders are generated during an MRP run when supply orders are 
found to be less than demand. Planned orders alert you that you should increase the orders to 
meet demand.

If you do not change the status of planned orders to either firmed or released before the next 
MRP run, they are deleted and new planned orders are created based on the demand numbers in 
effect during the next MRP run.

With this check box selected, on-hand balances are subtracted from the planned orders that are 
generated for items with an order policy of Master Schedule. Functioning in this manner, the 
number of units needed for supply at the master schedule level can be accurately displayed.
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9 If you want the minimum, maximum, and multiple order quantity settings for each part considered, 
select the Apply Min/Max/Multiple to Master Scheduled Parts check box. The quantity ordering 
requirements for your parts are taken into account.

10 If you do not want on-hold customer orders considered during the MRP run, select the Exclude 
On-hold Customer Orders check box.

11 If you do not want unreleased work orders considered during the MRP run, select the Exclude 
Unreleased Work Orders check box.

12 If you want a log file generated for the MRP session, select the Log MRP check box. The log file 
appears in the directory where your executables are installed as a text file named 
VMPLNWIN.LOG.

13 To start processing, click the Ok button.

Note: Depending on the number of parts that require processing, the number of demand orders, 
the speed of your machine, and other factors, MRP may take a few minutes to run.

Linking Purchase Requisitions to Projects
You can generate purchase requisitions by project. 

1 Open the Purchase Requisition window, click the Site ID arrow and select the site to use.

2 Select Edit, Add Purchase Parts from EM/WO/Project.

3 Click the Project option.

4 Click the Project ID button.

The Select Project browse dialog box appears. 

5 Double-click the project to which you want to link the current purchase requisition.

The dialog box closes and the appropriate information appears in the Add Purchase Parts from 
EM/EO/Project dialog box.

6 If you want to select what to include in the requisition, select one of the following options in the 
Include section:

• Parts
• Services
• Both 

7 Click the OK button.

The Add Purchase Parts from EM/EO/Project dialog box closes.

All purchasable material and service requirements on work orders linked to the project appear on 
the purchase requisition.

Note: If you do not require any line items to be part of this requisition, you can delete them from 
the requisition individually. 

Requisition lines also include the following project related information:
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• Warehouse ID
• WBS Code
• Sequence Number
• Department ID
• Cost Category

For more information on Purchase Requisition, refer to the Infor VISUAL Purchasing User’s Guide.

Linking Direct A/P Invoices to Projects
Just as you can link A/P invoices directly to work orders—without the involvement of purchase 
orders—you can do the same against projects.

To link A/P invoices to projects:

While you are completing your Invoice Entry procedures, enter the following items for each line:

Project ID – Click the Project ID button and select the project to which you want to assign this line 
item.

WBS Code – Click the WBS Code button and select the work breakdown structure to which you want 
to assign this line item.

Note: Only the work breakdown structures you have used in the project you selected appear in the 
list.

Proj Ref Sub ID – The project reference Sub ID for the project and WBS code you selected 
automatically appears in the Proj Ref Sub ID column.

Proj Ref Seq No – The project reference sequence for the project and WBS code you selected 
automatically appears in the Proj Ref Seq No column.

Department ID – Click Dept ID button and select the department you want to assign to this line item.

Cost Category ID – Click Cost Cat ID button and select the cost category you want to use for this line 
item.

GL Override Account – If you want to override the account for this line item, click the Account ID 
button and select the account you want to use.

G/L Account ID – You will be forced to enter a G/L account for the debit side of the transaction. This 
account will automatically be credited when the project journals are prepared, as the G/L Mappings 
defined in the project summary window will be used for the final debit account used. Consider using 
some type of accrual/contra account.

For more information on Invoice Entry, refer to the Infor VISUAL Financials Payables User’s Guide.
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Transferring Materials from One Location to Another
In the system, each project can have only one warehouse. You might find it necessary, however, to 
account for transit time between two locations. You can set up multiple addresses for the project 
warehouse, then use Interbranch Transfer to account for transit time. 

Setting Up Multiple Warehouse Addresses
To set up multiple warehouse addresses:

1 From the Inventory menu, select Warehouse Maintenance.

2 Click the Site ID arrow and select the site to use.

3 Click the Warehouse ID button and select the warehouse for which you want to add addresses.

4 Click the Alternate Warehouse Address tool bar button, or select Edit, Alternate Warehouse 
Addresses.... 

5 Click the Insert button to add a new row, then enter information in the following fields:

Ship to ID – Enter the Ship to ID you would like to use for this warehouse address.

Name – Enter the name of the alternate address in the Name field.

Address – Enter the alternate street address for this warehouse.

City – Enter the city in which the warehouse is located in the City field.

State – Click the State arrow and select the abbreviation for the state in which the warehouse is 
located.

Zip – Enter the postal code of the area in which the warehouse is located in the Zip field.

Country – Enter the country in which the warehouse is located in the country field.

6 Click the OK button.

The Warehouse Address dialog box closes.

Using Interbranch Transfer Within the Same Warehouse
After you set up multiple warehouse addresses, use the following procedure to transfer items from 
one warehouse address to another.

1 From the main window, select the Inter Branch Transfer Entry option from the Inventory menu.

2 Click the Site ID arrow and select the site to use.

3 If you want to manually enter an IBT ID, click in the IBT ID filed and enter a unique identifier for 
this transfer. If you are using the auto-number feature, leave this field empty.

4 Set up the following transfer information:

Order Date – Click the Order Date calendar button and select the date on which you want the 
transfer to occur.
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From Warehouse ID and To Warehouse ID – Click the browse button and select the project 
warehouse you would like to use. Make sure to enter the same project warehouse in the From 
Warehouse ID and To Warehouse ID fields.

Desired Ship Date – Click the Desired Ship Date calendar button and select the date on which 
you would like to ship the goods.

Desired Receive Date – Click the Desired Recv Date calendar button and select the date on 
which you would like the receiver to receive the parts.

Transit Days – In the Transit Days field, enter the number of days the parts are to be in transit. 
For transfers within the same warehouse, you must enter the transit days manually.

5 From the Edit menu, select Ship From Address, or click the Ship From Address button on the 
tool bar.

Select the address you would like to use for the ship from address, then click Use Selected 
Address. The system placed a check mark in the Use check box. To choose a different address 
than the one selected, click the Clear Selected Address button, highlight the address you would 
like to use instead, then click the Use Selected Address button.

6 To choose the ship to address, from the Edit menu select Ship To Address, or click the Ship To 
Address button on the tool bar. In the Alternate Warehouse Address dialog box, select the 
address you would like to use for the ship to address, then click Use Selected Address. The 
system placed a check mark in the Use check box. To choose a different address than the one 
selected, click the Clear Selected Address button, highlight the address you would like to use 
instead, then click the Use Selected Address button

After you select a ship from and a ship to address, the address information appears in the Ship 
From/To tab.

7 On the Ship From/To tab, enter and select the following information:

Status – Click the Status arrow and select a status for the transfer. You can select:

• Firmed
• Released
• Closed
• Cancelled/Void
• Shipped

Whether or not you assign a status, a default status is assigned to a transfer. For more 
information on setting a default Inter Branch Transfer status, refer to later in this chapter.

Carrier ID – Click the Carrier ID arrow and select a carrier for the transfer.

Ship Via – Click the Ship Via arrow and select a means of conveyance for the transfer.

8 Click the Insert Row tool bar button and enter the following information.

Quantity – The quantity of the part that you are transferring.

Part ID – Click the Part ID browse button to select the part that you want to transfer.

Quantity Shipped – The current order’s quantity of parts that you have successfully shipped to 
another warehouse.



4 – 12 | Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense 

Quantity Received – The current order’s quantity of parts that you have successfully receive in 
the To warehouse.

Transit Location ID – The location within the warehouse from which you are shipping the part. If 
the part does not have a Transit Location ID in the From Whse ID, you can specify a unique 
Transit Location ID, which is added to the database. You can only define one warehouse location 
per part this way, or “on the fly.” After you have defined one transit location for a part in a 
warehouse in this manner, you must use Part Maintenance to specify other locations as transit 
locations.

U/M – The unit of measure of the part.

Unit Price – The price per unit of the part.

Extension – The price per unit of the part multiplied by the quantity of parts.

Specs – This section is selected if there is any text regarding the IBT line.

Stock Order Qty – The stock order quantity of the part. Stock Order Quantity is the same as the 
order quantity.

Destination Location ID – Click the Destination Location ID browse button and select the 
location to where you want the goods transferred.

Demand Quantity Allocated – The quantity of the IBT that you have allocated to demand.

Demand Quantity Fulfilled – The demand quantity that has been fulfilled by the supplying 
source.

Supply Quantity Allocated – The quantity that you have allocated as supply to the IBT line

Supply Quantity Fulfilled – The supply quantity that has been fulfilled by the supplying source.

Cartons – The number of cartons you use in the shipment.

Shipping Weight – The weight of the shipment.

Weight U/M – The unit of measure used to weigh the part that you are transferring.

Package Type – The type of package in which you are shipping the IBT. Enter packaging types in 
Application Global Maintenance. For more information, refer to the “Application Global 
Maintenance” chapter.

Owner ID – Click the Owner ID browse button and select the owner of the goods.

From/To User Dimensions – Double-click the From User Dimension and To User Dimension 
browse buttons and select the user dimensions you want to associate with this IBT shipper line.

9 Click the Save tool bar button.

Understanding Planned Supply
You are allowed the advantage of universally planning for project materials that have Discrete order 
policies. The Project relationships are tracked and greater flexibility is allowed in making bulk 
purchases for parts and materials common to several projects.

If you set up an order for a material for a project and the following applies:
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• the material card specifies a universal warehouse
• you universally plan the material
• the material’s order policy is Discrete

In the Material Planning Window, the following information automatically appears:

Demand Side:

Demand Warehouse – The warehouse that is causing the demand for the material—where the 
material is going.

Required WBS – The WBS specified as the demand—the specific WBS to where the costs will be 
attributed.

Supply Side:

Supply Warehouse – The warehouse on the purchase order or other supply source—from where the 
material is coming.

Due WBS – The WBS specified on the purchase order, or other supply source—the specific WBS 
from where the material is coming.

Working with Material Planning
In the Firm/Release Planned Orders dialog box in the Material Resource Planning window, these 
fields are automatically populated but can be changed:

• Warehouse ID
• Order Qty
• Rls Date
• Want Date
• WBS Code
• Proj Ref Seq #
• Proj Ref Sub ID

This allows you to take advantage of bulk purchasing while maintaining the WBS and Warehouse 
links to your projects.

Inventory Transaction Entry

Adjust/In
When performing inventory adjustments against project warehouses, enter the following information 
at the bottom of the Inventory Transaction window.

WBS Code – Enter the WBS code to which you want to charge the adjustment.
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Proj Ref Seq No – Enter the project task to which you want to charge the adjustment

Sub ID – This field is populated based on your selection in the Proj Ref Seq No field.

Department ID – Enter the department to which you want to charge the adjustment.

Inventory Transfers
When performing inventory transfers to project warehouses, enter the following information at the 
bottom of the Inventory Transfer window.

WBS Code – Enter the WBS code to which you want to charge the transfer.

Proj Ref Seq No – Enter the project task to which you want to charge the transfer.

Sub ID – This field is populated based on your selection in the Proj Ref Seq No field.

Department ID – Enter the department to which you want to charge the adjustment.

Note: During an adjust out or transfer of inventory from a project warehouse where the part in 
question may happen to exist on two different WBS's, the WBS and task that is charged with relieving 
inventory is the WBS/task associated with the FIFO layer relieved.

Setting Up Inventory Inspection Locations
Because you may receive Universally Planned material into several locations within several 
warehouses, you may want to set up your project warehouses as Part and Warehouse inspection 
points.

To set up inspection locations:

1 Select Part Maintenance from the Inventory menu of the main window.

2 Click the Site ID arrow and select the site to use.

3 Click the Part ID button and select the part you want to set up.

4 From the Maintain menu, select Warehouse Locations.

All of the warehouse locations you have previously set up for the part you selected appear.

5 Click the row header for the warehouse whose attributes you want to change.

The row appears highlighted.

6 If you want all parts added to this location to be inspected, click the Set part inspect button.

The check box in the Part Inspect column is selected. The status of the parts within this location is 
automatically changed to On Hold until you release them after your inspection.

7 If you want to designate the location you selected as an Inspection Location, select the Set whs 
inspect button.

The check box in the Whs Inspect column is selected.

8 Click the Save button.
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9 When you have finished making changes to your part warehouse locations, click the Close 
button.

Working with Physical Counts
For more information on Physical Inventory Counting, refer to the Infor VISUAL Inventory User’s 
Guide.

You are prevented from performing physical inventory counts on project warehouses that do not have 
at least one associated WBS code. If you select a project warehouse in which you have not used a 
WBS code, the system displays a dialog box informing you that you cannot perform the physical 
inventory count.

When selecting single or multiple project warehouses for physical inventory counts, you cannot limit 
the location within the warehouse—only complete project warehouse counts are allowed.

In order for project warehouse and WBS references to be maintained, you cannot delete a project or 
task for which there is a physical inventory count in process.

Entering Physical Counts
Entering physical counts for projects requires you to enter the following additional information if the 
quantity of your count is greater than the current inventory count:

WBS Code – Click the WBS Code button and select the code you want to associate with this count.

Proj Ref Seq No – Click the Proj Ref Seq No button and select the sequence number you want to 
associate with this count. The Sub ID field is populated based on your selection in the WBS Code and 
Proj Ref Seq No fields.

Department ID – Click the Dept ID button and select the department you want to associate with this 
count.

Viewing Project Schedules
You can view the progress of your scheduled projects in the Scheduling WIndow. You can use the 
Scheduling Window to view only your project-related operations and see at-a-glance if your projects 
are on time or late. You can also view additional information about the projects on the schedule, 
including any associated work orders. 

For more information on the Scheduling Window, refer to the Infor VISUAL Manufacturing User’s 
Guide.
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Understanding the Operation Bar Color Code
The horizontal bars in the main window represent the operations that have been scheduled to take 
place, or are in process at that shop resource.

For projects, the horizontal bar displays the project ID, operation number, and the WBS code. The 
system also displays the project ID, operation number, and WBS code along with the start date, finish 
date, and want date. The system also indicates if there is a delay in starting the operation due to 
existing load and whether the operation is in the determinant path.

If you are viewing a work order that is related to a project, the tool tip displays the linked operation and 
WBS code.

Cyan – An on-time work order operation. The operation will be complete before the work order want 
date.

Orange – An on-time project task (available to licensed VISUAL Project users only). The task will be 
complete before the project want date.

Purple – An on-time planned order operation.

Red – A late or “just in time” work order operation. Operation’s finish date is on or after the want date 
of its work order.

Dark Orange – A late or “just in time” project task (available to licensed VISUAL Project users only). 
The task will be complete on or after the project want date.

Dark Purple – A late or “just in time” planned order operation.

Blue – A frozen work order operation. Frozen operations cannot be rescheduled.

Brown – A frozen project task. Frozen tasks cannot be rescheduled.

Light Yellow – Indicates that you have selected the work order operation or project task. If the text is 
blue, the operation or task is frozen. When you select an operation or task, the system highlights the 
dates at the top of the scheduling window that work is scheduled to occur on the operation or task. 
The system also highlights the resource on the left of the window.

Dark Yellow – Indicates that you have selected a work order operation or project task that is late. 
Dark yellow indicates that the operation or task is late. If the text is blue, the operation or task is 
frozen. When you select an operation or task, the system highlights the dates at the top of the 
scheduling window that work is scheduled to occur on the operation or task. The system also 
highlights the resource on the left of the window.

Green – Operation or task is part of the determinant path and is on time. If the text is blue, the 
operation or task is frozen.

Dark Green – Operation is part of the determinant path, and will be late or just in time.

If there are large differences between the durations of operations (for example, one is for an hour, 
and another is for a day or days) the bars for the short operations may be very narrow. You can use 
the right-mouse button function even on these tiny bars. You can also use the zoom-in function in the 
View menu, or the plus (+) key, to zoom in until the bar is larger.’
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Showing Work Orders and Projects
Use the following options available on the Info menu to filter the information that the system displays:

Show Work Orders and Projects – Select this option to view all projects and work orders.

Show Work Orders – Select this option to view work orders only. The system does not display any 
scheduled projects as defined in the Project window, but it does show any work orders associated 
with a project. It also shows all non-project related work orders.

Show Projects – Select this option to view projects only.

Include Project Work Orders – The system activates this option if you select the Show Projects 
option. Select Include Project Work Orders if you would like to view any work orders associated with 
projects.

Show Work Orders by Task – The system activates this option if you select the Show Projects 
option. If you select this option, the system displays any work orders associated with the project task 
you select.

Show Focus Work Order/Project – Select this option to view only the currently select project or work 
order in the Scheduling window. If you select a task within the project, the system displays only the 
task and its related work orders.

Assigning Labor Costs to Projects
You can link Work Orders and Labor Tickets to projects to track labor costs and time by WBS code.

Linking Work Orders to Projects
When you create work orders to manufacture products or components you have specified on 
projects, you must link the work orders to their respective projects by entering the appropriate linking 
information.

Note: You link work orders to projects via the work order’s header card.

To link work orders to projects:

1 Open the Manufacturing Window, click the Site ID arrow and select the site to use, then select the 
Work Order to which you want to link your project.

2 Click the Warehouse ID button and select the Warehouse ID that matches the Project ID.

3 Click the WBS button and select the work breakdown structure you want to link to the header 
card.

4 Click the Proj Ref Seq # button and select the appropriate project reference.

5 When you finished linking the work order to the project, click the Save button.
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Planning Project Linked Work Order Material Requirements
Using VISUAL — Projects/A&D, you have the ability to plan for some parts to be bought and built to a 
project warehouse and for others to be purchased and fabricated in a common warehouse or 
company owned inventory. This allows you to commingle the requirements across multiple or all 
projects (or contracts) for selected parts. To use this feature, select a different Warehouse ID on the 
engineering master or work order breaking the link to the project warehouse.

Locate the material card whose warehouse you want to change.

The Inherit Warehouse from Header check box is automatically selected and populates the 
Warehouse ID with the warehouse you named on the header card. The demand and supply is 
directed to the appropriate header card warehouse. By clearing the Inherit Warehouse from Header 
check box and specifying a warehouse on the material card, the demand and supply is directed to the 
material card warehouse.

Linking Work Orders to Earned Value Reporting
By selecting the Report Earned Value Quantities From This Operation check box on one of the 
work order operations, you can automate the process of reporting earned value against project linked 
work orders. Earned value is calculated against the task to which the work order is linked. Because 
the task completion becomes the same percentage as the operation to which you have linked, you 
should take care which task you link.

In the above example, operation 20 is 40% complete which makes the project Task 40% complete, 
however, operation 30 and 40 are not complete and do not need to be in order to see a 100% 
completion at the task.

Linking Labor Tickets to Projects
Use the Labor Ticket Entry window to enter labor tickets and thus capture labor against your objects 
and work orders.

The Labor Ticket Entry window and the methods you use to capture labor are the same as VISUAL 
with the exception of the Project & Comp and Project Hours tabs.

For more information on the Labor Ticket Entry window, refer to the Infor VISUAL Manufacturing 
User’s Guide.
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Users can enter information through the Project% Comp tab or the Project Hours tab.

To enter labor information for a project:

1 From the Eng/Mfg menu of the VISUAL main window, select Labor Ticket Entry.

2 If you are using the Project% Comp tab, click the tab and enter the following information:

Project Info – Although you can manually enter information in the Project ID, Version, Split ID, 
and Sub ID fields, you may find it easier to click the Project Info button and select the exact 
project to which you want to report labor.

When you select a project using the Project Info button, all of the appropriate information 
automatically appears.

Oper Seq No – The Operation Sequence Number field is populated based on your selections on 
the tab.

Task ID – Click the Task ID button and select the task to which you want to report this labor.

Total Qty Earned – Because most companies typically asses their project tasks on a percent 
complete basis, you may find that using the Total% Earned field a more appropriate figure.

Note: When you enter a value in the Total Qty Earned field, the Total% Earned value is 
automatically calculated. Likewise, if you enter a value in the Total% Earned field, the Total Qty 
Earned value is automatically calculated.

Total% Earned – Enter the percentage complete for the task. This is the cumulative percentage 
complete, including any previous labor tickets. This percentage may be more or less than the 
previous ticket. For example, if you specified 90% on the previous labor ticket, but then 
discovered a 5% loss, then you would specify 85% on this labor ticket. This value is also used for 
calculating earned value.

If you are using the Project Hours tab, enter the following additional information:

Earning Code – Click the Earning Code button and select the code to which you want to report 
this labor.

Clock-in Time – Click in the Clock-in Time field and enter the time you clocked in.

Clock-out Time – Click in the Clock-out Time field and enter the time you clocked out.

Elapsed Hours – The Elapsed time automatically appears in the Elapsed Hours field.

The Elapsed time automatically compensates for any break times you enter.

Break Hours – If you took a break during your clock-in and clock-out times, click in the Break 
Hours field and enter the duration of the break.

Total Qty Earned – If applicable, enter the quantity completed for the task.

Description – If you want to add a description regarding this time that you worked, click in the 
Description field and enter the description you want.
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Costing and Posting
The Costing Utility gathers your project costing information from your labor tickets, inventory 
transactions, purchase receipts, general ledger entry, and accounts payable and

• Values your projects
• Prepares the project FIFO layering
• Updates the Project Summary window
• Prepares the sub-ledger.

After you have run the costing utility, use the Project Summary window to view the sub-ledger for the 
project on which you are working. If the costing figures for the sub-ledger are acceptable, post the 
project’s costing figures to your general ledger.

To run the costing utility:

1 Select Costing Utilities from the Eng/Mfg menu of the VISUAL main window.

2 Click the Site ID arrow and select the site to use.

3 Make the appropriate selections for the type of costing you want to perform.

4 Click the Start button on the tool bar.

The costing utility performs the appropriate calculations based on your settings.

Note: Your project information is costed prior to running costing figures for VISUAL.

5 After the Costing Utility has completed all of its calculations, click the Close button.

For more information on VISUAL’s Costing Utility, refer to the Infor VISUAL Manufacturing User’s 
Guide.

Posting Project Information Journals
After you run the costing utilities and prepare the journals, post the journals to the General Ledger.

1 From the Ledger menu, select Post Manufacturing Journals. The Post Manufacturing Journals 
window appears.

2 Click the Site ID arrow and select the site to use.

3 Leave the Batch ID and Description fields blank. These fields are populated.

4 Enter the date you would like to use for posting the journals in the Batch Date field. If you are 
preparing the month-end closing, enter the end date of the month you are closing. The 
Accounting Period is populated.

5 Clear the Current User Only check box to process journal entries for all users.

Click the Post All button to post all journal types.



Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense | 4 – 21

Setting Up the Barcode Transaction Scanner to Record 
Project Transactions
If you use the Barcode Transaction Scanner (BTS), you can set up the VMBTS.INI file to determine 
which cost category and department ID you would like to use transactions.

To set up the VMBTS.INI file:

1 Navigate to the directory where your executables are installed, and open the VMBTS.INI file with 
a text editor such as WordPad or NotePad.

2 To set up VMBTS for work orders, scroll to the # AssumeWODeptANdCostCat section, or use 
your text editor’s search function to find the section. 

3 Enter one of the following codes after AssumeWODeptAndCostCat=:

R – Enter R if you would like to use the department ID and cost category from the shop resource. 
If the shop resource does not have a department ID or cost category, then the system will use the 
department ID and cost category from the employee. The user cannot change the cost category 
or department ID.

E – Enter E if you would like to use the department ID and cost category from the employee. The 
user cannot change the cost category or department ID.

P – Enter P if you would like to prompt the user to enter a department ID and cost category. By 
default, the system displays the cost category and department ID for the employee. The user can 
enter a new cost category or department ID, or press Enter to accept the defaults.

PR – Enter PR if you would like to prompt the user to enter a department ID and cost category. 
The system displays the cost category and department ID for the shop resource. The user can 
enter a new cost category or department ID, or press Enter to accept the defaults.

PE – Enter PE if you would like to prompt the user to enter a department ID and cost category. 
The system displays the cost category and department ID for the employee. The user can enter a 
new cost category or department ID, or press Enter to accept the defaults.

N – If you enter N or do not enter any value, then the system will determine which department ID 
and cost category to use when the record is processed. The user will not be prompted to enter a 
department ID or cost category.

4 To set up VMBTS for projects, scroll to the # AssumeProjectDeptAndCostCat section, or use your 
text editor’s search function to find the section. Enter one of the codes described above after 
AssumeProjectDeptAndCostCat=.

5 Save the VMBTS.INI file to commit your changes.

Setting Up Wedge Barcode Labor Entry to Record Project 
Transactions
If you use Wedge Barcode Labor Entry, you can determine how users enter cost category IDs and 
department IDs in Administrator Setup.
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1 From the Bar Code Labor Ticket Entry window, select File, Administrator Setup. 

2 To set up how you would like Wedge Barcode Labor Entry to record department IDs and cost 
categories for work orders, click the Assume work order department and cost category arrow 
and select one of the following options:

Employee – Select this option to use the cost category and department ID associated with the 
employee. The user cannot change the cost category or department ID.

Prompt (Emp) – If you select this option, the system inserts the cost category and department ID 
associated with the employee into the appropriate fields. The user can enter a different cost 
category and/or department ID, or press Enter to accept the defaults. 

Resource – Select this option to use the cost category and department ID associated with the 
shop resource. The user cannot change the cost category or department ID.

If the shop resource does not have a cost category and department ID, the system uses the cost 
category and department ID associated with the employee. In this case, the user can change the 
cost category and/or department ID.

Prompt (Res) – If you select this option, the system inserts the cost category and department ID 
associated with the shop resource into the appropriate fields. The user can enter a different cost 
category and/or department ID, or press Enter to accept the defaults.

If the shop resource does not have a cost category and department ID, the system uses the cost 
category and department ID associated with the employee. The user can enter a different cost 
category and/or department ID, or press Enter to accept the defaults. 

3 To set up how you would like Wedge Barcode Labor Entry to record department IDs and cost 
categories for projects, click the Assume project department and cost category arrow and 
select an option. The options for projects are the same as the options for labor tickets. Refer to 
the descriptions of the options, above, for more information.

4 Click Ok to save your changes and exit the Preferences Setup window.

Closing Projects
When work is complete on a project, close the project. Before you change the project’s status to 
Close through the Project Window, verify the following information:

1 Make sure all project invoices have been issued and payments have been received.

2 If necessary, ship all products to the customer. 

3 Recognize all project revenue. 

4 Make sure that all project-related transactions are posted to the General Ledger. 

5 “Test” Close the project.

6 Run the Project Charges Under Review Report to check for outstanding transactions.

7 Re-release the project and resolve items identified on the Project Charges Under Review Report.

8 Close the project.
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Step One: Make Sure All Project Invoices Have Been Issued and 
Payments Have Been Received
To make sure that all invoices have been issued, run the Project Billing Events Report for the project 
you would like to close. 

To review the invoices issued for the project, run the Project Billing Events Report (for more 
information, refer to “Project Billing Events Report,” on page 6–37.). To check to see if invoices have 
been issued, run the report with the following parameters:

Site ID – Click the Site ID arrow and select the site in which the project was created.

Customer ID – Enter the ID for the customer of the project you would like to close.

Order ID – Enter the ID of the order associated with the project you would like to close. 

Starting Date – Enter a date within the period that work on the project began.

Ending Date – Enter a date within the period that work on the project ended. 

Show Events Section – Select all check boxes in the Show Events section.

Customers Section – Select Current Customer in the Customers section.

Orders Section – Select Current Order in the Orders section.

Sequence Section – Select either order ID or customer ID, depending on your preference.

When the report outputs, it lists all the invoices that have been issued. It also shows billing events 
eligible for invoicing that have not yet been invoiced.

If the report shows that you have not issued invoices for billing events, generate the invoices by 
selecting the Generate Invoice check box in the Edit Billing Events window and printing the invoice.

To check to see if invoices have been paid, use the Accounts Receivable Invoice Registry. To view 
unpaid invoices for the project you would like to close, use the following parameters:

Beginning Customer ID and Ending Customer ID – Enter the ID for the customer of the project you 
would like to close.

Beginning Invoice Date and Ending Invoice Date – Enter a date on or before the date of the first 
invoice in the Beginning Invoice Date field. Enter the date that the last invoice was issued in the 
Ending Date field.

Include Section – Select the Unpaid and Partially Paid check boxes to view the invoices that have 
not been paid.

Click Ok to output the report. The report shows which invoices have not been fully paid.

Step Two: If Necessary, Ship All Products to the Customer
Shipping products to customers is especially important if you are using Shipment as the revenue 
recognition method. Refer to the Infor VISUAL Sales User’s Guide for more information on shipping 
products.
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Step Three: Recognize All Project Revenue
Prepare and post all revenue recognition transactions for your project. For more information on 
recognizing revenue, refer to “Recognizing Revenue,” on page 5–9.

Step Four: Post All Project-Related Transactions to the General 
Ledger
To check project transactions, run the G/L Transactions Report / Inquiry from the Info menu of the 
Project Summary menu. Set up the inquiry with the following parameters:

Sequence Section – In the Sequence section, select Project, WBS, Dept.

Starting Project ID and Ending Project ID – In the Starting Project ID and Ending Project ID fields, 
enter the ID of the project you would like to close. 

Filters Section – Select By Date Range in the Filters section.

Starting Date and Ending Date – In the Starting Date field, enter the date that you released the 
project. In the Ending Date field, enter the date that work was complete on the project. 

Transactions Section – Select Print Unposted Txs to view unposted transactions.

Current User Only – Clear the Current User Only check box to view transactions entered by all 
users.

Include Rev Recognition – Select the Include Revenue Recognition check box to view revenue 
recognition transactions.

Transaction Type Section – Select Print All in the Transaction Type section.

Click Ok to review unposted transactions. Post any unposted transactions, if necessary.

Step Five: “Test” Close the Project
After you review transactions, temporarily close the project. By temporarily closing the project, you 
can review any outstanding work orders and other transactions.

To close the project:

1 Open the project you would like to close in the Project window. 

2 Select the header card of the project.

3 From the Status Change menu, select Close. The Change Status dialog box appears.

4 Select the Change status of subordinate materials and operations check box, then click Ok.

Step Six: Run the Project Charges Under Review Report to Check 
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for Outstanding Transactions
For more information on running the Project Charges Under Review Report, refer to “Project Charges 
Under Review Report,” on page 6–33.

Run the report for the project you are closing. The report identifies any additional open transactions 
and work orders. 

Step Seven: Re-release the Project and Post or Close Outstanding 
Items
If the Project Charges Under Review Report identified unresolved items, re-release the project so that 
you can post and/or close items. 

To re-release the project, select the project’s header card, then select Release from the Status 
Change menu. Select the Change status of subordinate materials and operations check box, then 
click Ok.

Resolve the transactions identified on the Project Charges Under Review Report. 

Step Eight: Close the Project
When you have resolved the items identified in the Project Charges Under Review Report, close the 
project. From the Status Change menu, select Close. Select the Change Status of subordinate 
material check box, then click Ok. 

After you close the project, users can no longer refer to the project in new transactions.

To prevent MRP processing from using a closed project’s warehouse, mark the closed project’s 
warehouse as MRP exempt. For more information, refer to  “Creating the Project Warehouse” on 
page 3–51.

Updating Project Costs after Closing
You can incur costs on a project after it is closed. Costs from AP Invoices, Sub-assembly updates, 
and FIFO layer updates can impact actual project costs.

The formal EAC at the end of the project should match the actual costs. The formal EAC must be 
updated so that the correct amounts of revenue can be recognized.

To update the formal EAC, you can use the Updated ETCs with Actuals utility. Select the Mark new 
ETC versions as current, Create new EAC versions, and Mark new EAC versions as current 
options when you run the utility. See "Updating ETCs with Actual Costs" on page 7–7 in this guide.

You can also manually update the formal EAC to match the final costs. See "Manually Creating 
Estimates at Completion" on page 7–5 in this guide.



4 – 26 | Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense 

About Project Statuses
The following status options are provided for projects:

Unreleased – An unreleased project has not yet been activated. Labor tickets, work orders, and other 
transactions cannot be linked to an unreleased project.

Firm – A firm project will likely go forward, but has not yet been released. Labor tickets, work orders, 
and other transactions cannot be linked to a firm project.

Release – A released project is an active project. Users can link labor tickets, work order, and other 
transactions to a released project. 

Close – A closed project is a completed project. Users cannot link work orders, labor tickets, and 
other transactions to a closed project.

Cancel – A cancelled project is a project that users have stopped working on before the project’s 
completion. Users cannot link work orders, labor tickets, and other transactions to a cancelled project.

Changing a Project’s Status
To change a project’s status:

1 Open the project you would like to close in the Project window. 

2 Select the header card of the project.

3 From the Change Status menu, select the status for the project. Your options are Unrelease, Firm, 
Release, Close and Cancel. The Change Status dialog box appears.

4 Select the Change status of subordinate materials and operations check box, then click Ok.

Changing the Status of an Individual Task
You can change the status of an individual task without changing the status of the entire project. 
Select the task whose status you would like to change, then select the new status from the Change 
Status menu. Clear the Change status of subordinate materials and operations check box to change 
the status of only the element you selected. Click Ok. 
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Chapter 5: Project Billing, Revenue Recognition, 
and Retro Burden

In this chapter, you’ll learn how to issue invoices to your customers, how to recognize the revenue 
your projects earn based on percent of completion, billing events, or shipments, and how to apply 
new rates to existing projects.

This chapter includes:

Topic Page

Project Billing .................................................................................................................................. 5–2
Recognizing Revenue..................................................................................................................... 5–9
About Retro Burden ...................................................................................................................... 5–13
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Project Billing
Because companies in the Project and Aerospace and Defense industries invoice their customers 
based on the completion of WBS and other non-shipping items, you must perform your Project Billing 
using the Project Billing Entry window.

If your project involves shipping goods, then generate invoices using the Invoice Forms option on the 
Contracts menu.

Project Billing is a three step process:

• Create Billing Events for your Customer Order lines.
• Mark each of the appropriate Billing Events for invoice generation.
• Print your Invoices automatically transferring them to Accounts Receivable.

Creating Billing Events
To create Billing Events for your project customer order lines:

1 Select Project Billing Entry from the Project menu of the main window.

2 Click the Site ID arrow and select the site to use.

3 Click the Order ID button and select the order whose bills you want to set up.

The individual lines of the order appear in the table along with their identifying CLINs.

4 Select the line for which you want to create billing events.

Note: Single lines of your Customer Orders can have multiple Billing Events, each contained in 
one Billing Event table.

5 From the Edit menu, select Billing Events. The Edit Billing Events window appears.

6 Click the Insert button.

7 Enter information in the following fields:

Seq # – The next available number is automatically entered in increments of ten.

Description – Enter a description for this billing event.

Billing Basis – Click the arrow and select the basis on which you are configuring this billing 
event. You may want to review the contract types set up in the Contract Type table to ensure that 
you choose the correct billing basis. 

Billing Amount – Enter the amount for which you are billing.

Note: The total amount of billing events cannot be greater that the total of the order line to which 
you have attached the events.

If you are billing on a Cost or Cost Plus Earned Fee, you can also enter a Fee Amount.

Fee Amount – Enter the amount of the fee for this billing event. 
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Recognize Revenue – Select the Recognize Revenue check box if you want the system to flag 
the event as eligible for revenue recognition. If you have set up revenue recognition to be based 
on shipment or percentage of completion, a warning message appears when you select the check 
box. Make sure you want to associate the billing event with revenue recognition before 
proceeding.

8 Click the Calendar button to enter the date on which the billing event will take place.

9 Click the Save button.

10 When you have finished creating Billing Events for this line, click the Close button.

Copying Billing Events
You may find that it easier to copy similar billing events from other customer orders and modify them 
to fit the current order.

To copy billing events:

1 Select the Copy From button.

2 If you want to limit the customer names that appears in the Order ID list, click the Customer ID 
arrow and select the customer you want to appear.

3 Click the Order ID button and select the order from which you want to copy billing events.

4 In the table, click the row header for the billing events you want to copy.

You can select multiple continuous lines by clicking the first line you want and holding the SHIFT 
key while selecting the last line you want. You can select multiple discontinuous lines by holding 
the CTRL key while selecting the lines you want.

5 Click the Ok button.

The Copy Events From dialog box closes and the lines you selected appear in the Edit Billing 
Events dialog box.

Renumbering Billing Events
For example, you have lines 10, 20, 30, and 40, and you want to move line 40 to appear between 
lines 20 and 30.

To change the order in which your event lines appear:

1 Select the line you want to move.

2 Click in the Seq # field and enter a number between the sequence numbers where you want to 
move the line.

In the example, select line 40 and change its number to anything between 20 and 30.

3 Click the Renumber button.

4 When you are prompted to save the changes, click the Save button.
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Line 50’s Seq # is changed to 20 and all other lines are renumbered in increments of 10 and they 
are kept in the same order.

Deleting Billing Events
You cannot delete billing events for which you have generated invoices. If you have not posted the 
invoice to your general ledger, you can delete the invoice and then delete any associated billing 
events.

To delete billing events:

1 Open the Edit Billing Events dialog box and select the billing event you want to delete.

If you have not created an invoice for a billing event the Delete button appears active when you 
select the line. If the event is ineligible, the Delete button appears gray. 

2 Click the Delete button.

An X appears in the row header indicating you have marked the event for deletion.

3 When you have marked all of the events you want to delete and are sure that the deletions are 
correct, click the Save button.

Note: Because you are not prompted to confirm the deletion of billing events, make sure you 
have marked the correct events before clicking the Save button.

Marking Billing Events for Invoice Generation
When you reach the point at which you need to generate an invoice for billing events, you must first 
mark the event as being ready for invoicing.

To mark billing events:

1 Open the Project Billing window.

2 Click the Site ID arrow and select the site in which the event was created.

3 Select the Order ID containing the event you want to mark.

4 Select the line containing the billing event you want to mark and click the Edit Billing Events 
button on the tool bar.

5 For the billing event you want to mark, select the Generate Invoice check box.

6 When you have finished marking billing events, click the Save and Close buttons.

Note: Invoices are not generated until you print them.
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Generating Invoices
During the Printing Invoice process, the invoices are generated. You can view and post the invoices 
through Account Receivable Invoice Maintenance. 

Note: When you generate an invoice through Project Billing Events, the invoices are not posted to the 
general ledger. You must post the invoices to the general ledger through Accounts Receivable 
Invoice Maintenance.

You are provided with several methods of outputting your project invoices:

• Print
• File
• E-mail
• View (available only if you select the Print Only - Do Not Save Invoice #s check box)

Printing Invoices
To print and generate invoices:

1 Open the Project Billing Entry window.

2 Click the Site ID arrow and select the site for which to print invoices.

3 From the File menu, select the Print Invoices option.

4 If any of the invoices are attached to international orders, click the Language ID arrow and select 
a language for the invoice.

5 In the Date Setting section, select Current, Event Date, or Specified. If you select Specified, click 
the calendar button and select the date you want.

6 Select the appropriate print options:

Print Only - Do Not Save Invoice # – If you want to print draft invoices and you do not want to 
generate the actual invoice record in your database, select the Print Only option.

When you select the Print Only option, you have the option to view the invoice on-screen only.

Note: Printing for view generates invoice numbers but does NOT save the invoice number and 
does not transfer it to your general ledger, the next time you print invoices, the transfer is done.

Use Pre-numbered Forms – If you are using pre-numbered forms, select the Use Pre-
numbered Forms check box and enter the number on which the forms start in the Starting Form 
Number field.

Use Current Exchange Rates – If exchange rates are involved in your invoice calculations and 
you want to make sure the latest exchange rates are used, select the Use Current Exchange 
Rates check box.

7 Select the appropriate format option in the Format section.

You can select the standard QRP format, or one of three user defined formats.

8 The Samples section is helpful in setting up your printer correctly. If necessary, select the 
appropriate sample options:
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Print Samples Only – If you want to print samples ONLY of your invoice form, select the Print 
Samples Only check box.

Zero Sample Forms – Select this option if you do NOT want to print any sample invoices before 
printing actual invoices.

1 Sample Form – Select this option to print one sample invoice when you select the Print 
Samples Only check box.

3 Sample Forms – Select this option to print three sample invoices when you select the Print 
Samples Only check box.

9 To print the invoices, click Ok.

If you have NOT selected the Print Only - Do Not Save Invoice # check box, a notification dialog 
box appears indicating that invoices were printed and they were transferred to Accounts 
Receivable.

If you selected the Print Only - Do Not Save Invoice # check box, the notification dialog box 
states that invoices were printed and they were NOT transferred to Accounts Receivable.

10 To close the dialog, click Ok.

The Print Invoices dialog also closes.

Printing Duplicate Invoices
To print duplicates of your invoices:

1 Open the Project Billing Entry window.

2 Click the Site ID arrow and select the site in which the order was created.

3 Select the Order whose invoices you want duplicate.

4 From the File menu, select the Print Duplicate Invoice(s) option.

The Reprintable Invoices dialog is displayed with a list of invoices for the order and customer you 
selected.

5 To select the invoice you want to reprint, click the row header.

To select multiple continuous lines, select the first line, press the SHIFT key, and select the last 
line you want. All of the lines you select appear highlighted.

To select multiple discontinuous lines, press and hold the CTRL key while selecting each lines 
you want.

6 Click Ok.

The Print Invoice dialog is displayed.

7 Select the printing options you want to use for this print run.

8 For more information on working in the Print Invoices dialog, refer to  “Printing Invoices” on 
page 5–5.

9 Click Ok.
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The invoices you selected are printed using the setting you selected.

E-mailing Invoices
You can use this feature to e-mail invoices to the associated customer contacts. This feature is useful 
if you want to e-mail invoices instead of, or in addition to, printing. You can also use this feature to 
preview the invoices selected to be e-mailed before sending them to the recipients. The e-mailing 
invoices process allows you to preview, e-mail, and print invoices by site, customer, beginning and 
ending dates, and invoice types. When you run the process the e-mails are consolidated by customer 
and by site.

Note: If no e-mail address is associated with a contact, the e-mail is generated for preview, where 
you can then add the e-mail address of the recipient.

To e-mail invoices:

1 From the A/R Invoice Entry window, select File, Email Invoices.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site or sites in which 
you created invoices. If you select **All** in the Site ID field, all sites are selected. If you are 
licensed to use a single site, this field is unavailable.

3 To e-mail invoices to a particular customer, specify the Customer ID in the Customer ID field.

4 Specify a date range in the Begin Date and End Date fields for the invoices that you want to e-
mail.

If you do not specify a date range all invoices for the selected customer and sites are e-mailed.

5 Select the check box of the types of transactions that you want to e-mail. You can select any of 
these types of invoice documents:

AR Invoices – Select this check box to e-mail Account Receivables invoices to the contact’s e-
mail address associated with the customer. If you access the Email Invoices dialog from the 
Account Receivables Invoice Entry window, this check box is already selected.

MFG Invoices – Select this check box to e-mail manufacturing invoices to the contact’s e-mail 
address associated with the customer. If you access the Email Invoices dialog from the Account 
Receivables Invoice Forms window, this check box is already selected.

Progress Billing – Select this check box to e-mail progress billing invoices to the contact’s e-mail 
address associated with the customer. If you access the Email Invoices dialog from the Progress 
Billing Entry window or the Project Billing Entry window, this check box is already selected.

6 Select one of these check boxes to display distributed invoices or invoice drafts:

Show Distributed Invoices – Select this check box to view invoices that have already been e-
mailed or printed.

Show Invoice Drafts – Select this check box to display invoice drafts in the Email Invoices table. 
Clear this check box to display only finalized invoices.

7 To review e-mails before you send them, select the Preview Emails check box. After you click the 
Run toolbar button, the e-mails are opened for your review. The content of the e-mail is generated 
based on the e-mail template that you set up for AR Invoices in Notification Maintenance.
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8 Select or specify information in the Email Invoices table:

Email – Select the check box in this column for each invoice that you want e-mailed. When you 
click the Run toolbar button, e-mails are created for the selected invoices. If the check box is 
clear, no e-mails are created for the invoice.

Print – Select the check box in this column to print the invoices to the default printer. When you click 
the Run toolbar button, the selected invoices are printed.

9 Review this information in the Email Invoices table:

Customer ID – Specifies the Customer ID.

Customer Name – Specifies the customer name.

Site ID – Specifies the Site ID of the record.

Invoice ID – Specifies the Document Invoice ID. If the document invoice is a draft, then the ID 
displays “Draft” as a suffix.

Invoice Type – Specifies the document invoice type created. If the Print Only check box was 
selected for the document invoice type, then draft is added as a suffix to the invoice type. These 
are the invoice types: AR Inv for an Account Receivables invoice, Memo for an Account 
Receivables memo, Mfg Inv for a Manafacturing invoice, and PB Event for a Progress Billing 
invoice.

Customer Order ID – Specifies the customer order ID on an invoice line. If there are multiple 
customer order IDs, each Customer Order ID is separated by a comma.

Note: The Customer Order ID is printed in place of the %ARInvoiceCustOrderID on the email 
notification.

Customer PO Reference – Specifies the Customer PO Reference on a Customer Order ID that 
is on an invoice line. If there are multiple Customer PO Reference numbers, each Customer PO 
Reference is separated by a comma.

Note: The Customer PO Reference is printed in place of the %ARInvoiceCustPORef on the 
email notification.

File Exists – Specifies a ‘Y’ if the document invoice file exists, and ‘N’ if it does not.

File Link – Specifies the file path to the invoice. You can click the file path to drill down to the 
invoice and further review the invoice details.

Invoice Date – Specifies the invoice date for Account Receivables invoices and Manufacturing 
invoices.

Invoice Amount – Specifies the invoice amount for Account Receivables invoices, Manufacturing 
invoices, and Progress Billing invoices.

Currency ID – Specifies the currency identifier applied to the invoice.

Prepaid Order ID – Specifies the Prepaid Order ID listed on the invoice for a customer deposit or 
prepayment.

Prepaid Invoice ID – Specifies the Prepaid Invoice ID listed.

Last Distributed – Specifies the date that the invoice was last distributed.
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Recipients – Specifies a listing by e-mail address of those customer contacts receiving the 
invoice distribution.

10 You can select to all invoices in the Email Invoices table for e-mailing by clicking the Email - 
check all rows toolbar button. Click the Email - uncheck all rows toolbar button to clear all 
invoices from being e-mailed.

11 You can select to all invoices in the Email Invoices table for printing by clicking the Print - check 
all rows toolbar button. Click the Print - uncheck all rows toolbar button to clear all invoices 
from being printed.

12 Click the Run toolbar button to e-mail and print the invoices or draft invoices with Email and Print 
check boxes selected. A message is displayed noting the processed invoices.

If any invoices are misprinted you can reprint them using the Print Duplicate Invoice options.

Setting up your E-mail Preferences
Accounts receivable invoices are e-mailed using your preferred e-mail client. Before you e-mail 
invoces, make sure that your e-mail settings are correctly configured for your installed e-mail client.

To setup your e-mail preferences:

1 From your Email Invoices dialog, select Options, Mail Client Settings.

2 Select your installed e-mail client to be the default from the Email Client drop-down list.

3 Specify your server address in the Server Address field. Use your e-mail’s host name of the 
outgoing SMTP server address, for example smtp.example.com.

4 Specify the server port number to use in the Server Port field. The port number is used by the 
outgoing SMTP mail server. Commonly used port numbers are 25, 465, and 587, but check with 
your e-mail service.

5 Specify the user name for your default e-mail account in the User Name field. This is often your 
full e-mail address.

6 Specify your user password in the User Password field. This is the password that you use to sign 
in to your default e-mail account.

Select and hold your mouse down on the Show check box to view your password; otherwise, the 
field display is automatically encrypted.

7 To enable SSL (Secure Socket Layer) security, which is required by some SMTP providers, select 
the Use SSL Security check box.

8 Click Save.
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Recognizing Revenue
There are four ways to recognize revenue in VISUAL — Projects/A&D: at designated Percentages of 
Completion (the percentage is determined by comparing costs incurred versus the current EAC), 
upon Shipment, upon Billing and Manually. The contract type of your project determines the type of 
revenue recognition used.

The system calculates revenue based on the version of the EAC you designate as the current 
version. If you change the current version EAC during the course of a project, the system calculates 
the difference for previously processed transactions and sends the transaction back to revenue 
recognition for processing. Depending upon the type of transaction (POC, Shipment, or Billing), the 
preparation windows can be used to create new revenue transactions for the differences.

Use the Project Revenue Recognition window to formally recognize revenue triggered by percentage 
of completion, shipment, or billing events. If your project requires manual revenue recognition, use 
the Project Revenue Recognition window to create and recognize the revenue transactions.

For more information on EACs, refer to  “Manually Creating Estimates at Completion” on page 7–5.

Note: Make sure you have entered an EAC for the project you want to use in the revenue recognition 
transaction. If you have not entered an EAC, the transactions eligible for revenue recognition may not 
appear in the Prepare Revenue Recognition window.

Preparing Percentage of Completion, Shipment, and Billing Event 
Revenue Recognition Transactions
To recognize revenue from percentage of completion, shipment, or billing events:

1 From the Project menu, select Project Revenue Recognition. 

2 Click the Site ID arrow and select the site in which the event was created.

3 Select the type of transaction you would like to prepare. Click the Prepare POC Transactions 
button to prepare revenue recognition transactions triggered by Percentage of Completion. Click 
the Prepare Shipment Transactions button to prepare revenue recognition transactions 
triggered by Shipments. Click the Prepare Billing Event Transactions transactions to prepare 
revenue recognition transactions triggered by billing events. The appropriate window appears 
(our example uses POC Transactions):

4 The Prepare Revenue Recognition window contains the following information:

Project ID – The ID of the project associated with the revenue recognition transaction.

EAC ID – The current EAC for the project.

Customer ID – The ID of the customer associated with the project.

Transaction Description – Click in this field to enter a description of the revenue recognition 
transaction.

Customer Order Line – The line from the customer order associated with this transaction.

Billing Event No – The billing event number associated with this transaction. This field appears 
when preparing Billing Event transactions only.
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Invoice ID – The ID of the invoice that generated the revenue recognition event. This field 
appears when preparing Billing Event Transactions and Shipment transactions only.

Percent Complete – The current percentage completion of the project. To generate a revenue 
recognition transaction, this percentage must be less than 100%. This field appears when 
preparing POC transactions only.

Contract Ceiling – The contract ceiling for the project as established in Project Maintenance. For 
more information, refer to “Step 2 – Entering Contract Financial Information,” on page 3–47. his 
field appears when preparing POC transactions only.

Packlist Line – The packlist line associated with the transaction. This field appears when 
preparing Shipment transactions only.

Revenue Amount – The amount of revenue to be recognized.

Total COGS – The total cost of goods sold related to this transaction.

Fee Amount – The fee amount of the transaction.

Fee Percent – The cumulative percentage of all billed fees.

Double-click a row in the Prepare Revenue Recognition Entries window to view the Project Billing 
Entry window for the project.

5 Select the transaction(s) you would like to prepare, then click Prepare. A dialog box appears 
listing the number of events that have been prepared. 

6 Click OK to return to the Project Revenue Recognition window. 

7 To review the transaction, click the Transaction ID button and select the ID of the transaction you 
would like to review. The window is populated with the transactions’s details.

8 In the Totals tab, the totals for the current transaction along with the totals for the previous 
transactions and the cumulative total of all transactions are displayed. 

9 Click the Other tab to view additional details.

Customer – The name of the customer associated with the transaction.

Order Line – The line from the customer order associated with this transaction.

CLIN – The Contract Line Item Number associated with the transaction.

Packlist Line – For revenue recognition transactions based on shipment, the Packlist ID number 
appears in this field.

Billing Event No – For revenue recognition transactions based on billing events, the Billing Event 
number appears in this field.

Billing Event Desc – For revenue recognition transaction based on billing events, the description 
of the billing event appears in this field.

Invoice ID – The invoice ID associated with the transaction.

Contract Ceiling – The contract ceiling amount for the project.

Percent Complete – The cumulative percent complete of all revenue recognition transactions. 

10 In the table below the header, distribution information for the transaction appears. 
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11 To post the transaction to the general ledger, click the Post to G/L button. The Posted check box 
is selected.

12 Click the Close button to exit the window.

Creating Manual Revenue Recognition Transactions
If a project’s contract type requires you to enter revenue recognition transactions manually, use the 
following steps:

1 From the Project menu, select Project Revenue Recognition. 

2 Click the Site ID arrow and select the site in which the project was created. 

3 Leave the Transaction ID field blank. This field is populated for you when you save the record.

4 In the Project ID field, enter the ID of the project for which you are recognizing revenue. The 
Current EAC and Revenue Basis fields are populated. 

5 Select the currency for the revenue transaction by clicking the Currency ID arrow and selecting a 
currency from the list.

6 Enter the date of the transaction in the Transaction Date field.

7 In the table below the header, change the G/L account ID, if necessary. Double-click the G/L 
Account ID column header and select a new account.

8 Enter the credit and debit amounts for this transaction. As you enter information in the table, the 
information in the Totals tab is updated. 

Note: After you post the revenue recognition transaction to the General Ledger, you cannot edit 
the information in the table.

9 When you have finished entering information, click the Save button.

10 To post the revenue transaction to your general ledger, click the Post to G/L button.

11 Click the Close button to exit the Project Revenue Recognition window.

Viewing Revenue History
To view the revenue history of a project:

1 In the Project Revenue Recognition window, click the Site ID arrow and select the site in which 
the project was created. 

2 Click the Project ID button and select the project whose revenue history you want to view.

3 From the Info menu, select the Revenue History option.

Where applicable, the following information appears in the Revenue History dialog box.

Transaction ID – The identification for the transaction.

Transaction Date – The date of the transaction.
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Posted – If the transaction was posted, the check box appears selected.

Posted Date – If the transaction was posted, the date on which it was posted appears.

Revenue Type – The type of revenue appears.

POC Percent – The Percent of Complete (POC) percentage appears.

EAC ID – The Estimate at Complete (EAC) transaction ID appears.

Packlist ID – If this transaction resulted from a shipment, the Packlist ID appears.

Packlist Line Number – If this transaction resulted from a shipment, the packlist line number that 
triggered amount appears.

Order ID – The order ID associated with the transaction.

Billing Event – The billing event amount appears.

Revenue Amount – The actual amount of this revenue.

CGS Amount – The Cost of Goods (CGS) amount appears.

Profit/Fee Amount – The profit or fee amount appears.

Profit/Fee Percent – If the profit or fee for the project is based on a percentage, the percentage 
appears.

Description – If you entered any descriptions for this transaction, they appear in the Description 
column.

4 When you have finished viewing the revenue history, click the Close button.

About Retro Burden
During the course of your projects, you may need to change the burden rates that you apply to your 
costs. Use the Rate Management window to analyze the impact of changing the burden rate, then run 
the retro burden utility to create retro burden transactions. 

You can run retro burden multiple times during your fiscal or calendar year.

Analyzing the Impact of a Rate Change
Before you run the retro-burden utility, you can view the impact of a rate change on your transactions 
using the Rate Change Analysis tool.

To use the Rate Change Analysis tool:

1 From the Rate Management window, select Info, Rate Change Impact Analysis. 

2 Click the Site ID arrow and select the site in which the project was created.

3 Click the Project ID button and select the project for which you want to run a rate analysis.

The Current and Applied Billing Rates for the project you selected automatically appear.
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4 If you want the information on this report sorted by CLIN, select the By CLIN check box.

5 If you want this report to contain information from a specific date rate, use the calendar buttons in 
the Enter Date Range section to select the Start and End fiscal periods.

6 In the Select Rate to Compare section, select the rate you want to compare by selecting the 
appropriate option. You can select either the Current Billing Rate ID or the Applied Billing Rate 
ID.

7 In the Compare with this Rate section, click the Select Rate ID arrow and select the rate to which 
you want to compare the Current or Applied Billing Rate.

8 Click the Run button on the tool bar.

The rate you selected is compared against the Current or Applied rate for this project and report 
appears with the appropriate figures.

Understanding Rate Change Impact Analysis
The object of the Rate Change Impact Analysis report is to provide you with a side-by-side 
comparison of your current figures and those of any rate you select. This information allows you to 
study the effects that changing rates will have before you commit to using those new rates.

The Rate Change Impact Analysis dialog box is divided into four sections:

Basic project information – The rates and dates of the project you selected appears in the top 
section.

Existing Targets – The following existing target information appears for the project you selected:

Target Price

Target Cost

Target Profit/Free

Target Rate

Use the figures in the Existing Target section to compare against the figures appearing in the Revised 
Targets for comparison.

Revised Targets (Rate Change Impact) – The following revised target information appears for the 
project you selected:

Target Price

Target Cost

Target Profit/Free

Target Rate

Cumulative Amounts for Date Range – A list of the cost elements with cumulative amounts based 
on the date range you entered appears in the bottom section of the dialog box.
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Running the Retro-Burden Utility
To calculate the new burden costs, you must run the retro-burden utility. When you run the retro-
burden utility, the system looks for all prime costs that used the rate ID that you have flagged as the 
“Use for Actual” rate for the period and applies the new rate you specify. For more information on 
setting up rates, refer to “Setting Up Information in the Rate Management Window,” on page 2–20.

To calculate retro-burden:

1 From the Rate Management window, select Edit, Calculate Retro-Burden.... The Calculate 
Retro Burden dialog box appears.

2 Click the Site ID arrow and select the site in which you want to post retro burden transactions. 

3 In the End of Fiscal Period field, enter any date within the period that you would like to post retro 
burden transactions. The fiscal period you choose must be open; you cannot post retro burden 
calculations to closed periods. 

4 In the Burden Rate ID field, select the burden rate you would like to apply to past transactions. For 
more information on setting up rate IDs, refer to  “Setting Up Rate IDs” on page 2–20.

5 In the Burden Period ID field, select the period to which you would like to apply the new burden. 
For more information on setting up period IDs, refer to  “Setting Up Period IDs” on page 2–21.

6 Click Calculate. The utility calculates the retro burden transactions for the period you specified.

Reviewing Retro Burden Transactions
Before you post retro burden transactions, you can review them by running the Retro G/L 
Transactions report. To run the report:

1 From the Rate Management window, select File, Print Retro G/L Transactions.... The Print G/L 
Transactions dialog box appears.

2 Click the Standard tab, and specify this information:

Site ID – Click the Site ID arrow and select the site in which the unposted transactions were 
created in the Calculate Retro Burden utility.

In the Print Selection section, select By Accounting Period, then enter the end date of the during 
which you ran retro burden.

3 Click the Advanced tab, and specify this information:

Report Calendar ID – Click the Report Calendar ID arrow and select the calendar you want to 
use for this report.

Fiscal Year – Click the Fiscal Year calendar button and select the fiscal year for which to create 
this report.

Site ID(s) – Click the Site ID(s) arrow and select the site(s) to use for this report.

Clear the Current User Only check box to view transactions generated by all users. Select the 
check box to view the transactions that you generated.

In the Transaction Type section, select Print All to view all transactions for the period.
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In the Transactions section, select Print Unposted Txs to view the retro burden transactions that 
you have not yet posted.

In the Sequence section, select a sort order for the report. Select G/L Account ID to view the 
report by G/L Account ID. Select Source, G/L Account ID to view the report by the source of the 
transaction, then by G/L account.

4 Click the View drop-down box to select an output method for the report. You can choose View, 
Print, File, or E-Mail.

5 Click Ok. The report displays the unposted transactions that the retro burden utility generated for 
the selected period.

Posting Retro Burden Transactions to the General Ledger
If you are satisfied with the transactions displayed in the Retro Burden G/L Transactions report, post 
the transactions to the general ledger. To post the transactions, select the Post All button on the tool 
bar. If you do not post the transactions, the unposted transactions generated by the Retro Burden 
utility will be erased the next time you run costing.

Use the Inquiry / Print G/L Transactions feature of the Project Summary window to view how burden 
amounts are distributed. For more information, refer to “Inquiry / Print G/L Transactions,” on page 6–
18.

Freezing Rates
If you would like to preserve burden amounts in a certain period even if the Use for Actuals rate is 
changed, you can freeze the rates. When you freeze rates, costing uses the same rate ID that it 
previously used on any given transaction within that period. To freeze rates:

From the Rate Management window, click the Site ID arrow and select the site to use, then select 
Maintain, Period Table.... 

In the Period Table, select the Freeze Rates check box for the appropriate period.

Costing will apply whichever rate was last used on a transaction, preventing changes to burden 
amounts. 
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Working with the Project Summary Window
The Project Summary window provides a platform from which you can manage your project budgets, 
apply those budgets, and review the results. You can also view the results of your actual costs and 
compare them to your budgeted figures thereby allowing you greater accuracy in your budgeting.

Use the Project Summary window to:

• Set up Budgets
• Maintain Cost and Burden tables
• Set up your G/L and Burden Mappings
• Spread Budgets
• Calculate Earned Value
• Estimate Completion Dates
• Calculate Retro Burden

Using the Project Summary Window
The Project Summary’s main window contains a table that, depending on your selections, provides 
you with quick access to the following important project information:

• Budgeted Spread
• Earned Value
• Estimate at Completion
• Actuals
• Schedule Variance
• Cost Variance
• Budget Variance

Several viewing methods for your data are provided:

• Together or separately
• In monthly buckets or in summary form
• For single projects or many

You can access different layers of information down to the source transactions from which the actual 
costs are derived. For more information, refer to “Accessing Nested Information,” on page 6–6.

To view your project status in the Project Summary window:

1 From the Project menu of the main menu, select Project Summary.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which the 
project was created. If you are licensed to use a single site, this field is unavailable.

3 Click the Project ID button and select the project whose summary you want to view.

If you have created several versions of the project you selected, click the Versions arrow and 
select the specific version you want to view.
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4 In the Summary Types section, select the type of summary you want to appear in the table.

As you select summary types the appropriate information appears in the table.

If you select a Variance summary type, the Variance Threshold section activates allowing you to 
specify the following:

Type – Click the arrow and select the type of threshold you want to use for this summary. You can 
select Fiscal Period, Year-To-Date, or Cumm-To-Date.

Amount – Enter the amount of variance you want to use for this summary.

Changing Sort Settings
Within the Project Summary window you can change the criteria by which your information is sorted. 
The information is automatically sorted by Project, WBS Code, Sequence number, Department, and 
Cost Category.

To change the sort settings:

1 From the Options menu, select Sort Preferences.

2 In the Sort Preferences dialog box, select the criteria on which you want your information sorted.

3 Click the Ok button.

The Sort Preferences dialog box closes and the information in the Project Summary window table 
is sorted on the criteria you selected.

Using Project Filters
In the Project Summary window, you have the option of viewing more than one project at a time by 
either selecting the projects you want to view or by selecting project type. You also have the option of 
further selecting project data by department.

For example, if you are rough cut capacity planning, you can use project filters to select All project 
types with an Engineering type department. By selecting a Summary Type of Budget Spread, you can 
easily view the expected number of engineering hours required on a monthly basis across all off your 
projects.

To set project filters:

1 Open the Project Summary window and click the Project Filters tab.

2 Click the Project Info button.

3 Use the tabs to select the types of filters you would like to use. You can enter filter information on 
a single tab or on multiple tabs to retrieve the information you would like to view. Use the arrow 
buttons to move project IDs to the Selected Codes section. The tabs are:

Site ID – If you are licensed to use multiple sites, click the Site ID tab and specify the sites to view. 
If you are licensed to use a single site, this field is unavailable.
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Project ID – Click the Project ID tab to specify individual projects you would like to view. The IDs 
of all the projects appear in the Available Codes section.

Project Type – Click the Project Type tab to select the specific project types you would like to 
view. 

Department ID – Click the Department ID tab to select the specific department types you would 
like to view.

Business Line – Click the Business Line tab to select the specific business lines you would like to 
view.

Division – Click the Division tab to select the specific divisions you would like to view.

Customer – Click the Customer tab to select the specific customers you would like to view.

Cost Category – Click the Cost Category tab to select the specific cost categories you would like 
to view.

WBS – Click the WBS tab to select the specific WBS codes you would like to view.

Financial Analyst – Click the Financial Analyst tab to select the financial analyst whose projects 
you would like to view. Specify the Financial Analyst for a project in the Contract General dialog 
box in Project Maintenance.

4 When you have finished building your filter set, click the Ok button.

The information for the filter set you selected appears in the Project Summary window.

5 Select the Summary Type you want to use.

The appropriate information appears in the Project Summary window for the Summary Type you 
selected.

Interpreting Information in the Summary Window
The Project Summary window contains a table that is populated with cost information based on 
budgets, actual costs, and estimates at completion.

Total Summaries – The total summaries section consists of 12 columns comprising of six groups. 
The first column in each group contains time-based figures and the second column contains the 
corresponding cost calculation.

The columns that appear in the Total summaries section are:

Budget Spread Total Hours – The total number of hours based on the used time, assigned 
hours, and budget spread appear in the Budget Spread Total Hours column.

Earned Value Total Hours – The total earned value for the task appears in the Earned Value 
Total Hours column.

Budget Hours to Date – The amount of your total budget you have used to date appears in the 
Budget to Date Hours column.
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Estimate at Completion – The Estimate at Completion column contains the estimated final 
figures for your project. The Estimate at Completion values that appear in this table are informal 
values only. To maintain your formal Estimate at Completion, refer to “Manually Creating 
Estimates at Completion,” on page 7–5.

Actual Total Hours – The number of hours you have reported to the task appears in the Actual 
Total Hours column.

Cost Var Total Hours – The difference between your budgeted and actual for the task appears in 
the Cost Var Total Hours.

Monthly Summaries – The monthly summaries section contains summaries for each month for the 
life of the project. If the life of the project is for two months, two sets of 12 columns appear with the 
information for each month appearing in each set of 12 columns. If the life of the project is for one 
year, then 12 sets of 12 columns appear.

The columns that appear in the Monthly summaries section are:

Budget Spread – For each month the amount of budget you have assigned to the task appears in 
the Budget Spread column.

Earned Value – The earned value for the task for the month appears in the Earned Value column.

Estimate at Comp – The Estimated Time to Complete is an estimate of the time it will take you to 
complete the project.

Actual – The number of hours you have reported to this task for the month appears in the Actual 
column.

Sched Var – The Schedule Variance is the difference between your budget and the earned value 
of the project at the time you calculated the schedule variance.

Cost Var – The Cost Variance is the difference between the earned value of the project and the 
actual value you have reported to the project.

Each individual line contains the figures for each cost category associated with each task within the 
project, therefore, if your project has a total of nine tasks with two cost categories assigned to each 
task, 18 lines appears in the upper portion of the table. The bottom portion of the table contains the 
total amounts for all of the tasks within your project.

Manipulating Information in the Project Summary Window
For many reasons, you may find it necessary to change the figures appearing for your Budget 
Spread.

To manipulate information:

1 In the Project Summary window, click the Site ID arrow and select the site in which the project 
was created.

2 Click the Project ID arrow and select the project for which to change figures.

3 In the Summary Type section, select Budget Spread.
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4 Double-click the row containing the information you want to change. and make the changes you 
want. The Direct Costs dialog box for the row appears.

5 Click in the cell that you would like to change and enter the new amount. 

6 When you have finished making changes, click the Save button on the tool bar.

Selecting Information in the Project Summary Window
While working in the Summary window, you may find it helpful to highlight specific information so you 
can better concentrate on the information you want.

Use the following methods to highlight information:

• To select a single line, click anywhere in the appropriate header.
• To select several concurrent lines, click in the first row you want to select and drag the cursor to

the last row you want to select.

You can also click the first row you want to select and hold the SHIFT key while clicking the last 
row you want to select.

To select more than one discontinuous row, hold the CTRL key while click on the rows you want 
highlighted.

• To select columns, click the column header for the column you want highlighted.
• To select more than one column, hold the CTRL key and select the columns, you want

highlighted.

Note: You can select columns and rows together to help highlight the information you want.

Accessing Nested Information
One of the most powerful aspects of the project Summary window is the ability of the user to easily 
access nested information: information in layers below that which the user is currently viewing.

You can go from a summary level view of your project to a transaction level detail.

Accessing Nested Direct Cost Detail Information
Project summary cost information is the fully loaded or burdened cost associated with a cost 
category: cost information includes the direct labor, material, and ODC cost as well as the applied 
burden and overhead costs.

To access nested direct cost detail information:

1 Click the Site ID arrow and select the site in which the project was created.

2 Select a Project ID and select an Actuals summary.
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3 Double-click on the line in the summary information table that contains the summary for which you 
want more information.

A secondary window appears showing the Direct Cost details for the line you selected.

You can also highlight a line and then from the Edit Menu and select Direct Cost Detail. 

With the Details table open, you can select any number of lines in the Summary table and their 
detailed information automatically appears in the Details table.

The rows beginning with Amount are direct cost, all other rows contain Applied Burden 
categories.

Note: Using the Copy command on the Edit menu, you can copy detail information into other 
programs. 

Accessing Nested Details for Actuals Information
Note: Before you can view actuals information you must run VISUAL — Projects/A&D’s costing 
utilities.

To access nested details for actuals information:

1 Click the Site ID arrow and select the site in which the project was created.

2 Select a Project ID and select an Actuals summary.

3 From the Info Menu select the Show Details for Actuals option.

The secondary window shows the specific transactions relating to the cost summary for the rows and 
columns you highlight.

Note: When you select rows and columns together, only the cost category detail information for the 
intersection you select appears in the secondary window.

The secondary window is populated with this information:

Labor transactions – Labor Ticket ID, Employee, Transaction Date, Quantity Complete Reported, 
Hours, and Direct Cost.

Material transactions – Purchase Order ID, Vendor, Part Number, Receipt Date, Quantity Received, 
and Direct Cost.

Direct Charge A/P invoices – A/P Invoice ID, Vendor, Reference Description, Invoice Date, and 
Direct Costs.

Accessing Nested Source For Actuals Information
To access nested details for actuals information:

1 Click the Site ID arrow and select the site in which the project was created.

2 Select a Project ID and select an Actuals summary.

3 From the Info Menu select the Show Source for Actuals option.
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A secondary window appears showing the specific transactions relating to the cost summary for 
the rows and columns you highlight.

The secondary window shows the Cost Source (for example, Labor and Purchase Order) and the 
direct cost associated with the project summary lines you highlight.

4 Double-click on a line to view the Show Detail for Actuals window. 

Showing Project Status
To show the status of each task within the project:

1 Click the Site ID arrow and select the site in which the project was created.

2 Select a Project ID in the Project Summary window and select an Actuals summary.

3 From the Info Menu select the Show Project Status option.

A secondary window appears showing, by WBS, all the work orders, quotes, and A/P invoices 
associated with the project.

Opening Work Orders
To open a work order from the Project Status secondary window, select the line that contains the 
work order you want to open and click the Open Work Order button.

VISUAL’s Manufacturing window opens and the appropriate work order appears.

Managing Earned Value
Use Earned Value management to measure the progress of your projects taking into account the 
amount of work you have completed, the time you have taken, and costs you have incurred to date. 
Because you use time and materials to complete tasks, you can use Earned Value to evaluate project 
progress in fiscal terms. By looking at the Earned Value at any instant in time, you can compare your 
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planned figures with your actual figure and make informed judgements as to the progress of your 
projects. You can also use Earned Value data to more accurately estimate your completion dates and 
costs. 

Glossary
BCWS – The Budget Cost of Work Scheduled is your budget for the project. The BCWS is compiled 
from the following:

• Work Breakdown Structure
• Project Budget
• Project Master Schedule

ACWP – The Actual Cost of Work Scheduled is the costs you have reported to the project to date.

BCWP – The Budget Cost of Work Performed is the difference between your budget costs and your 
actual costs to date—this is the project’s Earned Value. 

VAC – The Variance at Completion is the difference between your complete budget and the total 
costs you have reported to the project.

SV – The Schedule Variance is the difference between your budget and the earned value of the 
project at the time you calculated the schedule variance.

CV – The Cost Variance is the difference between the earned value of the project and the actual 
value you have reported to the project.

ETC – The Estimate to Completion is an estimate of the costs required to complete the project.

Earned Value is calculated using two methods:

Calculate Earned Value Quantities – The most common form of Earned Value calculation is 
“Objective” and is based on the quantity you have completed.

Earned Value Quantities are calculated based on the quantity complete for the project linked work 
orders.

SV
CV

BCWP

VAC
Budget

ETC

$

Time

BCWS
ACW

P

Contract
Complete

Date

Current Date
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Calculate Earned Value Amounts – Earned Value calculations based on Amounts is a “Subjective” 
form of evaluation and a less common form of Earned Value calculations than calculations based on 
Quantities.

Earned Value Amounts are calculated based on the Percentage of Complete of the project’s tasks—
the percentage of budget costs for work performed.

Note: You cannot realize Earned Value greater than your budget.

After the earned value is calculated, you can use the Project Summary window to view and analyze 
the results. For more information, refer to “Working with the Project Summary Window,” on page 6–2.

Calculating Earned Value Quantities
After you have created work orders for your projects and collected labor and financial data for those 
work orders, you can use the Calculate Earned Value window to post the information to your projects.

To calculate and post earned value quantities:

1 From the Project Summary Window, click the Site ID arrow and select the site to use.

2 Select Edit, Calculate Earned Value....

3 Click the Starting Project ID button and select the Project ID on which you want to start this 
posting.

4 Click on the Ending Project ID button and select the Project ID on which you want to end this 
posting.

5 Click the Calculate Quantities button. 

This information is displayed:

Post – A check box appears allowing you to select the earned value line.

EV Project ID – The Project ID appears in the EV Project ID column.

EV Task ID – The Task ID appears, indicating the task to which the program will post.

EV Qty to Date – The quantity to date that you have reported to this task appears in the EV Qty to 
Date column.

EV Qty Remaining – The quantity you have not reported yet for the task appears in the EV Qty 
Remaining column.

Post Quantity – If you reported quantity instead of hours, the quantity you reported appears in 
the quantity column.

Ticket Quantity – The quantity you reported on any labor tickets appears in the Ticket Quantity 
column.

From Work Order ID – The work order on which you entered labor appears in the From Work 
Order column.

From Resource ID – The Resource from which this earned value came appears in the From 
Resource ID column. 
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Employee ID – The identification number of the employee who performed the labor appears in 
the Employee ID column.

Hours – The number of hours you reported appears in the Hours column.

6 Click Save.

Calculating Earned Value Amounts
Earned value is calculated based on the percent complete for the project tasks against which you 
have entered labor in Labor Ticket Entry.

To calculate and post earned value amounts:

1 In the Project Summary window, click the Site ID arrow and select the site in which the project 
was created.

2 Select the project for which you would like to calculate Earned Value Amounts.

3 From the Edit menu, select Calculate Earned Value. 

4 In the Calculate Earned Value window, click the Calculate Amount button.

5 Click the End of Fiscal Period calendar button and select any date within the period on which the 
fiscal period ends.

6 Click the Calculate button.

Earned value is calculated based on the parameters you select. After the values are calculated, a 
dialog box is displayed, prompting you to refresh the Project Summary window.

7 Click the Yes button.

8 Click the Close button to exit the Project Summary window.

Viewing Percent of Completion Values
Percent of Completion or POC is a method of recognizing revenue and profit, based on the 
percentage of completion against the job, prior to transferring the title of the goods to your customer.

For more information on the methods of calculating POC, refer to the American Institute of Certified 
Public Accountants (AICPA) SOP 81-1.

1 In the Project Summary window, click the Site ID arrow and select the site in which the project 
was created.

2 Select the project whose percent of completion values you want to view.

3 From the Info menu, select Percent of Completion Values.

4 If you want to view a different Version ID of this project, click the Version ID arrow and select the 
version you want to view.
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5 If you want to specify a date limit for your completion values, use the Actual Costs as of calendar 
button.

6 When you have finished viewing percent of completion values, click the Close button.

Interpreting Percent of Completion Values
The following values appear in the Percent of Completion dialog box:

EAC – The EAC column contains the latest set of Estimate at Completion values.

Cumulative Actuals – Actual figures you have reported against this project to date.

Percentage Complete – The amount of the project you have completed to date. By changing the 
Actual Costs as of date you can review the POC figures as they were on the date you selected.

For each of the above columns, the following categories appear:

Hours – The number of hours you have posted to the project.

Material Amount – The financial amount of material you have posted to the project.

Labor Amount – The amount of labor (monetary) that you have posted to the project.

Burden Amount – The financial amount of burden you have posted to the project.

Service Amount – The financial amount of outside service you have posted to the project.

Total Amount – The totals of all of the above are calculated.

Viewing Baseline and EAC Comparisons
You can compare any version of an EAC to its original baseline target. This allows you to see view 
the impact those different versions have on the contract’s profitability.

To view Baseline and EAC Comparisons:

1 In the Project Maintenance window, click the Site ID arrow and select the site in which the project 
was created.

2 Select the project whose percent of completion values you want to view.

3 From the Info menu, select the Baseline/EAC Comparison option.

Note: The version appearing in the Baseline/EAC Comparison dialog box is the version you have 
designated as current in the Project EAC/Target Costs window.

4 If you want to select a different version, click the Version ID arrow and select the version you 
want.

5 When you have finished viewing your Baseline/EAC Comparisons, click the Close button.
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Interpreting Baseline/EAC Comparisons
There are three columns of information in the Baseline/EAC Comparison window:

Baseline – The information appearing in the Baseline column is information you entered in the 
Baseline Financial Information window. This serves as a financial starting point for your contract.

Version Number – The figures you entered for the particular version in the EAC/Target Costs window 
appear in the center column.

Variance – The difference between the Baseline and the version you selected is calculated. Positive 
numbers appear if your Baseline is higher and negative numbers appear if the Baseline is lower.

Project Summary Chart
Use the Project Summary Chart to analyze how project summary values have changed over time to 
track whether your project is on budget. The amounts displayed are based on your current ETC. 

When you view the chart, you can view summary information measured in monetary amounts or 
summary information measured in hours. For example, you can compare EAC Amounts to Actual 
Amounts, or Budget Hours to Actual Hours, but you cannot compare EAC Amounts to Actual Hours.

In addition to the summary information you select for the chart, the contract value of the project is 
displayed. You can use this line to evaluate whether the project is profitable. 

Viewing the Project Summary Chart
To view the project summary chart:

1 Select View, Project Summary Chart.

2 Specify this information:

Project ID – If you selected a project ID in the Project Summary Window before accessing the 
chart, then that ID is inserted in the Project ID field. To examine a different project, click the 
browse button and select the ID of the project to view.

From Date and Thru Date – Specify the date range to use to examine values. Leave these fields 
blank to view information for all of the project’s history.

Chart Only – To view only a chart, select this check box. To view the chart and the values used 
for the chart, clear this check box. If you view the values used in the chart, the values are 
displayed in a grid. You can sort and group the information in the grid in a variety of ways and 
export the information in the grid to Microsoft Excel. See "Grids" on page 2–23 in the Concepts 
and Common Features guide.

3 To specify the information to view in the chart, click Setup Chart. 

4 You can view either monetary amounts or hour values on the left axis. To view monetary amounts, 
click Amounts. To view hour values, click Hours.

5 Select the information to display in the chart. Perform one of these steps:
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• If you clicked Amounts, you can view total amounts and variances. To make it easier to see
variance patterns, a separate scale for variances is drawn on the right axis. If you select more
than one variance amount, multiple scales are drawn on the right axis. This is a known issue
with the graphic engine. 

Select from these options for the left axis:

Budget Amount

EAC Amount

Actual Amount

Earned Amount

Select from these options for the right axis:

Budge Variance

EAC Variance

Cost Variance

Schedule Variance

• If you clicked Hours, a scale is drawn on the left axis only. Select from these options:

Budget Hours

EAC Hours

Actual Hours

Earned Hours

6 Click Ok. The chart is drawn. If you cleared the Chart Only check box, the values used to draw 
the chart are displayed.

Printing the Project Summary Chart
After you generate a project summary chart, you can print the chart to a printer. To print the chart, 
click Print. Only the chart is printed. The values used to construct the chart are not printed, even if you 
are viewing them in the Project Summary Chart dialog. 

Project Summary Window Reports and Tools
The Project Summary window features several reports that can help you analyze project budgets, 
review materials used in the project, review labor tickets associated with the project, and review GL 
transactions associated with the project.
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Project Summary Report
Use the Project Summary Report to output the information currently displayed in the Project 
Summary window. You can also use this report to review costs for all periods.

To run the report:

1 In the Project Summary window, click the Site ID arrow and select the site in which the project 
was created.

2 Enter the project you would like to view in the Project ID field. You can select a project by clicking 
the Project ID button and selecting the project ID from the table.

3 If you want to output specific information from the Project Summary window, select the 
information you would like to view. For example, select Budget Variance in the Summary Type(s) 
section to view budget variance information.

4 From the File menu, select Print Project Summary.... 

5 Select the information you want to view in the report. To view the information that currently 
appears in the Project Summary window, select Print data currently showing on screen. To 
print information for all periods, select Print detail for all periods. If you select Print detail for all 
periods, the report displays the summary type(s) you selected in the Project Summary window 
with cumulative totals for the entire project, not just the current period.

6 If you select Print detail for all periods, the Cost Group Type section becomes available. Select 
the cost groups you would like to view in the report:

All – Select All to view all cost groups in the report.

Labor – Select Labor to view only labor-related costs in the report.

Material – Select Material to view only material costs in the report.

ODC – Select ODC to view other direct costs in the report.

7 If you select Print detail for all periods, the Group By section becomes available. Use the Group 
By section to select a sort order for the report. Your choices are:

• Current screen settings
• WBS, Seq No, Cost Cat, Dept
• WBS, Seq No, Cost Cat
• WBS, Cost Category
• WBS, Department
• WBS
• Project ID
• Project Type

8 Select the Print grid lines check box to print grid lines in the report. The grid lines separate each 
line.

9 If you select Print detail for all periods, the Print Subtotals check box becomes available. Select 
Print Subtotals to view the sub-total by group. 
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10 Click the arrow to select the output method for the report. Your choices are View, Print, Email, and 
File. If you choose Email, the PDF Format check box becomes available. Select the check box to 
email the report as a PDF.

11 Click Ok. 

Budget Information Report
Use the Budget Information report to review budget hours and amounts. The information that appears 
in this report is the same information that appears in the Maintain Budget window. For more 
information, refer to “Setting Up Budgets,” on page 3–38.

To output the report:

1 In the Project Summary window, click the Site ID arrow and select the site in which the project 
was created.

2 From the File menu, select Print Budget Info.... The Print Budget Info dialog box appears.

3 In the Print Budget Info dialog box, enter the first Project ID you would like to view in the Starting 
Project ID field, or click the Starting Project ID button to choose a Project ID from a table. In the 
Ending Project ID field, enter the last project ID you would like to view, or click the Ending Project 
ID button to choose a Project ID from a table. To view a single Project ID, enter the same ID in the 
Starting and Ending Project ID fields. To view all Project IDs, leave the Project ID fields blank.

4 Click the arrow to select the output method for the report. Your choices are View, File, Print and 
Email. If you select Email, the PDF Format check box becomes available. Select the check box to 
email the report as a PDF.

5 Click Ok to output the report. The report displays the Project ID, Project Version, WBS Code, 
Sequence #, WBS Description, Operation Specs, Sub ID, Dept ID, Cost Calgary ID, Hours or 
Amount, and Spread Type for each WBS code with budget information in the project(s) you 
selected.

Material Commitment Report
The Material Commitment Report shows the parts and materials required to complete the project. To 
run the Material Commitment Report:

1 In the Project Summary window, click the Site ID arrow and select the site in which the project 
was created.

2 Enter the project you would like to view in the Project ID field. If you would like to view all projects 
in the report, leave the Project ID field blank.

3 From the File menu, select Print Material Commitment Report....

4 In the Print Material Commitment Report dialog box, in the Group By section, select how you 
would like the report to be organized. Your choices are:

• Current screen settings
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• WBS, Seq No, Cost Cat, Dept
• WBS, Seq No, Cost Cat
• WBS, Cost Category
• WBS, Department
• WBS
• Project ID
• Project Type

5 Select the AP Value check box to view amounts as expressed in Accounts Payable. Leave the 
check box blank to view the amounts actually received.

6 Select the Print Subtotals check box to view subtotals by the group you selected in the Group By 
section.

7 Click the View arrow to select the output method for the report. Your choices are View, Email, 
File, and Print.

8 Click Ok.

The report includes the Project ID and Description, The WBS code, Sequence Number, Cost 
Category, Department, Order ID, Vendor, Order Date, Line Status, Line Number, Part ID, Order 
Quantity, Unit Price, Fixed Charge, Extended Cost, Paid Quantity, Paid Price, Paid Fixed Charge, 
Paid Cost, Outstanding Quantity and Outstanding Cost.

EAC/POC Report
Use the EAC/POC Report to compare Estimate At Completion figures with Percent of Completion 
figures. To run the EAC/POC Report:

1 In the Project Summary Window, click the Site ID arrow and select the site in which the project 
was created.

2 From the File menu, select Print EAC/POC Report....

3 Click Current Project to view information on the project currently selected in the Project 
Summary window. Click Range of Projects to view a range of projects in the report.

4 If you selected Current Project in the Print Selection section, click the Version ID button to select 
the EAC version you would like to use in the report, or enter the EAC version in the Version ID 
field.

5 If you selected Range of Projects in the Print Selection section, the Starting Project ID and Ending 
Project ID fields appear. In the Starting Project ID field, enter the first Project ID you would like to 
view, or click the Starting Project ID button to choose a Project ID from a table. In the Ending 
Project ID field, enter the last project ID you would like to view, or click the Ending Project ID 
button to choose a Project ID from a table. To view a single Project ID, enter the same ID in the 
Starting and Ending Project ID fields. To view all Project IDs, leave the Project ID fields blank.

If you choose to view a range of projects, the report compares the percentage of completion 
figures to the current EAC.
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6 In the Filter section, enter a filter for the report to narrow the information that appears. You can 
select:

Project Type – Select Project Type to narrow the information in the report by project type. Click 
the Project Type button to select the project type you would like to view in the report. The report 
displays only those projects with the type you specify.

Project Status – Select Project Status to limit the information in the report to projects with the 
status(es) you specify. When you select Project Status, the Project Status selection section 
becomes available. Select the status(es) you would like to view in the report. Your choices are:

• Unreleased
• Firmed
• Released
• Closed
• Cancelled/Void

7 In the Summary of Actuals and Cost of Goods Sold section, enter the date range of the actuals 
and costs of goods sold you would like to view. If you would like to view all actuals and costs up to 
a certain date, leave the Begin Accounting Period Date field blank, and select a date for the End 
Accounting Period Date field only. The dates you enter in the Begin Accounting Period Date and 
End Accounting Period Date fields are adjusted to the last day of the accounting period.

8 Click the output arrow to select the output method for the report. Your choices are View, Email, 
Print, and File. If you select Email, the PDF Format check box becomes available. Select the 
check box to email the report as a PDF.

9 Click Ok. 

The report shows the date the ETC was last updated, the Project ID and Description, the Cost 
Group, Actual Amounts, Informal EAC Amounts, Formal EAC Amounts without Reserves, Formal 
EAC Amounts with Reserve, Cost of Goods Sold, Project WIP, and Percentage of Completion 
with Reserve. If you selected an EAC in the Version field, the name of the EAC appears on the 
report. If you selected multiple projects, a summary of the report appears on the final page.

Inquiry / Print G/L Transactions
Use the Inquiry / Print G/L Transactions window to review all G/L transactions related to projects. You 
can view posted and unposted transactions, and in Inquiry mode you can access the individual 
transaction that created the G/L transaction. 

To access the Inquiry / Print G/L Transactions window, select Inquiry / Print G/L Transactions from 
the Info menu. The Inquiry / Print G/L Transactions window appears.

Setting Up Report / Inquiry Parameters
To set up the parameters for your report or inquiry:

1 Do one of these steps:
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• To view information for a single site, click the Standard tab. Click the Site ID arrow and select
the site to view.

• To view information for multiple sites, click the Advanced tab. Click the Currency ID and
select the currency to view in the report. Transactions that were posted in the currency you
select are displayed. Click the Site ID(s) arrow and select the sites to include in the report. 

1 In the Filters section, select how you would like to limit the information for the report. Your choices 
are:

By Date Range – Select By Date Range to limit the information to transactions that occurred on 
certain dates. If you choose By Date Range, the Starting Date and Ending Date fields become 
available. In the Starting Date field, enter the first date of the period you would like to view. In the 
Ending Date field, enter the last day of the period you would like to view. The dates are adjusted 
to the last date of the period. If you choose By Date Range, the Starting and Ending Account ID 
fields become active. Use the Starting and Ending Account ID fields to limit the information in the 
report to certain accounts. In the Starting Account ID field, enter the first account ID you would like 
to view in the report. In the Ending Account ID field, enter the last account ID you would like to 
view in the report. The accounts you specify and all accounts that fall in between are displayed. 

By Batch Number – Select By Batch Number to limit the information to transactions posted in 
particular batches. If you select By Batch Number, the Starting Batch ID and Ending Batch ID 
fields become available. In the Starting Batch ID field, enter the first Batch ID you would like to 
view, or click the Starting Batch ID button to choose a Batch ID from a table. In the Ending Batch 
ID field, enter the last Batch ID you would like to view, or click the Ending Batch ID button to 
choose a Batch ID from a table. To view a single Batch ID, enter the same ID in the Starting and 
Ending Batch ID fields. To view all Batch IDs, leave the Batch ID fields blank.

By Project Info Filters – Select By Project Info Filters to limit the information to transactions 
associated with projects that match the criteria you determine in the Project Info section. When 
you select By Project Info Filters, the Project Info section becomes active. Click the Project Info 
button and select the project criteria. For more information on selecting Project Info filters, refer to 
“Using Project Filters,” on page 6–3. If you select By Project Filters, the Starting Date and Ending 
Date fields become active. In the Starting Date field, enter the first date of the period you would 
like to view. In the Ending Date field, enter the last day of the period you would like to view. The 
dates are adjusted to the last date of the period.

2 In the Sequence section, select the sort order for the report / inquiry. Your choices are:

G/L Account ID, Batch Type – Select this option to sort the report by G/L Account ID first, then 
by Batch Type.

Project, WBS, Dept – Select this option to sort the report first by Project ID, then by WBS code, 
then by Department. If you select this option and have chosen to view a report, only a detailed 
report is available.

Project, Batch Type – Select this option to sort the report first by Project ID, then by Batch Type. 
This option is not available if you are running the report or inquiry by Project Info Filters.

Batch Type – Select this option to sort the report by Batch Type. This option is not available if you 
are running the report or inquiry by Project Info Filters.

Burden Cat ID, G/L Acct ID – Select this option to sort the report by Burden Category ID/G/L 
Account ID combination.
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G/L Acct ID, Burden Cat ID – Select this option to sort the report by G/L Account ID/Burden 
Category ID combination.

Proj, WBS, Seq, Dept, Burden Category – Select this option to sort first by project ID, then by 
WBS code, then by project sequence ID, then by burden category, and then by G/L Account ID. 
This sort option is particularly useful in analyzing move transactions. Note that the label in the 
drop-down menu is truncated.

Proj, WBS, Seq, Dept, G/L Account ID – Select this option to sort first by project ID, then by 
WBS code, then by project sequence ID, then by G/L Acct ID, and then by Burden Category. This 
sort option is particularly useful in analyzing move transactions. Note that the label in the drop-
down menu is truncated.

3 In the Transaction Type section, select the type of transaction you would like to view in the report. 
Your choices are:

• Purchases
• Labor
• Adjustments
• Project Transfers (includes Project Transfers and WIP Issues)
• Move Transactions (includes Project Transfers, WIP issues, Adjust Outs, and Receipt

Returns)
• Accounts Payable
• General Journal

Select Print All to view all transaction types.

4 In the Transactions section, select from the following:

Print Unposted Txs - Select this option to view only those transactions that have not yet posted 
to the General Ledger. This option is not available if you selected to view the report by Batch ID.

Print Posted Txs - Select this option to view only posted transactions. This option is selected 
automatically if you choose to view the report by Batch ID.

Print Both - Select this option to view both posted and unposted transactions. This option is not 
available if you selected to view the report by Batch ID.

5 To further define your report, select or clear check boxes as follows:

Current User Only - Select the Current User Only check box to view transactions that the current 
user inputted. To view all transactions from all users, clear this check box.

Include Rev Recg - Select this check box to include revenue recognition transactions in the 
report. Clear the check box to omit revenue recognition transactions from the report.

Include Rev Recg WIP Only - Select this check box to view revenue recognition for work in 
process projects only. Clear this check box to include all revenue recognition transactions. This 
check box is only available if you select the Include Rev Recg check box.

Printing the G/L Transactions Report
To print a report based on the parameters you set up:
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1 In the Mode section, select Report Only. The Reporting Options section becomes available.

2 In the Reporting Options section, select the type of report you would like to view. You can choose 
from:

Detail – Choose Detail to view a detailed report. The information displayed in the detailed report 
varies depending on the type of report you are viewing.

Summary – Select Summary to view a summarized report.

Summary w/subtotals – Select Summary w/subtotals to view the summarized report with 
subtotals by group.

3 Click the View arrow to select the output method for the report. You can choose View, Email, 
Print, or File.

4 Click Ok. 

Viewing the G/L Transactions Inquiry
To view the results based on the parameters you set up in a table:

1 In the Mode section, select Inquiry Only.

2 Click Ok. 

3 If a Plus sign appears in the Sum column, you can view more information about the line. Double-
click the row header to view the additional information. The details appear indented underneath 
the row you selected. When there is no additional detail to view, the Sum column is blank.

4 If you are viewing a burden line, you can view the details of the burden distribution. Double-click 
the line to open the Burden Distributions dialog box. See "Viewing Burden Information" on page 
6–22 in this guide.

5 When you are finished viewing information in the Inquiry / Print G/L Transactions window, click 
Close to exit the window.

Saving the G/L Transactions Inquiry as a Database Table
If your G/L Transactions Inquiry returned a large number rows, you can export the results to a 
database table. The name of the table is PROJECT_GL_TRANS.

1 In the Mode section, select Save to DB.

2 If you have selected the By Date Range or By Project Info filters, specify dates in the Starting 
Date and Ending Date fields.

3 Click Ok to export the data to a table. 

Note: When you export a new G/L Transaction Inquiry, the information in the PROJECT_GL_TRANS 
table is copied over. 
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Exporting the G/L Transactions Inquiry to Microsoft Excel or XML
You can export the data from your G/L Transactions Inquiry to Microsoft Excel. After you export the 
data, you can sort and manipulate the data.

After you execute your inquiry, select an option from the File menu:

Send All Rows to Microsoft Excel – Select this option to send all of the inquiry results to Excel.

Send Selected and Visible Rows to Microsoft Excel – Select this option to send only the rows 
you’ve selected in the table to Excel.

Send Detail Burden Rows – Select this option to send only the rows that show individual burden 
transactions to Excel.

Send Summary Burden Rows – Select this option to send the summary burden rows to Excel. 

Send to XML – Select this option to export the inquiry data in XML format.

Viewing Burden Information
In the Inquiry mode, you can view additional information about burden transactions. You can view 
summary level information and detail level information.

After you generate an inquiry, double-click any burden row to review the details of the burden 
transaction. 

The burden distributions dialog shows this information:

• The source of the transaction.
• The account ID and description where the transaction was posted.
• The burden category ID.
• The amount type. CR is displayed if the transaction is a credit transaction. DR Is displayed if the

transaction is a debit transaction.
• The debit amount.
• The credit amount.
• The posting date of the transaction.
• The department ID of the transaction.
• The cost category ID of the transaction.
• The project ID.
• The WBS code.
• The batch ID and description of the batch used to post the transaction.
• The date the batch was posted.
• The type of batch posted.
• The inventory ID of the transaction that generated the burden.
• The document ID of the transaction that generated the burden, such as a purchase order ID or

work order ID.
• The line number of the document that generated the burden.
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• The Site ID where the transaction occurred.
• The project summary ID.

Use the Burden Category ID field to filter the table by burden category. When you select a burden 
category ID, only transactions for that burden category are displayed in the table. 

To display the burden amounts in a different currency, specify the ID of the currency in the Currency 
ID field. 

Viewing Burden Information for “Move” Transactions
Certain transactions use a single burden category to report burden costs. These transactions are 
called “move” transactions. These move transactions report burden in a single category:

• Transfer from commercial inventory to project inventory
• Transfer from project inventory to different project inventory
• Transfer from project inventory to commercial inventory
• Adjust out of project inventory for purchase parts
• Adjust out project inventory for fabricated parts
• WIP issue commercial inventory to project work orders
• WIP issue project inventory to different project work order
• WIP issue project inventory to different WBS in the same project (WBS transfers flagged)
• WIP issue returns transferred to another project.
• Finished goods receipts transferred to another project.
• Purchase receipt returns for project inventory
• Any cost updates for these transaction that may have taken place in a previous period

Additional transactions can be classified as move transactions, but these other transactions do not 
create burden.

When you view burden information for move transactions, the Burden Details dialog shows the actual 
burden transactions posted to your general ledger. Where possible, the individual burden amounts 
that made up the actual amounts are also listed. These individual burden amounts are identified as 
SUPPLY transactions in the table. To identify the supply burden transactions, the INV_TRANS_DIST 
and BURDEN_DIST_DETAIL tables are examined to find the cost layers linked to the actual burden 
amounts.

Depending on the move transaction, the total of the supply transactions may not match the burden 
amount actually posted. In certain cases, such as transfers of finished goods and WIP issue returns, 
cost layers of the supply burden transactions do not generate a burden transaction. For these move 
layers, the ID of the work order that produced the goods is provided for your further analysis.

To analyze the transactions:

1 In the Print G/L Transactions dialog box, specify this information:

Mode – Specify Inquiry Only.
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Transaction Type – Specify Project Transfers to view only project transfer and WIP issue 
transactions. Specify Move Transactions to view project transfers, WIP issues, adjust out 
transactions, and purchase receipt returns.

Sequence – Specify the sequence for the inquiry. To ease the identification of burden line items, 
select either Proj, WBS, Seq, Dept, Burden Category, G/L Account ID or Proj, WBS, Seq, Dept, 
G/L Account ID, Burden Category.

2 Complete the remaining header information as necessary.

3 Click Ok.

4 You can view burden details for an individual burden transaction row or for a summary row. To 
view details, double-click the row. To view details for a summary row, you must first expand the 
row to display all child transactions. Otherwise, double-clicking on the header row expands the 
child transactions instead of opening the burden summary information.

The header of the Burden Distributions dialog box shows the type of information you are viewing. 
If you are viewing information for a summary row, then Summary is inserted in the header. If you 
are viewing information for a detail row, then Detail is inserted. 

The Burden Distributions dialog box shows the same information as the standard Burden Detail 
dialog box. This information is also shown:

Inv Tx Qty – The total quantity of materials for the supplying inventory transaction is displayed.

Sup Debit Amount – The total burden debit amount for the supplying inventory transaction.

Sup Credit Amount – The total burden credit amount for the supplying inventory transaction.

Dist Debit Amount – The moved burden debit amount reported in the BURDEN_DIST_DETAIL 
table.

Dist Credit Amount – The moved credit amount reported in the BURDEN_DIST_DETAIL table.

Dist Qty – The move quantity for the supply layer for the actual transaction.

Dist-In Trans ID – The ID of the transaction that supplies the quantity for the actual transaction.

Work Order ID – For finished goods and WIP Issue return transfers, the ID of the work order for 
the supply layer.

Row Type – For the transactions that were formally posted to your general ledger, ACTUAL is 
displayed. For the transactions that fed into the total actual burden amounts, SUPPLY is 
displayed.

5 To filter the information in the table, specify this information:

Burden Category ID – To view transactions for a particular burden category ID, specify the ID in 
this field.

Row Type – To view the actual burden postings only, specify ACTUAL. To view the cost layers 
that supplied the values for the actual burden postings, specify SUPPLY. To view all transaction, 
specify ** All **.

6 To change the currency of the amounts in the table, specify the currency to use in the Currency ID 
field. If you are viewing transactions for a single site, you can use any currency assigned to the 
site’s parent entity. If you are viewing transactions for multiple sites, you can select only 
currencies common to each site’s parent entity.
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Exporting Information from the Burden Distributions Dialog
To export the information in the table, right-click in the table. To send the data to Microsoft Excel, 
select Send to Excel. A Microsoft Excel spreadsheet is opened with the information from the table. 
To send the data to an XML file, select Send to XML.

Rate Management Window Reports and Tools
Use Rate Analysis to assess the rates you use in your projects. Use the Rate Info report to review the 
rate usage within a period of time that you specify. 

Analyzing Rates
Analyzing the rates you use in calculations and comparing them against each other is important in 
helping you manage your projects and contracts.

To analyze rates:

1 From the Project menu of the main window, select Rate Management.

2 From the Info menu, select Rate Analysis. 

3 Click the Site ID arrow and select the site in which to run a rate analysis.

4 Click the Year arrow and select the year for which you want to run a rate analysis.

5 Use the Period arrows to select the Starting and Ending periods for this Rate Analysis run.

6 Click the Run Rate Analysis button.

The three Year to Date columns are populated with this information:

Applied Rate – The current applied rate percentage by Burden Category ID appears in the 
Applied Rate column.

Actual Rate – The Actual Run Rate Percent is calculated as:

Variance – The variance is calculated as the Actual Rate percent subtracted from Current applied 
rate percentage.

Burden Category Pool
Burden Category Base Actual =
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Accessing Nested Rate Analysis Information
You can access nested information in the Rate Analysis window by double-clicking on the line in 
which you are interested, or selecting the line then clicking the Detail... button.

The Rate Analysis Drill-down View dialog box appears.

You can use the arrows at the top of the window to scroll through the Burden Categories that appear 
on the Rate Analysis window. 

The following Year to Date information appears:

Total Budget Amount – The total amount of your budget figures for this burden category for the time 
period you specified.

Total Actual Amount – The total amount of your actual figures for this burden category for the time 
period you specified.

Variance – The difference between the Total Budget Amount and the Total Actual Amount.

Actual Rate – The Actual Run Rate Percent based on the Cat Pool and Cat Base for this Burden 
category.

For the Burden Category Pool and Base, the following information appears:

Account ID – Each account you specified for the Cat Pool appears.

Account Description – The description of the account.

Budget Amount – The budget amount for each individual account within the base or pool appears.

Actual Amount – The actual amount for each individual account within the base or pool appears.

Variance – The difference between the budget and actual amounts for each individual account within 
the base or pool appears.

Click the Sort button to change the order of the information presented in the Burden Category Pool 
and Base tables. You can sort by Account ID, Account Description, Budget Amount, Actual Amount, 
or Variance. Select the Sort Ascending option to sort the information in ascending order. Clear the 
selection to view the information in descending order.   

Note: The totals for all of the accounts within your Category Pool and Base appears.

Printing Rate Analysis Information
To print Rate Analysis reports:

1 Open the Rate Analysis dialog box, click the Site ID arrow and select the site to use, then select 
the Year and Period of interest.

2 Click on the Category for which you want to print a report.

3 Click the Print button.

4 The Year and Period you selected automatically appears in the Print Dialog section. If you want to 
print a report for different periods, make the appropriate changes.
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5 The Burden Category ID you were viewing in the Rate Analysis table appears selected. If you 
want to print this report for all of your Burden Categories, select the All option button.

6 The Summary Report Type option appears selected. If you want a more detailed report, select 
the Detail option button.

7 Click the Destination arrow and select how you want to view the report. You can select Print, 
View, File, and E-mail. Select the PDF format check box to export the file as a PDF.

8 Click the Ok button to print your report.

Rate Info Report
To run the Rate Info Report:

1 From the Rate Management window, click the Site ID arrow and select the site to use. 

2 Select File, Print Rate Info.

3 Enter the Rate IDs you would like to view in the report in the Starting Rate ID and Ending Rate ID 
fields. 

To view a single rate, enter the same rate ID in the Starting Rate ID and Ending Rate ID fields, or 
click the Rate ID buttons to select the rate ID from a table. 

To view a range of rates, enter the first rate ID you would like to view in the Starting Rate ID field 
and the last rate ID you would like to view in the Ending Rate ID field. The report lists the starting 
rate ID, the ending rate ID, and all rate IDs in between. 

To view all rates, leave the Starting Rate ID and Ending Rate ID fields blank.

4 Enter the Period ID(s) for the period(s) you would like to view in the report in the Starting Period 
ID and Ending Period ID fields. The periods available to you are the periods set up in the Period 
Table in Rate Maintenance. For more information, refer to “Setting Up Period IDs,” on page 2–21. 

To view a single period, enter the same period ID in the Starting Period ID and Ending Period ID 
fields, or click the Period ID buttons to select the period ID from a table. 

To view a range of periods, enter the first period ID you would like to view in the Starting Period ID 
field and the last period ID you would like to view in the Ending Period ID field. The report lists the 
starting period ID, the ending period ID, and all period IDs in between. 

To view all periods, leave the Starting Period ID and Ending Period ID fields blank.

5 Click the View arrow to select the output method for the report. The choices are View, Email, 
Print, and File. If you select Email, select the PDF Format check box to email the information as a 
PDF.

6 Click Ok.

The report shows the Rate ID and description, the Period ID and description, the start and end 
dates of the period, and the rates for each Cost/Burden Category ID.
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Provisional Rate Billing Inquiry
Provisional Billing Rates provide the ability to link a project’s actual costs and EAC figures to a 
Provisional set of Burden Rates. Specify the provisional rate for the project in the Contract Financial 
dialog box in Project Maintenance.

Because Project based Aerospace and Defense companies contract specific billing rates for certain 
types of contracts (such as cost reimbursable types), billing is supported based on pointing actual 
direct costs to a provisional billing rate unique to the contract. This capability enables you to bill for 
cost reimbursable types of contracts. However, the Project Summary window represents your actual 
costs based on a single set of rates you have designated as “use for actuals.”

If changes in business conditions cause you to use new or different set of rates for your project, you 
can easily perform “what-if” rate impact scenarios prior to having to use those rates with your actual 
data. Having this advance information at your fingertips allows you to see the impact to your project’s 
bottom line before actually applying the new set of rates.

Examples of the usefulness of this tool are:

• If companies lose contracts they had planned on receiving as part of their forward pricing rate
submission, they could compare the impact against individual contracts.

• During contract closeout activities a company must “true up” based on final negotiated rates.
Truing up adjusts the money owed to either the company or the customer and can sometimes
happen several years after the company has made its final deliverable. The ability to compare
different types of rates against each other is called Provisional Rate Billing Inquiry.

To run provisional rate billing inquiries:

1 From the Project menu, select the Provisional Rate Billing Inquiry option.

2 Click the Site ID arrow and select the site in which the project was created.

3 Click the Project ID button and select the project on which you want to run a Provisional Rate 
Billing Inquiry.

4 Select the By CLIN check box to view billing information by Contract Line Item Number.

5 Select the By WBS check box to view billing information by WBS code.

6 In the Enter Date Range section, select the Start and End date ranges for the inquiry you are 
running.

7 Click the Rate ID arrow and select the rate you want used for the inquiry.

8 Click the Run button on the tool bar.

Understanding Billing Inquiries
The Billable setting you select in the WBS Codes tab in Project Maintenance or in the Project Window 
is used when calculating Provisional Billing Rate Inquiries.

The Provisional Rate Billing Inquiry dialog box has three sections:
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General Information – The section at the top of the dialog box contains general information about 
the project.

Billable Section – The Billable section contains figures connected to the WBS Codes you have 
indicated as being billable.

Non-billable Section – The Non-billable section contains figures connected to the WBS Codes you 
have indicated as being non-billable.

Note: To access nested rate analysis information, double-click category in which you are interested. 
A secondary dialog box appears with individual lines for each account within the category you select.

Understanding Billable Costs

Note: Negative values appear in parentheses.

For each billable cost element the following information appears:

WBS – If you chose to sort the table by WBS code, the WBS column appears with costs broken out 
by WBS code.

CLIN - If you chose to sort the table by CLIN code, the CLIN column contains the contract line item 
number associated with the costs.

Cap / Ceiling Cost Element – The cost element that generated the amount.

Prior Hours – A summarization of hours occurring before start date.

Prior Amounts – A summarization of amounts occurring before start date.

Period Hours – A summarization of hours falling between the start and end dates of the date period 
you entered.

Period Amounts – A summarization of amounts falling between the start and end dates of the date 
period you entered.

Ceiling Percentage – The percentage you specified as a ceiling for the project appears.

Ceiling Hours – The number of hours you specified as a ceiling for the project appears. Set up 
ceilings in the Billing Ceilings dialog box in Project Maintenance.

Ceiling Amounts – The amount you specified as a ceiling for the project appears. Set up ceilings in 
the Billing Ceilings dialog box in Project Maintenance.

Over/Under Hours – The over or under hours are calculated using the following:

(Prior Amounts + Period amounts) — Cap/Ceiling Amounts

Over/Under Amounts – The over or under amounts are calculated using the following:

(Cap/Ceiling Amount — Prior Amount) = Over/Under Amount

If the Over/Under Amount is less than or equal to the Period amount, the figure appears as a positive 
amount. If the Over/Under Amount is greater than the period amount, the figure appears as a 
negative value in parentheses.



6 – 30 | Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense 

Exceeded – If any figure exceeds its Ceiling at its lowest possible level a Y appears in the Exceed 
column.

For example, for a cost category of “Travel” with a ceiling of $20,000 and actuals of $25,000, the 
category is marked with a Y at the lowest level of reporting for that cost category.

Any Y marked category is posted to the highest level of reporting for whatever Cost Element to which 
“Travel” belongs.

Billing Hours – The potential number of hours you can bill for this category.

Billing Amounts – The potential amount you can bill for this category.

Note: To access nested rate analysis information, double-click category in which you are interested. 
A secondary dialog box appears with individual lines for each account within the category you select.

Understanding Non-billable Costs
For each non-billable cost element the following information appears in the table:

Prior Hours – A summarization of hours occurring before start date.

Prior Amounts – A summarization of amounts occurring before start date.

Period Hours – A summarization of hours falling between the start and end dates of the date period 
you entered.

Period Amounts – A summarization of amounts falling between the start and end dates of the date 
period you entered.

Note: To access nested rate analysis information, double-click category in which you are interested. 
A secondary dialog box appears with individual lines for each account within the category you select.

Project Window Reports and Tools
The Project Window features several reports and tools that help you track the progress of your 
progress and assess availability of resources. The reports and tools include:

• Engineering Report
• Availability
• Labor Tickets
• Project Status
• Exploded Estimated Costs
• Project Charges Under Review
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Engineering Report
The Engineering Report summarizes the legs and tasks in your project. To output an engineering 
report:

1 From the Project Window, open the project you want to print, then select File, Print Engineering 
Report. 

2 In the Engineering Report dialog box, click the Site ID(s) arrow and select the site(s) to use.

The Base ID, Lot ID/Eng ID and Split ID of the project that you are currently viewing in the Project 
Window appear in the dialog box.

3 Select the information you would like to view in the report.

Short Form – Select the Short Form check box to view only the quantity, total hours, and hours 
per piece information. Clear the check box to view quantity, task type, scrap%, start quantity, end 
quantity, resource ID, set up time, fixed scrap amount, run time, minimum move, service ID, 
transit time, and capacity minimum information for each task.

Sort by Op Seq No – Select the Sort by Op Seq No check box to view the report by operation 
sequence number. operations and tasks are indented in the same manner that they are indented 
in the Project Window. If you do not select the check box, operations and tasks are displayed at 
the same indent level.

Skip masters with obsolete parts – Select the Skip masters with obsolete parts check box to 
omit operations and tasks that use obsolete parts. Clear the check box to view all operations and 
tasks.

Include active ECN’s – Select the Include active ECN’s check box to include active engineering 
change notices in the report. Clear this check box to omit active ECN’s.

PDF Format – If you select Email in the View arrow, select the PDF Format check box to email 
the report as a PDF.

4 Click the View arrow to select how you would like to output the report. The choices are View, 
Print, File, and Email. Refer to the Infor VISUAL System-wide Guide for more information on 
outputting reports.

5 Click Ok. 

Check Availability
Use the Check Availability tool to assess potential bottlenecks to the completion of your project. To 
use the tool:

1 From the Project Window, open the project you want to print. 

2 Select File, Check Availability. 

The schedule ID, Work Order/Master to schedule, Release Date, Want Date, and Desired Qty 
fields are populated based on the project you are currently viewing in the Project Window.

3 In the Check Availability dialog box, select the information you would like to analyze.
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Schedule ID – Select the schedule for the project. You can set up schedule IDs in the Concurrent 
Scheduler window. Refer to the Infor VISUAL Manufacturing User’s Guide for more information.

Check Material Availability – Select the Check Material Availability check box to assess the 
material inventory for the project. Leave this check box blank if you do not want to consider 
material availability in scheduling the project.

Check Service Availability – Select the Check Service Availability to assess the availability of 
services you need to procure for the project. Leave this check box blank if you do not want to 
consider service capacity in scheduling the project.

Force Forward Schedule – Select the Force Forward Schedule check box to schedule the 
project for completion as soon as possible after the release date. 

Treat Release Date as Hard – Select the Treat Release Date as Hard check box if you know the 
exact release date you would like to use. Clear the check box if the release date can be changed. 
This check box may have been selected automatically based on your selections in the Schedule 
Current Project... window. For more information on scheduling current projects, refer to “Working 
with Project Inventory,” on page 4–3.

4 Click Schedule.... The project is scheduled and potential delays are identified.

5 To view the work orders associated with the project, click the Work Order Audit... button.

6 Click Close to exit the window.

Labor Ticket Table
The labor ticket table displays a list of the labor tickets associated with the project along with the total 
hours worked and total break hours. 

To view the labor ticket table:

1 In the Project Window, open the project you want to print. 

2 Select Info, Labor Tickets....

3 To output the report, select the view arrow to select the output method, then click the Print button. 
If you choose Email as the output option, select the PDF Format to email the information as a 
PDF.

Project Status Table
To view a summary of the project’s status:

 In the Project Window, open the project you want to print. 

Select Info, Project Status.... 

The Project Status window displays actual costs to date.
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Exploded Estimated Costs
The Exploded Estimated Costs window displays all estimated expenses for the project. To view the 
window:

1 In the Project Window, open the project you want to print.

2 From the Info menu, select Exploded Estimated Costs. 

The dialog box displays costs and hours for all operations, purchased parts, fabricated parts, and 
requirements. The dialog box also displays the total estimated costs and hours.

3 To limit the information shown in the Exploded Estimated Costs dialog box, select the View menu 
and click the type of information you would like to view. You can limit your view to operations only, 
purchased parts only, fabricated parts only, and requirements only.

4 To view additional detail in the window, select Display Estimated Cost Detail. The estimated 
unit, estimated material, estimated labor, estimated burden, and estimated service costs are 
shown. The window totals each of these columns.

5 Select Display Estimated Hours from the View menu to view the estimated set up hours and 
estimated run hours. Each of these columns are totaled in the dialog box.

6 Click the X button to close the dialog box.

Project Charges Under Review Report
Use the Project Charges Under Review report to assess outstanding transactions for projects that do 
not have a status of released. The report is particularly helpful when you are closing a project. It 
identifies transactions that need to be completed before closing the project.

To run the report:

1 In the Project Window, open the project you want to print.

2 From the Info menu, select Project Charges Under Review Report. 

3 In the Print dialog box, select the project or projects you would like to view in the report. To select 
a single project, enter the project ID in the Starting Project ID field, or click the Starting Project ID 
button to select the project from a browse table. To view a range of projects, enter the starting 
project ID in the Starting Project ID field and the ending project ID in the ending Project ID field. 
The report will contain information for the project IDs you specify and all project IDs in between.

4 Click the View arrow to select the output method for the report. The choices are View, Email, 
Print, and File. If you select Email, select the PDF format check box to email the information as a 
PDF.

5 Click Ok. 
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Project Maintenance Reports and Tools
The Project Maintenance window features several reports and tools that help you track your project’s 
budget. The reports and tools include:

• Project Info Report
• WBS Report

If the system administrator has set up auditing for certain project-related information, you can also 
view a history of changes to project information. 

Project Info Report
The Project Info Report displays basic information about your project. To output the report:

1 From the main menu, select Project, Project Maintenance.

2 From the File menu, select Print Project Info.... 

3 In the Project Info Report dialog box, click the Site ID (range) arrow and select the site(s) to use.

4 To specify a single project for the report, enter the same project ID in the Starting Project ID and 
Ending Project ID fields, or click the Starting Project ID button and Ending Project ID button to 
select the ID from a table. To view a range of projects, enter the starting project ID in the Starting 
Project ID field and the ending project ID in the Ending Project ID field. The report will contain 
information for the project IDs you specify and all project IDs in between.

5 Click the View arrow to select the output method for the report. The choices are View, Email, 
Print, and File. If you select Email, select the PDF Format check box to email the information as a 
PDF.

6 Click Ok. 

The report shows the project ID, project description, project type, customer, division, segment 
(business line), contract type, summary code, government related, and status.

WBS Report
The WBS report displays the WBS codes for your projects. To run a WBS report:

1 In the Project Maintenance Window, click the Site ID arrow and select the site to use for the 
report.

2 Select File, WBS. 

3 In the Print dialog box, select the information you would like to view in the report:

Current Project – If you selected a project in the Project Maintenance window, the Current 
Project button is active. Select the button to view information for the current project only.
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Range of Projects – To view information for multiple projects, select the Range of Projects 
option. When you select this option, the Starting Project ID and Ending Project ID fields become 
active. Click the Starting Project ID button and Ending Project ID button to select the range of 
projects you would like to view. To view a single project, enter the same ID in both the Starting 
Project ID field and Ending Project ID field.

Range of WBS Codes – To view information for selected WBS Codes only, select the Range of 
WBS Codes option. When you select this option, the Starting WBS and Ending WBS fields 
become active. Click the Starting WBS button and Ending WBS button to select the range of WBS 
codes you would like to view. To view a single WBS, enter the same ID in the Starting and Ending 
WBS fields. To view all WBS codes, leave the WBS fields blank.

4 If you chose By Project, the Starting Project ID and Ending Project ID fields become active. In the 
Starting Project ID field, enter the first Project ID you would like to view, or click the Starting 
Project ID button to choose a Project ID from a table. In the Ending Project ID field, enter the last 
project ID you would like to view, or click the Ending Project ID button to choose a Project ID from 
a table. To view a single Project ID, enter the same ID in the Starting and Ending Project ID fields. 
To view all Project IDs, leave the Project ID fields blank.

5 Click Ok. 

The report contains Project ID and description, Project Type, Customer, Division, Segment 
(Business Line), Project Status, WBS Code and description, and WBS Status. The report also 
indicates whether the project is government-related, and whether each WBS code is billable. 

Viewing Audit History
If you are auditing information in database tables related to customers, you can view a history of the 
changes made to a customer in the Audit History dialog. 

A system administrator must grant you permission to view this dialog. 

Use Audit Maintenance to set up the audit. See "Audit Maintenance" on page 5–1 in the System 
Administration guide.

Information is written to this dialog if you are auditing these database tables:

• PROJECT_INFO
• PROJECT_ETC
• PROJECT_EAC_POC
• PROJECT_CEILING

To view audit history information:

1 Select Project, Project Maintenance.

2 Open a project record.

3 Select Info, Audit History.

4 This information is displayed:

ID – The primary key of the database record that was changed.
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User ID – The ID of the user who made the change.

Date – The date that the change was made.

Field – The database table and column that was changed.

Old Value – The original value.

New Value – The new value.

Action – The action that occurred to update the date. These actions are used:

Insert – A new value was created.

Update – An existing value was changed.

Delete – A value was deleted. 

Exporting Audit Information
You can export Audit Information to Microsoft Excel or to an XML file. 

Exporting Audit Information to Microsoft Excel
To export the information to Microsoft Excel:

1 Select Project, Project Maintenance.

2 Open a project record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to Microsoft Excel. Microsoft Excel is opened, and the rows 
you selected are inserted in the spreadsheet.

Exporting Audit Information to XML
To export audit information to XML:

1 Select Project, Project Maintenance.

2 Open a project record.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to XML.

6 Specify this information:

File Name – Specify the name to use for the XML file.
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XML to Write – Specify the content to include in the file. Click one of these options:

Schema – Click this option to export the schema only. The XML structure is exported, but no 
information from the table is exported.

Document – Click this option to export the rows that you selected in the Audit History table in 
XML format. 

Both – Click this option to export both a schema file and a document file.

Tags – Specify the information to use for the XML tags. Click one of these options:

Use column name – Click this option to use the database column names for the tags.

Use item name – Click this option to use the column names as displayed in the Audit History 
table for the tags.

7 Click Export. 

Project Billing Entry Window Reports
Use the reports available in the Project Billing Entry window to view current, future, and past project 
bills. You can view run the Project Billing Events Report and the Order Invoice Status Report.

Project Billing Events Report
Run the Project Billing Events Report to review billing events for your projects. To run the report:

1 In the Project Billing Entry window, click the Site ID arrow and select the site for which to create a 
project billing events report.

2 If you want to view the Billing Events Report for a single order, enter the order ID you would like to 
view in the Order ID field. To view billing events for multiple orders, leave the Order ID field blank.

3 From the File menu, select Print Project Billing Events.... The Print Project Billing Events 
window appears.

If you selected an order ID in the Project Billing window, the ID and associated customer appear 
in the Order ID and Customer ID fields. If you did not select an order ID in the Project Billing 
window, the Order ID and Customer ID fields are blank

4 In the Starting Date and Ending Date fields, enter the date range you would like to view in the 
report. 

5 In the Show Events section, select the events you would like to view:

Future Billing Events – Select this check box to view events that are not yet eligible for billing, 
but will occur during the dates you specified in the Date fields.

Current Billing Events – Select this check box to view events that are currently eligible for billing.

Processed Billing Events – Select this check box to view events that have already been billed.
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6 In the Sequence section, select a sort order for your report. Select Order ID to view the report by 
order ID. Select Customer ID to view the report by customer ID. 

7 In the Customers section, select Current Customer to view information for the customer in the 
Customer ID field. Select All Customers to view information for all customers.

8 In the Orders field, select Current Order to view information for the order selected in the Order ID 
field. Select All Orders to view all orders. 

9 Click the output arrow to select the output method. Your choices are view, email, file, and print. If 
you select email, the PDF Format check box becomes active. Select the check box to email the 
report as a PDF.

10 Click Ok. 

The report includes the order ID, customer ID and name, Customer PO#, Order Date, Line #, Part 
ID, Customer Part ID, Order Quantity, Line Amount, Project ID, Customer Line Item Number, 
Event #, Event Description, Event Date, Invoice Date, Bill Amount, and Fee Amount. 

Order Invoice Status Report
Use the Order Invoice Status Report to view invoiced orders with G/L account distributions. To run the 
Order Invoice Status Report:

1 In the Project Billing Entry window, click the Site ID arrow and select the site for which to create 
an order invoice status report.

2 If you want to view the report for a single order, enter the order ID you would like to view in the 
Order ID field. To view billing events for multiple orders, leave the Order ID field blank.

3 From the File menu, select Print Order Invoice Status Report.... 

If you selected an order ID in the Project Billing window, the ID and associated customer appear 
in the Order ID and Customer ID fields. If you did not select an order ID in the Project Billing 
window, the Order ID and Customer ID fields are blank

4 In the Starting Date and Ending Date fields, enter the date range you would like to view in the 
report. 

5 In the Sequence section, select a sort order for your report. Select Order ID to view the report by 
order ID. Select Customer ID to view the report by customer ID. 

6 In the Customers section, select Current Customer to view information for the customer in the 
Customer ID field. Select All Customers to view information for all customers.

7 In the Orders field, select Current Order to view information for the order selected in the Order ID 
field. Select All Orders to view all orders. 

8 Click the arrow to select the output method. Your choices are view, email, file, and print. If you 
select email, the PDF Format check box becomes active. Select this check box to email the report 
as a PDF.

9 Click Ok. 



Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense | 6 – 39

The report includes the Order ID, Customer ID and Name, Customer PO#, Order Date, Ship On, 
Status, Order Amount, Line #, Part ID, Invoice ID, Invoice Date, Invoice Amount, Order Quantity, 
Line Amount, Work Order ID, G/L Account ID, G/L Description, Debit, and Credit.

Project Revenue Recognition Window Tools and Reports
Use the Revenue Recognition Transactions report to review recognized revenue and the 
corresponding G/L account distributions. To review past revenue recognition transactions for a 
project, use the Revenue History window. 

Revenue Recognition Transactions Report
To run the Revenue Recognition Transactions Report:

1 From the main menu, select Project, Project Revenue Recognition.

2 Select File, Print Transactions.... 

3 In the Print G/L Transactions dialog box, click the Standard tab, and specify this information:

Site ID – Click the Site ID arrow and select the site to use.

In the Print Selection section, select the information you would like to view in the report. Your 
choices are:

By Accounting Period – Select By Accounting Period to review transactions that occurred 
during a specific accounting period. If you select By Accounting Period, click the Calendar button 
to select a date within the accounting period you would like to view. The date is adjusted to the 
last date of the accounting period. 

By Transaction ID – To review a specific transaction or set of transactions, select By 
Transaction ID. When you select By Transaction ID, the Starting Transaction ID and Ending 
Transaction ID fields become available. Click the Starting Transaction ID button to select the 
first ID in the range of transactions you would like to view. Click the Ending Transaction ID 
button to select the last ID in the range of transactions you would like to view. Information for the 
transactions IDs you selected and all transaction IDs in between are outputted.

To view a single transaction, enter the same ID in the Starting Transaction ID and Ending 
Transaction ID fields. To view all transactions, leave the Starting Transaction ID and Ending 
Transaction ID fields blank.

By Project ID – To review transactions associated with a specific project or set of projects, select 
By Project ID. When you select By Project ID, the Starting Project ID and Ending Project ID fields 
become available. Click the Starting Project ID button to select the first ID in the range of 
projects you would like to view. Click the Ending Project ID button to select the last ID in the 
range of projects you would like to view. Information for the Projects IDs you selected and all 
Project IDs in between are outputted.

To view a single Project, enter the same ID in the Starting Project ID and Ending Project ID fields. 
To view all projects, leave the Starting Project ID and Ending Project ID fields blank.
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4 Click the Advanced tab, and specify this information:

Report Calendar ID – Click the Report Calendar ID arrow and select the calendar you want to 
use for this report.

Fiscal Year – Click the Fiscal Year calendar button and select the fiscal year for which to create 
this report.

Site ID(s) – Click the Site ID(s) arrow and select the site(s) to use for this report.

5 In the Report Currency field, click the arrow to select the currency for the report.

6 In the Sequence section, select the sort order for the report. Your choices are:

Transaction ID, G/L Account ID – Select Transaction ID, G/L Account ID to sort the report first 
by Transaction ID, then by G/L Account ID.

Type, Project ID, Transaction ID – Select Type, Project ID, Transaction ID to sort the report by 
Revenue Recognition Type, then by Project ID, then by Transaction ID.

Project ID, G/L Account ID – Select Project ID, G/L Account ID to sort the report first by Project 
ID, then by G/L Account ID. This option is available only if you selected By Project ID in the Print 
Selection section.

Project ID, Type, Transaction ID – Select Project ID, Type, Transaction ID to sort the report by 
Project ID and Revenue Recognition Type, then by Transaction ID. This option is available only if 
you selected By Project ID in the Print Selection section.

7 In the Transactions section, select Posted Transactions to view transactions that have been 
posted to the general ledger. Select Unposted Transactions to view transactions that have not 
yet been posted to the general ledger.

8 In the View field, click the arrow to select the output method for the report. Your choices are View, 
Print, Email, and File. If you select Email, the PDF Format check box becomes active. Select the 
check box to email the report as a PDF.

9 Click Ok. 

The report shows Transaction Type, Project ID (if viewing by project ID), Transaction ID, 
Transaction Description, Posting Date (if viewing posted transactions), G/L Account ID, G/L 
Account Description, Debit amount and Credit amount.

Revenue History Window
To review the information in the revenue history window:

1 In the Project Revenue Recognition window, click the Site ID arrow and select the site in which 
the project was created.

2 Click the Project ID button to select the project you would like to review information for. The 
Project ID and associated information appear in the Project Revenue Recognition window.

3 From the Info menu, select Revenue History. The Revenue History window appears.

4 Information appears in the following fields:
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Transaction ID – The ID of the revenue recognition transaction appears in the Transaction ID 
field.

Transaction Date – The date of the transaction appears in the Transaction Date field.

Posted – If the transaction has posted to the general ledger, a check box appears in the Posted 
field. If the transaction has not yet been posted, the check box is clear.

Posted Date – If the transaction has been posted, the date that the transaction was posted to the 
general ledger appears in the Posted Date field.

Revenue Type – The revenue recognition type appears in the Revenue type field.

POC Percent – For percentage of completion revenue recognition types, the percentage of 
completion that triggered the revenue recognition event appears in the POC Percent field. 

EAC ID – The ID of the current EAC appears in the EAC ID field. 

Packlist ID – If this transaction resulted from a shipment, the Packlist ID appears.

Packlist Line Number – If this transaction resulted from a shipment, the packlist line number that 
triggered amount appears.

Order ID – The order ID associated with the transaction.

Billing Event – The billing event amount appears.

Revenue Amount – The actual amount of this revenue.

CGS Amount – The Cost of Goods (CGS) amount appears.

Profit/Fee Amount – The profit or fee amount appears.

Profit/Fee Percent – If the profit or fee for the project is based on a percentage, the percentage 
appears.

Description – If you entered any descriptions for this transaction, they appear in the Description 
column.

5 Click Close to exit the window.

WIP Balance Inquiry / Report for Projects
Use the Work In Process (WIP) Balance Inquiry for Projects from the Post Manufacturing Journal 
window to review your Work In Process balances for a specified period. You can use this report to 
reconcile your WIP balances after closing a period. You can use the inquiry window to print a WIP 
Balance report or view the information in a table within the inquiry window.

Accessing the WIP Balance Inquiry for Projects Window
From the main menu, select Ledger, Post Manufacturing Journals. 

In the Post Manufacturing Journals window, select Reports, Project WIP Balances. 
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Running the WIP Balance Inquiry
To run a query:

1 Click the Site ID arrow and select the site to use.

2 In the End Date of Accounting Period field, enter any date within the accounting period you would 
like to view, or click the Calendar button to select a date. The date is adjusted to the last date of 
the period and determines the Fiscal Period. 

3 In the Report Currency field, enter a currency by clicking the arrow and selecting a currency. You 
can choose from the system currency or any tracking currency.

4 In the Status section, select the Released Only check box to view information for projects that 
have been released. Clear the check box to view all projects.

5 Select a sequence in the Sort section. The fields in the window change depending upon the sort 
order you choose. The inquiry or report is sorted by the sequence you choose. Your choices are:

• G/L Account ID
• Project ID
• Project Type

6 If you selected G/L Account ID in the Sort section, enter information in the following fields:

Starting Account ID and Ending Account ID – Click the Browse button to select a starting 
account ID and an ending account ID, or enter account IDs in the Account ID fields. The report 
displays information for all the accounts that fall within the range you specify. To print all accounts, 
leave these fields blank.

Starting Project ID and Ending Project ID – Click the Browse button to select a starting project 
ID and an ending project ID, or enter project IDs in the project ID fields. The report displays 
information for all the accounts that fall within the range you specify. To print all projects, leave 
these fields blank.

If you selected Project ID in the Sort section, enter information in the following fields:

Starting Project ID and Ending Project ID – Click the Browse button to select a starting project 
ID and an ending project ID, or enter project IDs in the project ID fields. The report displays 
information for all the accounts that fall within the range you specify. To print all projects, leave 
these fields blank.

If you selected Project Type in the Sort section, enter information in the following fields:

Starting Project Type ID and Ending Project Type ID – Click the Browse button to select a 
starting project type ID and an ending project type ID, or enter project type IDs in the Project Type 
ID fields. The report displays information for all the project types that fall within the range you 
specify. To print all project types, leave these fields blank.

7 In the Mode section, select Inquiry Only to view the results of your query in the table. Select 
Report Only to output the results of your query as a report.

8 If you select Inquiry Only in step 6, the results of the query appear in the table when you click Ok. 

If a plus sign appears in the Sum column, you can double click the row header (the gray box at 
the beginning of each row) to view more detailed information. You can continue to drill down to 
individual transactions. 
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9 If you select Report Only in step 6, select the output for the report. You can choose Print, View, 
File, or Email. 

10 Select the type of report you would like to view. You can view a summary report, summary with 
sub-totals report, or a detailed report with or without burden detail.

Summary – Select Summary to output a summary report. The summary report by G/L account 
displays the G/L account ID, the account description, the total debit amount, and the total credit 
amount. The summary reports by project or project type shows the project ID or project type ID, 
project or project type description, status, type, material cost, labor cost, burden cost, service 
cost, and total value.

Detail – Select Detail to view a detailed report. Detailed reports show all of the transactions by 
type flowing in and out of the G/L accounts. The information includes transaction ID, transaction 
date, project ID, and project summary ID along with the debit and credit amount for each line item. 
Detailed reports by project show all the transactions by type for each project. Transactions include 
purchased materials, WIP issues, WIP labor, vouchers, and inventory adjustments. Detailed 
reports by project type show the same information as detailed reports by project ID, only the 
transactions are shown by project type. 

Summary with Sub-Totals Report – Select Summary w/Sub-Totals to output a Summary with 
Sub-Totals Report. The summary with sub-totals reports show the same information as the 
summary reports, but the information in broken down by transaction.

Detail with Burden Detail – You can only print detailed reports with burden detail for project IDs 
and project types. The reports show the same information as the detailed reports, but burden 
costs are broken down by burden category ID.

11 Click the Ok button to output the information. Click the Close button to exit the dialog box without 
printing the report. Click the Print Setup button to modify printer options.

Sending Data to Microsoft Project
Use VISUAL’s Microsoft Project Interface window to export data to and import data from Microsoft® 
Project™. After you have set up your project and exported its data to Microsoft Project, you can add 
task dependencies and change critical task information as you need, then import that new information 
back to VISUAL and save the project as a baseline.

By using VISUAL and Microsoft Project to prepare your project plans, you can extend your ability to 
provide detailed project information to your customers and any non-VISUAL users.
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The following picture depicts the informational links between VISUAL and Microsoft Project:

You can access VISUAL’s Microsoft Project Interface window from either the Project Summary 
window (File menu) or the Project Window (Send to Microsoft Project button).

There are three basic steps to exporting your VISUAL project information:

1 Set up your project with correct work breakdown structure.

2 Establish a budget for your project and assign cost categories to your tasks.

3 Transfer data to Microsoft Project.

Setting up Microsoft Project
In order for your VISUAL information to appear in Microsoft Project in the same format, you must 
perform the following steps within Microsoft Project:

1 Using Windows® Explorer or My Computer, copy the VE Template.mpp file from your VISUAL 
CD-ROM to an accessible directory on your local drive.

2 Double-click on the VE Template.mpp file so that Microsoft Project automatically starts and opens 
the VE Template.mpp file.

3 Select Organizer from the Tools menu. In Project 2007 and later, select File, Info, Organizer.

4 Click the View tab. Copy the VE Gantt from the VE Template.mpp list to the Global.mpp list by 
selecting VE Gantt in the VE Template.mmp list and clicking the Copy button.

5 Click the Tables tab.

6 Select the Task option button.

7 Copy VMEnt-Gantt from the VE Template.mmp list to the Global.mpp list by selecting VMEnt-
Gantt and clicking the Copy button.

8 Select the Resource option button.

9 Copy VisEnt-Res from the VE Template.mpp list to the Global.mpp list by and selecting VisEnt-
RES and clicking the Copy button.

10 Click the Close Window button in the top right corner of the Organizer window.

VISUAL Enterprise Microsoft project

Input all data required
WBS—

WBS Tasks—
Cost Categories—

Actuals & EV—

Data required
—Project ID information
—Leg and task information
—Duration
—Project Resource Pool

(Cost Categories)

Iterate to validate data and
balance against capacity

Validate input and planning
Baseline and save for export

Iterate as needed to manage

Project verifies information,
Plans tasks and
Produces a schedule

Export Required Data

Export Planned Values
(BCWS)



Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense | 6 – 45

11 Select Options from the Tools menu. In Project 2007 and later, select File, Options, General and 
Project View tab.

12 On the View tab, click the Default View arrow and select VE Gantt.

13 Click the OK button.

Information in Microsoft Project now appears in the same format as in VISUAL.

Exporting Data to Microsoft Project
Use the VISUAL - Microsoft Project Interface window to export your project information to Microsoft 
Project.

To export your project information:

1 In either the Project window or the Project Summary window, click the Site ID arrow and select 
the site to use.

2 Click the Project ID browse button and select the project you want to send to Microsoft Project.

3 From the File menu, select Send to Microsoft Project.

4 Click the Send to MS Project button.

The appropriate data is sent to Microsoft Project which creates a new MS Project file and 
populates it with your VISUAL project information.

If you have previously sent this project’s information to Microsoft Project, a dialog box is displayed 
alerting you that the project already exists. 

If you want to open the existing file in Microsoft Project and import the information back into your 
VISUAL project, click the Yes button.

If you want to open the existing file in Microsoft Project so that you can view the information, click 
the No button.

If you want to cancel the operation and close the dialog box, click the Cancel button.

5 In Microsoft Project, click the Save button on the toolbar.

Manipulating Data in Microsoft Project
The main reason for using Microsoft Project—rather than VISUAL—to schedule your projects is if you 
have structured your projects such that tasks from different WBS's are interrelated, Microsoft Project 
allows you to link tasks across multiple WBS's. In addition to linking your tasks, you can also 
manipulate other task related information. For example:

• Change the Calendar Duration in the Duration Column
• Change the allocation of a Cost Category [Resource] to a task
• Add or delete Cost Categories [Resource] as long as the Cost Category [Resource] is on the

Resource Sheet. 
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Note: You must also make sure that any Cost Category added also has a valid Department ID 
[Group] associated with it on the Resource Sheet. 

You should not do any of the following:

Add or delete a task to the WBS – You must do this in VISUAL.

Performing this operation will result in the following error message when you transfer data back to 
VISUAL, “The number of tasks imported from Microsoft Project is unequal to the number of tasks from 
Visual Manufacturing. Unable to save data from Microsoft Project.”

Add a new Cost Category – You must do this in VISUAL.

Performing this operation will result in the following error message when you transfer data back to 
VISUAL, “Cost Category XXXX not found in Visual Manufacturing. Unable to save the data from 
Microsoft Project.”

Importing Data from Microsoft Project
Use the VISUAL - Microsoft Project Interface window to import information you have modified from 
Microsoft Project.

To import the changes you made in Microsoft Project back into VISUAL:

1 In either the Project window or the Project Summary window, click the Site ID arrow and select 
the site to use.

2 Click the Project ID browse button and select the project you want to send to Microsoft Project.

3 From the File menu, select Send to Microsoft Project.

The VISUAL - Microsoft Project Interface appears populated with the data from the project you 
previously opened.

4 Click the Get from MS Project button.

Microsoft Project is started, the appropriate project file is opened, and your project information is 
imported. The project data is populated on the right side of the Microsoft Project Interface window.

5 Click the Save button.

6 In the VISUAL Enterprise Updated Data Report dialog box, select the method you want to use for 
viewing the changes to your project by clicking the arrow and making your selection.

If you want to print the VM Project Update Report, select Print.

If you want to view the VM Project Update Report, select View.

If you want to save the VM Project Update Report to a file, select File. You are prompted for 
where you want to save the report.

If you want to e-mail the VM Project Update Report, select E-mail. Your e-mail client is opened 
and the report is attached to that e-mail.

7 Click the Ok button.

Your project is updated with the changes you have made in Microsoft Project.
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8 When you have finished importing data, click the Close button.

You are prompted to select an option to handle the active Microsoft Project file.

To save the Microsoft Project file, with or without a baseline, click Yes.

To close Microsoft Project without saving any changes, click No.

To keep Microsoft Project open, click Cancel.

Note: To view your imported data, refresh the Project Window or Project Summary Window.
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Chapter 7: Maintaining ETCs and EACs

Use Estimates to Completion (ETCs) and Estimates at Completion (EACs) to track the progress of 
your projects. Use ETCs to determine the hours and costs required to complete the project. Use 
EACs to determine the total anticipated hours and costs for the entire project. You can enter ETCs 
and EACs manually or let the system update them for you.

This chapter includes:

Topic Page

Setting Up Automatic Numbering for ETCs and EACs ................................................................... 7–1
Initializing ETCs .............................................................................................................................. 7–2
Manually Creating Estimate to Complete Figures .......................................................................... 7–2
Manually Creating Estimates at Completion................................................................................... 7–5
Updating ETCs with Actual Costs ................................................................................................... 7–7

Setting Up Automatic Numbering for ETCs and EACs
The system automatically numbers your ETC and EAC versions. To customize the auto-numbering, 
use the Automatic Numbering - ETC and EAC Versions window.

1 From the Project Summary Window, select Edit, Auto Numbering. 

2 In the Automatic Numbering - ETC and EAC Versions dialog box, click the EAC Version tab and 
enter information in the following fields:

Initial Sequence Number – Enter the number for the first EAC. The system inserts 1 in this field 
by default. The sequence number you specify is the starting number for each project. For 
example, the first EAC you create for Project A will be the number you enter in the Initial 
Sequence Number field. The first EAC you create for Project B will also be the number you enter 
in the field. 

Alphanumeric Prefix – If you would like to add a prefix to the version number, enter the prefix 
you would like to use in this field. Please note that the system does not automatically insert a 
hyphen or other separation character after the prefix. If you would like to use a character to 
separate the prefix from the number, you must include it as part of the prefix.
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Alphanumeric Suffix – If you would like to add a suffix to the version number, enter the suffix you 
would like to use in this field. Please note that the system does not automatically insert a hyphen 
or other separation character before the suffix. If you would like to use a character to separate the 
suffix from the number, you must include it as part of the suffix.

Number of Decimal Digits and Show Leading Zeroes – If you would like your EAC versions to 
be a certain number of digits long, enter the number in the Number of Decimal Digits field. Select 
the Show Leading Zeroes check box if you would like the system to display leading zeroes 
before version numbers that have fewer digits than specified in the Number of Decimal Digits. For 
example, if you enter a 2 in the Number of Decimal Digits field and select the Show Leading 
Zeroes check box, then EAC version 1 will display as EAC version 01.

Note: Entering a digit in the Number of Decimal Digits field does not limit the number of EACs you 
can create. For example, if you enter a 2 in the Number of Decimal Digits, the system will not 
prohibit you from having more than 99 EAC versions.

3 To enter numbering information for ETCs, click the ETC Version tab. Enter information in the 
fields described above.

4 When you are finished entering EAC and ETC numbering information, click Save.

Initializing ETCs
You create the first ETC when you create the budget. The initial ETC is identical to the information 
found in the budget. For more information on creating the first ETC, refer to “Initializing Estimate to 
Complete Figures,” on page 3–39.

Manually Creating Estimate to Complete Figures
As you complete the work on your projects, you may want to revise the estimated time and cost to 
complete figures for the remaining project tasks. To initialize a project’s first Estimate to Complete 
figures, you must do so from the Budget Maintenance window.

To enter Estimate to Complete (ETC) figures:

1 Open the Project Summary window, click the Site ID arrow and select the site for which to create 
estimate to complete figures.

2 From the Maintain menu, select ETC....

3 In the Maintain ETC window, click the Project ID button and select the project for which you want 
to calculate Estimate to Complete figures.

The Rate ID automatically appears.

4 In the ETC Version field, enter the ID you would like to use for the ETC, or leave the field blank to 
allow the system to populate the field based on the settings in the Auto Numbering - EACs and 
ETCs window. For more information, refer to “Setting Up Automatic Numbering for ETCs and 
EACs,” on page 7–1. 



Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense | 7 – 3

5 Enter the date for the ETC version in the Version Date field, or click the Calendar button to select 
a date.

6 If the ETC has been linked to a formal EAC, the ID of the linked EAC appears in the Linked EAC 
Version field.

7 If you want to specify a range of WBS Codes for this calculation, click the Starting WBS button 
and select the code on which you want calculations started. Click the Ending WBS Code button 
and select the code on which you want calculations ended.

8 Select the following check boxes as appropriate:

Locked – Select the Locked check box if you do not want to allow any changes to the ETC 
version. When you select the Locked check box, the Delete Row and Insert buttons are inactive. 
The system selects the Locked check box if the linked EAC is locked.

Current Version – Select the Current Version check box to designate the ETC as the actively 
used version. If you previously marked another ETC version as the current version, the system 
clears the Current Version check box on the previous version when you select a new current 
version.

Baseline – The system selects the Baseline check box if the EAC linked to the ETC is the 
baseline version. The system maintains this check box; you cannot select it or clear it.

9 In the upper pane, select the WBS for which you want to change estimated costs. The current 
estimated and actual costs appear in the lower pane.

10 Use the scroll bar to locate the fiscal period to which you want to add costs. If the appropriate 
fiscal period does not appear in the lower pane, use the Insert Start Period and Insert End 
Period buttons to add periods to the table.

11 Click in the corresponding column for the information you want to add and enter the amount or 
number of hours for your new estimated costs.

12 Click the Save button.

The Estimate to Complete figures are calculated for the project you selected and the Project 
Summary window is populated with the results.

13 When you have finished working with this ETC, click the Close button.

Adding Detail Rows to ETCs
To add a new detail row for which you want to estimate costs:

1 With the Maintain ETC window open and the appropriate project selected, click the WBS code to 
which you want to add a new cost.

2 Click the Insert Row button.

3 Double-click the Dept ID button and select the department you want to use.

4 Double-click the Cost Cat ID button and select the category you want to use.

5 Scroll to the period to which you want to add the cost, and add the cost you want.
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6 Click the Save button.

7 When you have finished adding costs to this project’s ETC, click the Close button.

Deleting Detail Rows from ETCs
To delete a detail row from an ETC:

1 With the Maintain ETC window open and the appropriate project selected, click the WBS code 
that contains the department you want to delete.

2 Click the Delete Row button.

An X appears in the row header to indicate you have marked the department for deletion.

Note: Because the row is not deleted until you click the Save button, you can un-mark the row by 
clicking the Delete Row button again.

3 Click the Save button.

4 When you have finished deleting departments for this project ETC, click the Close button.

Recalculating ETCs with Different Rates
Because it is important for you to be able to predict how a project’s costs change, you can recalculate 
your projects Estimate to Complete costs using different rates.

To recalculate ETCs:

1 With the Maintain ETC window open and the appropriate project selected, click the Rate ID button 
and select the rate you want to use.

2 Click the Apply New Rates to ETC button.

The Project’s ETC figures are recalculated based on the new rate you selected. The system 
displays a dialog box informing you that the new rates have been applied to the ETC records. 

Only ETCs for the project you selected are calculated, if you want to recalculate ETCs for all of 
your projects, you must do so in the Rate Maintenance window. For more information on Rate 
Management, refer to “Setting Up Information in the Rate Management Window,” on page 2–20.

Editing an Existing ETC
Note: While the system allows you to edit an existing ETC, we strongly urge you to create a new 
ETC version when you change the ETC. Creating a new version allows you to keep track of the 
history of changes. 

To edit an existing ETC:
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1 In the Maintain ETC window, click the Project ID button to select the project associated with the 
ETC you would like to edit.

2 Click the ETC Version button to select the version you would like to edit.

3 Edit the ETC as necessary. For more information on the fields you can edit, refer to “Manually 
Creating Estimate to Complete Figures,” on page 7–2. 

Note: If the Locked check box is selected, you cannot edit the ETC

4 When you are finished editing the ETC, click the Save button.

Creating a New ETC from an Existing ETC
If you would like to create a new ETC for a project that is identical to an existing ETC for the same 
project, you can use the Copy To... function. You can then update the new ETC as necessary.

1 In the Maintain ETC window, click the Project ID button to select the project associated with the 
ETC you would like to copy.

2 Click the ETC Version button to select the ETC you would like to copy.

3 Click the Copy To... button. 

4 In the Copy to ETC Version, enter the ID you would like to use for the new version. Leave the field 
blank if you would like the system to generate an ETC version ID based on the settings in the 
Auto Numbering - EACs and ETCs window. For more information, refer to “Setting Up Automatic 
Numbering for ETCs and EACs,” on page 7–1. 

5 Click Save. The system opens the new ETC in the Maintain ETC window.

Manually Creating Estimates at Completion
During the life of your project, you may find it valuable to create multiple EACs to track the history of 
anticipated hours spent and costs. You create the first EAC as part of the project creation process. 
For more information on creating the first EAC, refer to  “Entering the Initial Formal Project Estimate 
at Completion and Target Costs Information” on page 3–54.

The system uses the formal EAC to determine the project’s percentage of completion.

To create additional EACs:

1 In the Project Summary Window, click the Site ID drop-down and select the site for which to 
create additional EACs.

2 Select Maintain, EAC/Target Costs.

3 In the EAC/Target Costs dialog box, click in the EAC Version field and enter the version number 
you want to enter for the project, or leave the field blank if you would like the system to 
automatically number the EAC based on the settings in the Auto Numbering - EACs and ETCs 
window. For more information, refer to “Setting Up Automatic Numbering for ETCs and EACs,” on 
page 7–1.
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4 Click the Calendar button and enter the date for this version.

5 Click the Linked ETC Version button to select the ETC you would like to link to this EAC. When 
you link an ETC to an EAC, information from that ETC populates portions of the table in the lower 
half of the window, providing the information you need to update the EAC. 

6 Select the following check boxes as necessary:

Lock – Select the Lock check box if you would like to prevent changes to the EAC. The system 
selects this check box automatically if the EAC has been used in a revenue recognition 
transaction.

Current Version – Select the Current Version check box if this is the actively used EAC for the 
project. If you selected the Current Version check box for a previous EAC, the system warns you 
that changing the current EAC will cause any revenue previously recognized to be reevaluated. 
Please carefully consider whether you want to designate the new EAC to be the current EAC 
before proceeding. 

Baseline – Only the first EAC may be designated the baseline EAC.

7 You can insert the figures from the informal EAC. Click the Init from Informal EAC button. The 
system will transfer the figures from the informal EAC in the Project Summary window to the 
formal EAC.

8 The following read-only information appears in the table:

Current Actual Amounts – All actual costs charged to the project appear in the Actual Costs 
column. 

Actuals for Linked ETC Amounts – All actual costs associated with the linked ETC appear in 
this column. 

Linked ETC Amounts – The amounts entered in the ETC you linked to the EAC appear in this 
column.

Linked Informal EAC Amounts – If you clicked the Init from Informal EAC button, the amounts 
from the Informal EAC appear in this column.

9 Enter information in the following columns to complete the EAC:

Current Formal EAC w/o Reserve – Click in the Current Formal EAC w/o Reserve column to 
adjust the amounts for hours, labor, material ODC, burden w/o COI (cost of investment) and COI 
(cost of investment). As you enter figures, the total amount appears in the Project Totals row and 
in the Target Cost field in the Summary tab.

Reserve Amounts – Click in the Reserve column to enter reserve amounts. for hours, labor, 
material ODC, burden w/o COI (cost of investment) and COI (cost of investment). As you enter 
figures, the total amount appears in the Project Totals row and in the Target Cost field in the 
Summary tab.

10 After you enter information in the Current Formal EAC w/o Reserve and Reserve Amounts fields, 
the system adds the amounts in the two fields to calculate the Formal EAC with Reserve amount.

11 Click the Summary tab to view the Target Cost, Target Price, Target Profit/Fee Amount and Target 
Profit/Fee Percent amounts for the contract. You enter this information in the Contractual 
Financial Information window. For more information, refer to  “Step 2 – Entering Contract 
Financial Information” on page 3–47.
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12 Click the Detail tab to view the contract modification ID, the contract type, and the project type. 
You enter the contract modification ID, contract type, and project type in Project Maintenance. For 
more information, refer to  “Entering Information in the Project Maintenance Window” on page 3–
40.

13 Click the Save button.

14 When you have completed creating the initial EAC, click the Close button.

Updating ETCs with Actual Costs
To apply current costs to your ETC(s), run the Update ETC with Actuals utility. When you run the 
utility, the system creates a new ETC for your project so you can keep a record of the changes to the 
ETC. You can also create new EACs based on the actual costs. You can run the utility for a single 
project, all projects, or a selection of projects. 

Updating ETCs with actual costs cannot be undone.

To update ETC with actuals:

1 From the Project Summary window, select Edit, Update ETC with Actuals. 

2 In the Update ETC with Actuals dialog box, click the Site ID arrow and select the site to use. 

3 Click the Project Info browse button to select the project ETC(s) you would like to update.

You can select projects based on Project ID, Project Type, Business Line, Division, Customer, 
Contract Administrator, Program Manager, and Financial Analyst. Click the tab for the filter you 
would like to use, click the IDs you would like to use in the Available section, then click the 
Include button to move the IDs to the Selected section. You can also double-click an ID to move 
it to the Selected section. You can use one filter or multiple filters, if you choose. When you are 
finished selecting project filters, click the Ok button.

If you would like to update ETCs for all of your projects, do not make any selections in the Project 
Info Filters dialog box.

4 In the Start Period field, enter any date in the period you want to update. The field is populated 
with the first day of the period. In the End Period field, enter any date in the period you are 
updating. The field is populated with the end date of the period.

5 Select from the following options:

Mark new ETC versions as current – Select this option if you would like the system to designate 
the new ETCs it creates as the current versions.

Create new EAC versions – Select this option if you would like to create new EACs in addition to 
the new ETCs. If you select this version, the system will create an EAC based on the informal 
EAC figures in the Project Summary window.

Mark new EAC versions as current – Select this option if you would like the system to designate 
the new EACs it creates as the current versions. 

Note: If you select the Mark new EAC versions as current check box, any percentage of 
completion calculations will be based on the new EAC. This may have an impact on projects that 
use percentage of completion as the billing basis.
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6 Click the Save button. The system informs you that the ETC was updated and EAC versions were 
created.
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Chapter 8: Period-End Closing Procedures

This chapter explains how to close a financial period using Projects/A&D. Use this information as a 
starting point to develop your company’s closing process. While following the steps described below 
will lead you to a successful close, please feel free to alter the steps as necessary to fit your 
company’s specific needs.

This chapter includes:

Topic Page

Overview......................................................................................................................................... 8–2
Step One: Enter All Manufacturing and Financial Transactions for the Period ............................... 8–2
Step Two: Run Reports and Utilities to Assess What Will Be Costed for Commercial Transactions8–4
Step Three: Run Costing Utilities and Prepare Manufacturing Journals....................................... 8–10
Step Four: Post Manufacturing Journals ...................................................................................... 8–10
Step Five: Re-run Costing Utilities and Post Manufacturing Journals .......................................... 8–10
Step Six: Analyze Project Summary Window Information ............................................................ 8–12
Step Seven: Update Formal EACs and ETCs .............................................................................. 8–13
Step Eight: Complete Project Billing and Progress Billing Manufacturing Invoicing ..................... 8–15
Step Nine: Process Project Revenue Recognition ....................................................................... 8–15
Step Ten: Reconciling the Balance Sheet..................................................................................... 8–17
Step Eleven: Close the Period...................................................................................................... 8–18
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Overview
Closing can be completed in twelve steps:

Step One: Enter All Manufacturing and Financial Transactions for the Period

Step Two: Assess the Transactions that Will Be Costed

Step Three: Run Costing Utilities and Prepare Manufacturing Journals

Step Four: Post the Manufacturing Journals

Step Five: Re-run Costing Utilities and Prepare and Post the Manufacturing Journals

Step Six: Conduct Project Summary Analysis

Step Seven: Update Formal EACs and ETCs for Your Projects

Step Eight: Complete Project Billing and Manufacturing Invoicing

Step Nine: Process Revenue Recognition

Step Ten: Reconcile Commercial and Project Transactions

Step Eleven: Close the Period

This chapter describes each step in detail. Many steps involve running reports; if you are not familiar 
with how to run each report, consult the Helpful Reports section. 

Step One: Enter All Manufacturing and Financial 
Transactions for the Period
Before you can close your books for the month, make sure all manufacturing and financial 
transactions for the period have been entered and properly processed. 

Consult with the co-workers who are responsible for entering transactions to ensure that all 
transactions have been entered and posted.

Many reports are featured in VISUAL that can help you analyze the transactions that have been 
entered for the period and can help alert you to transactions that have not yet been properly 
processed.

Below is a list of transactions that need to be completed, along with the reports that can help you 
assess the transactions’ statuses. A detailed description of how to run each report can be found in the 
Helpful Reports appendix. The manufacturing transactions include:

Shipments - The Pack Lists report run by actual ship date shows the shipments that have been 
processed during the period. For more information, refer to “Pack List Report,” on 
page Appendix–2. 

To view shipments that are scheduled to be shipped (but have not been shipped yet), run the 
Customer Shipping/Delivery report. For more information, refer to “Shipping/Delivery Report,” on 
page Appendix–2. 

A/R Manufacturing Invoice – The Customer Sales Journal report shows all invoiced orders. For 
more information, refer to “Customer Sales Journal Report,” on page Appendix–3.
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You can also view shipments eligible for invoicing by selecting File, Print One Invoice from the 
Invoice Forms window. For more information, refer to “Print One Invoice,” on page Appendix–4.

Project Billing – To review the transactions that have been entered and processed, run the 
Project Billing Events report. For more information, refer to “Project Billing Events Report,” on 
page Appendix–4.

You can also run the Order Invoice Status report to review transactions. For more information, 
refer to “Order Invoice Status Report,” on page Appendix–4.

Purchase Receipts – To review purchase receipts, run the Receiving report twice: once to review 
actual receipts for the month and a second time to review scheduled receipts. For more 
information, refer to “Receiving Report,” on page Appendix–5.

Inventory Transactions - To review inventory transactions for the month, run the Inventory 
Transactions report. For more information, refer to “Inventory Transactions Report,” on 
page Appendix–5.

Labor Reporting - To review the labor tickets that have been entered for the month, print a Labor 
Ticket report. For more information, refer to “Labor Tickets,” on page Appendix–6.

The financial transactions that should be entered and posted include:

A/R Invoices - To review the A/R invoices entered for the month, run the Accounts Receivable 
Invoice Register. For more information, refer to “A/R Invoice Register,” on page Appendix–7. 

Run the Gross Profit report to view sales and costs for customer orders. For more information, 
refer to “Gross Profit Report,” on page Appendix–8.

A/R Cash Receipts – Run the Cash Receipts report to assess cash received for the period. For 
more information, refer to “Accounts Receivable Cash Receipts,” on page Appendix–9.

A/P Invoices - To make sure that invoices have been entered for all purchase receipts for the 
month, run the Uninvoiced Receivers report. For more information, refer to “Uninvoiced Receipt 
Report Detailed,” on page Appendix–10.

A/P Payments – Run the Payment Register to review cash disbursements for the period. For 
more information, refer to “Payment Register,” on page Appendix–10.

General Journal Adjustments, including Recurring General Journals and Allocations – 
Execute and post any Recurring General Journals, GL Allocation Entries, General Ledger 
Transactions.

Cash Book Adjustments – Verify cashbook reconciliations from the prior period are entered and 
posted. 

All Revenue Recognition Transactions – The Revenue Recognition Transactions report shows 
details of your revenue recognition transactions for projects. For more information, refer to 
“Revenue Recognition Transactions Report,” on page Appendix–11.

The Deferred Revenue report shows revenue recognition transactions for the period. For more 
information, refer to “Deferred Revenue Report (Commercial Revenue Recognition),” on 
page Appendix–12. 

For commercial transactions, run the Milestone Status Report to review progress billings that are 
ready to be triggered. For more information, refer to “Milestone Status Report,” on 
page Appendix–13.
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Step Two: Run Reports and Utilities to Assess What Will Be 
Costed for Commercial Transactions
There are several reports you can run to help you identify the transactions that will be costed. When 
you run these reports, be sure to retain a copy so that you can compare anticipated costs to actual 
costs.

The reports you should run are:

Inventory Valuation Report – Run the Inventory Valuation Report to view a break down of the 
total value for all parts in your current inventory. You should run the report twice: once to review 
project transactions and once to review commercial transactions. We recommend running the 
report showing cost layer detail. You may find it helpful to sort the project Inventory Valuation 
Report by Warehouse ID, since Warehouse IDs are identical to Project IDs. For more information, 
refer to “Inventory Valuation Report,” on page Appendix–13.

Work In Process Posted Valuation – To view the actual posted costs for your work in process, 
run the Work in Process Posted Value report. Make sure you run the report using the posted 
value of the transactions. For more information, refer to “Work In Process Posted Value,” on 
page Appendix–14.

Labor Ticket Report – To review the labor tickets that have been entered for the month, print a 
Labor Ticket report. For more information, refer to “Labor Tickets,” on page Appendix–6.

General Journal Report – To review all general journal transactions, run the General Journal 
report. For more information, refer to “General Journal Report,” on page Appendix–14.

Costing Tools – Use the costing tools to review burden and cost details by type of cost for both 
project and non-project transactions. For more information, refer to the Infor VISUAL System-
wide Guide documentation.

Close/Re-Open Accounting Period – To identify any outstanding transactions, close and re-
open the accounting period in Close re-open period to identify outstanding transactions. For more 
information, refer to “Step Eleven: Close the Period,” on page 8–18.

Step Three: Run Costing Utilities and Prepare 
Manufacturing Journals
The more often you run costing utilities during the period, the quicker the costing process will be. We 
recommend running transaction costing and preparing and posting all journals daily. 

Note: Please run costing for the current period only. Running costing for previous periods may result 
in unstable data.

Note: Please consider the options presented when you click the Set Up button carefully. 

When you are ready to close the period, use the following procedures.
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Running the Costing Utilities
To access Costing Utilities:

1 From the Eng/Mfg menu or from the Ledger menu, select Costing Utilities. 

2 In the Costing Utilities window, click the Site ID arrow and select the site to use.

3 In the Date field, enter any date within the current period. The date is changed to the last day of 
the period.

4 Select all options in the top and bottom portions of the window. 

5 Click the Run button. The costing utilities analyze your database and cost transactions as 
appropriate.

When the costing utilities have finished running, a dialog box appears alerting you to the actions 
that the costing utilities took.

6 If costing encounters errors, you are prompted to examine the errors in the error log.

7 Click Yes to examine the log. 

The log identifies specific issues that interfered with the successful completion of costing. You 
must correct the problems identified in the log. If you do not correct the errors, they will compound 
over time.

If you do not want to review the log, click No. 

The error log is stored as VMPRJCST.log in the directory where your executables are installed. 
You can review the log at any time.

8 After you correct any errors in the error log, run the costing utilities and prepare the journals 
again. 

Reviewing Journals
After costing has run to completion with no errors, prepare the G/L Transaction Reports to view the 
transactions before you post them.

To access the reports:

1 From the Ledger menu, select Post Manufacturing Journals. 

2 In the Post Manufacturing Journals window, select Reports, G/L Transactions. 

3 Do one of these steps:

• To print a standard report, click the Standard tab, and specify this information:

Site ID – If you are licensed to use multiple sites, click the Site ID arrow and select the site for 
which to view G/L Transactions. If you are licensed to use a single site, this field is 
unavailable.

By Accounting Period – Click this option to generate the report by accounting period.
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End Date of Accounting Period – Click the Calendar button to select any date within an 
accounting period, or enter the end date in the field provided.

The ending date of the accounting period is automatically determined.

Fiscal Period – The fiscal period is entered when an end date is selected. 

By Batch ID – Click this option to generate the report by Batch ID.

Starting Batch ID – Click the Browse button to select the starting batch ID, or enter the 
starting batch ID in the field provided.

Ending Batch ID – Click the Browse button to select the ending batch ID, or enter the ending 
batch ID in the field provided.

• To print an advanced report, click the By Accounting Period option, then click the Advanced
tab. Specify this information:

Report Calendar ID – Click the Report Calendar ID arrow and select the reporting calendar 
to use for the report. 

Fiscal Year – Click the Fiscal Year browse button and select the fiscal year for the report. 

Site ID(s) – Click the Site ID(s) arrow and select the sites to include in the report. When you 
select multiple sites, shared tracking currencies are identified and inserted in the Report 
Currency field. If a shared tracking currency does not exist, “Not Available” is inserted in the 
Report Currency field. If “Not Available” is displayed, clear site selections until a shared 
currency can be identified.

4 Click the arrow beside the Report Currency ID to select a currency from the list. If you are printing 
a standard report, the entity currency associated with the site is inserted. If you are printing an 
advanced report and are printing the report for multiple sites, the drop-down list shows the 
tracking currencies shared by the selected sites. If no shared tracking currencies are found, “Not 
Available” is inserted. You cannot run the report if a shared tracking currency is not found. Clear 
site selections until a shared tracking currency ID is displayed in the drop-down list.

5 In the Sequence section, select Order ID/Trans, G/L Acct ID.

6 In the Transactions section, select Print Unposted Txs. The transactions you generated by 
running the costing journals will appear in the report.

7 In the Journal Type section, begin by selecting Purchases. After you run the Purchases report, 
run reports for each journal type except for Projects. See Reviewing Project Transactions.

8 Click Ok. 

9 Compare this report to the reports you printed in step two to see if transactions costed as 
anticipated.

Reviewing Project Transactions
To review project transactions before you post them, run the G/L Transaction Report from the Project 
Summary window.
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Use the Inquiry / Print G/L Transactions window to review all G/L transactions related to projects. You 
can view posted and unposted transactions, and in Inquiry mode you can access the individual 
transaction that created the G/L transaction. 

1 In the Project Summary Window, select Info, Inquiry / Print GL Transactions. 

1 Do one of these steps:

• To view information for a single site, click the Standard tab. Click the Site ID arrow and select
the site to view.

• To view information for multiple sites, click the Advanced tab. Click the Currency ID and
select the currency to view in the report. Transactions that were posted in the currency you
select are displayed. Click the Site ID(s) arrow and select the sites to include in the report. 

1 In the Filters section, select how you would like to limit the information for the report. Your choices 
are:

By Date Range – Select By Date Range to limit the information to transactions that occurred on 
certain dates. If you choose By Date Range, the Starting Date and Ending Date fields become 
available. In the Starting Date field, enter the first date of the period you would like to view. In the 
Ending Date field, enter the last day of the period you would like to view. The dates are adjusted 
to the last date of the period. If you choose By Date Range, the Starting and Ending Account ID 
fields become active. Use the Starting and Ending Account ID fields to limit the information in the 
report to certain accounts. In the Starting Account ID field, enter the first account ID you would like 
to view in the report. In the Ending Account ID field, enter the last account ID you would like to 
view in the report. The accounts you specify and all accounts that fall in between are displayed. 

By Batch Number – Select By Batch Number to limit the information to transactions posted in 
particular batches. If you select By Batch Number, the Starting Batch ID and Ending Batch ID 
fields become available. In the Starting Batch ID field, enter the first Batch ID you would like to 
view, or click the Starting Batch ID button to choose a Batch ID from a table. In the Ending Batch 
ID field, enter the last Batch ID you would like to view, or click the Ending Batch ID button to 
choose a Batch ID from a table. To view a single Batch ID, enter the same ID in the Starting and 
Ending Batch ID fields. To view all Batch IDs, leave the Batch ID fields blank.

By Project Info Filters – Select By Project Info Filters to limit the information to transactions 
associated with projects that match the criteria you determine in the Project Info section. When 
you select By Project Info Filters, the Project Info section becomes active. Click the Project Info 
button and select the project criteria. If you select By Project Filters, the Starting Date and Ending 
Date fields become active. In the Starting Date field, enter the first date of the period you would 
like to view. In the Ending Date field, enter the last day of the period you would like to view. The 
dates are adjusted to the last date of the period.

2 In the Sequence section, select the sort order for the report / inquiry. Your choices are:

G/L Account ID, Batch Type – Select this option to sort the report by G/L Account ID first, then 
by Batch Type.

Project, WBS, Dept – Select this option to sort the report first by Project ID, then by WBS code, 
then by Department. If you select this option and have chosen to view a report, only a detailed 
report is available.

Project, Batch Type – Select this option to sort the report first by Project ID, then by Batch Type. 
This option is not available if you selected to run the report by Project Info Filters.
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Batch Type – Select this option to sort the report by Batch Type. This option is not available if you 
selected to run the report by Project Info Filters.

If you select By Batch Number in the Filters section, the following Sequence options are also 
available. These options are not available if you chose By Date Range or By Project Info Filters:

Batch ID, Project – Select this option to sort the report first by Batch ID, then by Project. If you 
select this option and choose to output a report, only a detailed report is available. 

Batch ID, G/L Account ID – Select this option to sort the report first by Batch ID, then by G/L 
Account ID. If you select this option and choose to output a report, only a detailed report is 
available.

Burden Cat ID, G/L Acct ID – Select this option to sort the report by Burden Category ID/G/L 
Account ID combination.

G/L Acct ID, Burden Cat ID – Select this option to sort the report by G/L Account ID/Burden 
Category ID combination.

3 In the Transaction Type section, select the type of transaction you would like to view in the report. 
Your choices are:

• Purchases
• Labor
• Adjustments
• Project Transfers
• Accounts Payable
• General Journal

Select Print All to view all transaction types.

4 In the Transactions section, select from the following:

Print Unposted Txs - Select this option to view only those transactions that have not yet posted 
to the General Ledger. This option is not available if you selected to view the report by Batch ID.

Print Posted Txs - Select this option to view only posted transactions. This option is selected 
automatically if you choose to view the report by Batch ID.

Print Both - Select this option to view both posted and unposted transactions. This option is not 
available if you selected to view the report by Batch ID.

5 To further define your report, select or clear check boxes as follows:

Current User Only - Select the Current User Only check box to view transactions that the current 
user inputted. To view all transactions from all users, clear this check box.

Include Rev Recg - Select this check box to include revenue recognition transactions in the 
report. Clear the check box to omit revenue recognition transactions from the report.

Include Rev Recg WIP Only - Select this check box to view revenue recognition for work in 
process projects only. Clear this check box to include all revenue recognition transactions. This 
check box is only available if you select the Include Rev Recg check box.
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Printing the G/L Transactions Report
To print a report based on the parameters you set up:

1 In the Mode section, select Report Only. The Reporting Options section becomes available.

2 In the Reporting Options section, select the type of report you would like to view. You can choose 
from:

Detail – Choose Detail to view a detailed report. The information displayed in the detailed report 
varies depending on the type of report you are viewing.

Summary – Select Summary to view a summarized report.

Summary w/subtotals – Select Summary w/subtotals to view the summarized report with 
subtotals by group.

3 Click the View arrow to select the output method for the report. You can choose View, Email, 
Print, or File.

4 Click Ok. The report outputs.

Viewing the G/L Transactions Inquiry
To view the results based on the parameters you set up in a table:

1 In the Mode section, select Inquiry Only.

2 Click Ok. 

3 If a Plus sign appears in the Sum column, you can view more information about the line. Double-
click the gray row header to view the additional information. The details appear indented 
underneath the row you selected. When there is no additional detail to view, the Sum column is 
blank.

4 If you are viewing a burden line, you can view the details of the burden distribution. Double-click 
the line you would like to view, or select Info, Show Burden Detail. The Burden Distributions 
table appears, showing you which accounts were debited and credited.

5 When you are finished viewing information in the Inquiry / Print G/L Transactions window, click 
Close to exit the window.

Saving the G/L Transactions Inquiry as a Database Table
If your G/L Transactions Inquiry returned a large number rows, you can export the results to a 
database table. The name of the table is PROJECT_GL_TRANS.

1 In the Mode section, select Save to DB.

2 If you have selected the By Date Range or By Project Info filters, specify dates in the Starting 
Date and Ending Date fields.

3 Click Ok. The system exports the data to a table.

Note: When you export a new G/L Transaction Inquiry, the information in the PROJECT_GL_TRANS 
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table is copied over. 

Step Four: Post Manufacturing Journals
After you run the costing utilities and prepare the journals, post the journals to the General Ledger.

1 From the Ledger menu, select Post Manufacturing Journals. 

2 In the Post Manufacturing Journals window, click the Site ID arrow and select the site for which to 
post manufacturing journals.

3 Leave the Batch ID and Description fields blank. These fields are populated.

4 Enter the date you would like to use for posting the journals in the Batch Date field. If you are 
preparing the month-end closing, enter the end date of the month you are closing. The 
Accounting Period is populated.

5 Clear the Current User Only check box to process journal entries for all users.

6 Click the Post All button to post all journal types.

Step Five: Re-run Costing Utilities and Post Manufacturing 
Journals
Repeat steps three and four until the Costing Utilities indicate that no updates have been performed 
or when the number of updates remains constant (penny rounding sometimes moves back and forth 
between transactions, which results in costing reporting an update to a transaction).

Step Six: Analyze Project Summary Window Information
Use the tools available to you in the Project Summary and Project Maintenance window to assess 
transactions posted to projects.

Project Summary Estimate at Completion/POC Comparison
The Project Summary EAC/POC Comparison reports the percent change between the current 
version EAC and a summarized ETC. Use this report to determine which formal EACs need to be 
updated. You can also use this report to identify any unusual costs that have been reported to the 
actual costs and updated to the ETC.

To run the report:

1 From the Project menu, select Project Summary Window. 

2 From the File menu, select Print EAC/POC Report. 
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3 In the Print EAC/POC Report dialog box, click the Site ID arrow and select the site for which to 
print a EAC/POC Report.

4 To view all projects, leave the Project ID fields blank.

5 In the Filter section, leave the Project Type field blank to view all project types in the report.

6 In the Summarize up to field, enter the last day of the period you are closing.

7 Click Ok.

If the actual amounts do not match the formal amounts, you may want to update your EAC for the 
project. 

Project Budget Report
The Project Budget Report shows the current budgets for each project.

To run the report:

1 From the Project Summary window, click the Site ID arrow and select the site for which to print a 
project budget report.

2 Select File, Print Budget Info. 

3 To view all project budgets, leave the project ID fields blank in the Print Budget Info dialog box. To 
view a range of projects, enter a project ID in the Starting Project ID field and Ending Project ID 
field. All projects that fall between those two IDs (inclusive) will appear in the report.

4 Click Ok. 

Project Summary Tools
The Show Source for Details and Show Source for Actuals options in the Project Summary window 
allow you to examine individual transactions that make up your project summary figures. Double-
clicking on a line in the Project Summary window table often brings up additional information.

Accessing Show Source for Details and Show Source for Actuals Information
To view source information:

1 In the Project Summary window, click the Site ID arrow and select the site for which to view 
source information.

2 Click the Project ID button to select the project you would like to view. The project information 
appears in the window.

3 In the Summary Type(s) section, select the type of information you would like to view. 

4 Double-click on a line (including the total line). The Direct Costs Detail window appears.



8 – 12 | Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense 

The window breaks down costs by cost category.

5 Click the X button to close the window and return to the Project Summary window.

6 Select a line in the table, then select Show Detail for Actuals from the Info menu. The Detail for 
Actuals window appears.

7 Click the X button to close the window and return to the Project Summary window.

8 Select a line in the table, then select Show Source for Actuals from the Info menu. The Source 
for Actuals window appears.

9 Double-click a line in the table to view more detailed information.

10 Double-click a line to view the original document that created the actual cost. For materials, you 
can also click the Open Cost Source button. For labor, you can click the Open Work Order 
button.

Step Seven: Update Formal EACs and ETCs
To apply current costs to your ETCs and EACs, run the Update ETC with Actuals utility. When you 
run the utility, the system creates a new ETC for your project so you can keep a record of the changes 
to the ETC. You can also create new EACs based on the actual costs. You can run the utility for a 
single project, all projects, or a selection of projects. 

Updating ETCs with actual costs cannot be undone.

To update ETC with actuals:

1 From the Project Summary window, select Edit, Update ETC with Actuals. The Update ETC with 
Actuals window appears.

2 Click the Site ID arrow and select the site to use.

3 Click the Project Info browse button to select the project ETC(s) you would like to update.

You can select projects based on Project ID, Project Type, Business Line, Division, Customer, 
Contract Administrator, Program Manager, and Financial Analyst. Click the tab for the filter you 
would like to use, click the IDs you would like to use in the Available section, then click the 
Include button to move the IDs to the Selected section. You can also double-click an ID to move 
it to the Selected section. You can use one filter or multiple filters, if you choose. When you are 
finished selecting project filters, click the Ok button.

If you would like to update ETCs for all of your projects, do not make any selections in the Project 
Info Filters dialog box.

4 In the Start Period field, enter any date in the period you want to update. The field is populated 
with the first day of the period. In the End Period field, enter any date in the period you are 
updating. The field is populated with the end date of the period.

5 Select from the following options:

Mark new ETC versions as current – Select this option if you would like the system to designate 
the new ETCs it creates as the current versions.
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Create new EAC versions – Select this option if you would like to create new EACs in addition to 
the new ETCs. If you select this version, the system will create an EAC based on the informal 
EAC figures in the Project Summary window.

Mark new EAC versions as current – Select this option if you would like the system to designate 
the new EACs it creates as the current versions. 

Note: If you select the Mark new EAC versions as current check box, any percentage of 
completion calculations will be based on the new EAC. This may have an impact on projects that 
use percentage of completion as the billing basis.

6 Click the Save button. The system informs you that it updated the ETC and created new EAC 
versions.

To compare the current EAC with the Baseline EAC, from the Project Summary window select 
Info, Baseline/EAC Comparison.

You can also view percentage of completion for the project by selecting from the Project 
Summary window Info, Percent of Completion Values. The Percent of Completion Values 
window appears.

Step Eight: Complete Project Billing and Progress Billing 
Manufacturing Invoicing
Process project billings and commercial progress billings. 

To process project billing:

1 From the Project menu, select Project Billing Entry. 

2 Click the Site ID arrow and select the site to use.

3 In the Order ID field, select a customer order ID to invoice. Details of the order appear in the 
appropriate fields.

4 Select the row for which you would like to create billing events.

5 From the Edit menu, select Billing Events. The Edit Billing Events window appears.

Review the information in the line items. To mark a line item for invoicing, select the Generate
Invoice check box.

6 Click Save to save your changes.

7 To generate the invoices, select File, Print Invoices... from the Project Billing Entry window. 

8 If any of the invoices are attached to international orders, click the Language ID arrow and select 
a language for the invoice.

9 In the Date Setting section, select Current, Event Date, or Specified. If you select Specified, click 
the calendar button and select the date you want.

10 Select the appropriate print options:

Print Only - Do Not Save Invoice # – If you want to print draft invoices and you do not want to 
generate the actual invoice record in your database, select the Print Only option.
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When you select the Print Only option, you have the option to view the invoice on-screen only.

Note: Printing for view generates invoice numbers but does NOT save the invoice number and 
does not transfer it to your general ledger, the next time you print invoices, the transfer is done.

Use Pre-numbered Forms – If you are using pre-numbered forms, select the Use Pre-
numbered Forms check box and enter the number on which the forms start in the Starting Form 
Number field.

Use Current Exchange Rates – If exchange rates are involved in your invoice calculations and 
you want to make sure the latest exchange rates are used, select the Use Current Exchange 
Rates check box.

11 Select the appropriate format option in the Format section.

You can select the standard QRP format, or one of three user defined formats.

12 The Samples section is helpful in setting up your printer correctly. If necessary, select the 
appropriate sample options:

Print Samples Only – If you want to print samples ONLY of your invoice form, select the Print 
Samples Only check box.

Zero Sample Forms – Select this option if you do NOT want to print any sample invoices before 
printing actual invoices.

1 Sample Form – Select this option to print one sample invoice when you select the Print 
Samples Only check box.

3 Sample Forms – Select this option to print three sample invoices when you select the Print 
Samples Only check box.

13 To print the invoices, click the Ok button.

If you have NOT selected the Print Only - Do Not Save Invoice # check box, a notification dialog 
box appears indicating that invoices were printed and they were transferred to Accounts 
Receivable.

If you selected the Print Only - Do Not Save Invoice # check box, the notification dialog box 
states that invoices were printed and they were NOT transferred to Accounts Receivable.

14 To close the dialog box, click the Ok button on the dialog box.

The Print Invoices dialog box also closes.

Repeat the process for each of your projects.

For commercial transactions:

1 From the Contracts menu, select Progress Billing Entry. 

2 In the Progress Billing Entry window, click the Site ID arrow and select a site to use.

3 Select an Order ID in the Order ID field. Information for the order is populated in the window.

4 Select the row for which you would like to create billing events.

5 From the Edit menu, select Billing Events or Milestones, depending on the type of progress 
billing you have set up (this example uses billing events). The window appears.
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6 If a billing event has been triggered through the costing utility, a check mark appears in the 
Triggered field. 

7 Click the Close button to return to the Progress Billing Entry window.

8 To generate an invoice, select Print Invoices from the File menu. 

9 In the Print Invoices dialog box, click the Site ID drop-down and select the site to use.

10 In the Date Setting field, select the date that will appear on the invoice. Your choices are current, 
event date, or a date you specify.

11 Select the report’s format in the Format section. Depending on your system, you may have more 
than one choice in the Format section.

12 Select the appropriate print options.

Print Only - Do Not Save Invoice # - Select this option if you want to view draft invoices only.

Use Pre-numbered Forms - Select this option if you are using forms with preprinted invoice 
numbers. If you select this option, enter the starting form number in the Starting Form Number 
field.

Use Current Exchange Rates - Select this option to have the latest exchange rates from 
Currency Exchange Rate Maintenance used. See Currency Exchange Rate Maintenance for 
more information on creating exchange rates.

13 Click Ok to print the invoice.

Step Nine: Process Project Revenue Recognition
You should run revenue recognition for each type of revenue recognition (shipment, billing event, 
POC).

To run revenue recognition: 

1 From the Project menu, select Project Revenue Recognition. 

2 Select the site whose revenue you are recognizing.

3 In the Project Revenue Recognition window, select the Prepare Billing Event Transactions 
button to prepare billing event revenues. 

4 In the Prepare Revenue Recognition Entries - Billing Events window, select all of the projects that 
you would like to prepare, then click Prepare. The system displays a dialog box listing the number 
of transactions it prepared.

5 Click Ok to return to the Project Revenue Recognition window.

Repeat the process for Shipment transactions and Percent of Completion transactions.

If you need to make adjustments to any transaction, enter an adjustment manually.

You can review the project revenue history for each project by entering the Project ID in the 
Project ID field, then selecting Info, Revenue History.

You can also view revenue recognition transactions by running the Transactions report.
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Running the Transactions Report
1 From the File menu, select Print Transactions. 

2 Do one of these steps:

• To print a standard report, click the Standard tab, and specify this information:

Site ID – If you are licensed to use multiple sites, click the Site ID arrow and select the site for 
which to view G/L Transactions. If you are licensed to use a single site, this field is 
unavailable.

By Accounting Period – Click this option to generate the report by accounting period.

End Date of Accounting Period – Click the Calendar button to select any date within an 
accounting period, or enter the end date in the field provided.

The ending date of the accounting period is automatically determined.

Fiscal Period – The fiscal period is entered when an end date is selected. 

By Batch ID – Click this option to generate the report by Batch ID.

Starting Batch ID – Click the Browse button to select the starting batch ID, or enter the 
starting batch ID in the field provided.

Ending Batch ID – Click the Browse button to select the ending batch ID, or enter the ending 
batch ID in the field provided.

• To print an advanced report, click the By Accounting Period option, then click the Advanced
tab. Specify this information:

Report Calendar ID – Click the Report Calendar ID arrow and select the reporting calendar 
to use for the report. 

Fiscal Year – Click the Fiscal Year browse button and select the fiscal year for the report. 

Site ID(s) – Click the Site ID(s) arrow and select the sites to include in the report. When you 
select multiple sites, shared tracking currencies are identified and inserted in the Report 
Currency field. If a shared tracking currency does not exist, “Not Available” is inserted in the 
Report Currency field. If “Not Available” is displayed, clear site selections until a shared 
currency can be identified.

3 Click the arrow beside the Report Currency ID to select a currency from the list. If you are printing 
a standard report, the entity currency associated with the site is inserted. If you are printing an 
advanced report and are printing the report for multiple sites, the drop-down list shows the 
tracking currencies shared by the selected sites. If no shared tracking currencies are found, “Not 
Available” is inserted. You cannot run the report if a shared tracking currency is not found. Clear 
site selections until a shared tracking currency ID is displayed in the drop-down list.

4 In the Sequence section, select the sort order for the report. You can select Transaction ID, G/L 
Account ID or Type, Project ID, Transaction ID.

5 In the Transactions section, select Print Unposted Transactions to view all the transactions you 
processed.

6 Clear the Current User Only check box to view transactions processed by all users.

7 Click Ok. 
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Post Revenue Recognition to the G/L
After you have reviewed the Transaction report, post the revenue recognition transactions to the 
General Ledger.

1 From the main menu, select Project, Project Revenue Recognition.

2 Select File, Post to G/L. 

3 In the Post Distribution to General Ledger dialog box, click the Site ID arrow and select the site to 
use.

4 Enter the last day of the period in the Batch Date field.

5 Clear the Current User Only check box to process transactions entered by all users.

6 Click Start. The transactions can be reviewed again by selecting Yes when the dialog box 
appears. If not, the next dialog box asks if you would like to Post the transactions to the General 
Ledger. After posting, the transactions can be printed for filing purposes, or can be printed at 
another time. 

Step Ten: Reconciling the Balance Sheet
Many tools are provided in VISUAL to reconcile your commercial transactions. The types of 
transactions you should reconcile are Cash, Accounts Payable, Accounts Receivable, Inventory, 
Work In Process and PO Accrual transactions.

Note: The manufacturing reports must be run in a static environment. Any changes made to the 
database while you are performing the reconciliation will result in inconsistent results.

Reconcile the following types of transactions:

Cash Transactions - To reconcile cash transactions, compare information in the Cash Management 
window, the Cash Book window, the Cash G/L Accounts report and your company’s bank statements. 
For more information on the Cash G/L Accounts report, refer to “Cash G/L Transactions Report,” on 
page Appendix–15.

Accounts Receivable - To reconcile Accounts Receivable, compare the Aged Receivables report to 
the A/R account(s) in the Accounting window. For more information on the Aged Receivables report, 
refer to “A/R Aged Receivables,” on page Appendix–16.

Reconciling Accounts Payable - To reconcile Accounts Payable, compare the Aged Payables 
report to the commercial A/P account(s) in the Accounting window. For more information on the Aged 
Payables report, refer to “A/P Aged Payables,” on page Appendix–17.

Reconciling Inventory Transactions - To reconcile inventory transactions, run the Inventory 
Valuation – Cost Layer Detail report and the Inventory Balance Report. Compare the results you see 
on these two reports to the General Ledger. For more information on the Inventory Valuation report, 
refer to “Inventory Valuation Report,” on page Appendix–13. For more information on the Inventory 
Balance Report, refer to “Inventory Balance Report,” on page Appendix–18.

Reconciling Work In Process Transactions - Similarly, to reconcile work in progress, compare the 
Work In Process Report – Posted Value to the Post Manufacturing Journal WIP Balance report. The 
transactions on each of these reports should match, and you should find the transactions represented 
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in the General Ledger. For more information on the Work In Process report, refer to “Work In Process 
Posted Value,” on page Appendix–14. For more information on the WIP Balance report, refer to 
“Printing Project WIP Balance Reports,” on page Appendix–19.

Reconciling PO Accrual - To reconcile PO accrual, compare the Uninvoiced Detail Report in 
Payable Invoice Entry to the Post Manufacturing Journal PO Accrual report. The transactions on each 
of these reports should match, and you should find the transactions represented in the General 
Ledger. For more information on the Uninvoiced Detail Report, refer to “Uninvoiced Receipt Report 
Detailed,” on page Appendix–10. For more information on the PO Accrual report, refer to refer to “PO 
Accrual Report,” on page Appendix–21.

Three reports are particularly helpful when reconciling project transactions: the EAC/POC Report, the 
Project WIP Balance report and the Project Billing Events report. For more information on the Project 
WIP Balance report, refer to “Printing Project WIP Balance Reports,” on page Appendix–19. For more 
information on the Project Billing Events report, refer to “Project Billing Events Report,” on 
page Appendix–4. For more information on the EAC/POC report, refer to “EAC/POC Report,” on 
page Appendix–19.

Use the EAC/POC Report to review and analyze the actual amounts and cost of goods sold by 
project. Print the EAC/POC Report by selecting File, Print EAC/POC from the Project Summary 
Window. 

Use the Project WIP Balance Report to reconcile project WIP balances. Project WIP balances are 
made up of project inventory, plus direct project labor, plus other direct charge amounts, plus general 
ledger adjustments, plus A/P invoice charges, minus amounts moved to COGS through revenue 
recognition. Print the Project WIP Balance Report by selecting Reports, Project WIP Balances from 
the Post Manufacturing Journals window. 

Use the Project Billing Events Report to reconcile the customer order value to the contract value of 
your projects. You can also use this report to reconcile deferred revenue. Print the Project Billing 
Events Report by selecting File, Print Project Billing Events from the Project Billing window.

Step Eleven: Close the Period
When you have finished reconciling your transactions, you are ready to close the period. 

1 From the Ledger menu, select Accounting Window. The Accounting Window appears.

2 In the Accounting Window, select Maintain, Close/Reopen Period. 

3 In the Close/Reopen Period dialog box, click the Site ID arrow and select the site to use.

4 In the End Date of Beginning Acct Period field, enter any date within the period you would like to 
close. The field is populated with the end date of the period.

5 Click the Test button to verify that all transactions for the period have been posted. If necessary, 
investigate any unposted transactions.

6 If the test runs successfully, click the Close Period button to close the period.
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Appendix: Helpful Reports

Use the reports described in this appendix to help you close financial periods.

This chapter includes:

Topic Page

Reports for Reviewing Transactions .................................................................................. Appendix–2
Reports to Assess Costed Transactions .......................................................................... Appendix–13
Reports Used to Reconcile the Balance Sheet................................................................ Appendix–15
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Reports for Reviewing Transactions
Use these reports to review the transactions for the month. These reports correspond to Step One of 
closing procedures.

Note: The procedures for the reports in this section describe how to use the reports to close periods; 
the procedures in this section do not describe the full functionality of the reports. For more information 
on these reports, refer to your VISUAL documentation.

Pack List Report
Use this report to review shipments. You can use this report for both project and non-project 
transactions.

1 From the Contracts Menu, select Shipping Entry. 

2 In the Shipping Entry window, click the Site ID arrow and select the site for which to print a pack 
list report.

3 From the File menu, select Print Pack List Report. 

In the Pack List Report dialog box, specify this information:

4 In the Status section, choose Shipped.

5 In the Date section, choose Actual Ship Date.

The field labels at the top of the window change to Starting Actual Ship Date and Ending Actual 
Ship Date

6 In the Starting Actual Ship Date field, enter the first day of the month you would like to close. In 
the Ending Actual Ship Date field, enter the last day of the month that you would like to close.

7 In the Type section, choose Detail.

8 Click Ok. 

The key information on the Pack List detail report is the customer, the items shipped, the quantity 
and the value of the shipment. 

Shipping/Delivery Report
Use the Shipping/Delivery Report to review shipments. You can use this report for both project and 
non-project transactions.

1 From the Contracts menu, select Shipping/Delivery Report. 

2 In the Shipping/Delivery Report window, click the Site ID(s) arrow and select the site(s) to use.

3 In the Starting Due Date field, enter the first day of the period that you would like to close. In the 
Ending Due Date field, enter the last day of the period that you would like to close.

4 In the Sequence section, choose the primary sort order for the report. Your choices are:
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Due date

Order ID

Customer ID

Customer Name

Part ID

Supply ID

5 In the Subsequence section, choose the secondary sort order for the report. Your choices are: 

Due date

Order ID

Customer ID

Customer Name

Part ID

Supply ID

6 Click the Print button to output the report.

Customer Sales Journal Report
Use the Customer Sales Journal Report to review all invoiced orders. This report displays information 
for both project and non-project transactions.

1 From the Contracts menu, select Customer Sales Journal. 

2 In the Customer Sales Journal window, click the Site ID(s) arrow and select the site(s) to use.

3 In the Starting Date field, enter the first day of the period that you would like to close. In the 
Ending Invoice Date field, enter the last day of the period that you would like to close.

4 In the Sequence section, select the sort order for your report. 

5 Select the Print Uninvoiced check box. This enables you to view orders that were supposed to 
ship during the month that have not been invoiced.

6 Select the Detail option for the report. The Detailed version includes customer order IDs along 
with other valuable information.

7 Click the Print button to print the report. 

If there are uninvoiced transactions, you may want to investigate why they have not yet been 
invoiced.
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Print One Invoice
Use the Print One Invoice window to view shipments eligible to be invoiced. This window displays 
information for both project and non-project transactions.

1 From the Receivables menu, select Invoice Forms. 

2 In the Invoice Forms window, click the Site ID arrow and select the site to use.

3 From the File menu, select Print One Invoice. The Print One Invoice window appears.

The window shows orders that have been shipped but have not yet been invoiced. Review your 
records to see if an invoice should be issued.

Project Billing Events Report
Use this report to review project billing transactions. This report is for project transactions only.

1 From the Project menu, select Project Billing Entry. 

2 In the Project Billing Entry window, click the Site ID arrow and select the site to use.

3 Select File, Print Project Billing Events Report. 

In the Print Project Billings Events dialog box, specify this information:

4 In the Starting Date field, enter the first day of the period you want to close. In the Ending Date 
field, enter the last day of the period you want to close.

5 In the Show Events section, select Future Billing Events, Current Billing Events, and 
Processed Billing Events. Selecting all check boxes will give you a complete view of the billing 
events that are set to occur during the month.

6 In the Customers section, select All Customers. When you select All Customers, All Orders in 
the Orders section is selected by default.

7 Select a sort order for your report in the Sequence section. Your choices are by Order ID and by 
Customer ID.

8 Click Ok to run the report. 

Order Invoice Status Report
Use this report to review project billing transactions.

1 From the Projects Menu, select Project Billing Entry. 

2 In the Project Billing Entry window, click the Site ID arrow and select the site to use.

3 From the File menu, select Print Order Invoice Status Report. 

In the Print Order Invoice Status dialog box, specify this information:
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4 In the Starting Date field, enter the first day of the period you want to close. In the Ending Date 
field, enter the last day of the period you want to close.

5 In the Customers section, select All Customers. When you select All Customers, All Orders in 
the Orders section is selected by default.

6 Select a sort order for your report in the Sequence section. Your choices are by Order ID and by 
Customer ID.

7 Click Ok to run the report.

The report shows invoice amounts and distributions.

Receiving Report
Use the Receiving Report to review purchase receipts. This report displays information for both 
project and non-project transactions.

1 From the Purchasing menu, select Receiving Report. 

2 In the Receiving Report window, click the Site ID(s) arrow and select the site(s) to use.

3 In the Starting Date field, enter the first day of the period you would like to close. In the Ending 
Date field, enter the last day of the period you would like to close.

4 In the PO Receipt Status, select Scheduled. 

5 Leave the fields in the Selection Criteria blank to return all scheduled receipts for the month.

6 Click the Print button. The Purchased Part Receiving Report – Scheduled appears.

7 Run the report again, this time selecting Actual in the PO Receipt Status section.

8 Click Print. The Purchased Part Receiving Report – Actual appears.

9 Compare the Purchased Part Receiving Report – Actual to the Purchased Part Receiving Report 
– Scheduled. If there are scheduled deliveries that do not appear on your actuals report, you may 
want to investigate the discrepancy.

Inventory Transactions Report
Use the Inventory Transactions report to review the inventory transactions for the month. This report 
displays information for both project and non-project transactions.

1 From the Inventory menu, select Inventory Transaction Entry. 

2 In the Inventory Transaction Entry window, select File, Print. 

3 In the Print Inventory Transactions window, click the Site ID(s) arrow and select the site(s) to use.

4 In the Starting Date field, enter the first day of the period you would like to close. In the Ending 
Date field, enter the last day of the period you would like to close.



Appendix – 6 | Infor VISUAL User’s Guide for Project-Based Manufacturers and Aerospace & Defense 

5 In the Type section, use the check boxes to determine the types of inventory transactions you 
would like to view. Select Receipts, Issues/Shipments, and Adjustments to view all inventory 
transactions.

6 In the Sequence section, select a sort order for your report. Your choices are:

Transaction ID

Part ID

Customer Order ID

Purchase Order ID

Work Order ID

Warehouse/Location

Warehouse/Location/Part ID

For projects, you may want to sort the report by Warehouse/Location to view transactions by 
project (since project warehouse IDs are identical to project IDs).

7 Select the Include Obsolete Parts to include parts that you may have recently put out of service.

8 Click Ok.

Labor Tickets
Use the Labor Tickets report to review the labor tickets entered for the month. This report displays 
information for both project and non-project transactions.

1 From the Eng/Mfg menu, select Labor Ticket Entry. 

2 In the Labor Ticket Entry window, select File, Print Summary. 

3 In the Print Summary dialog box, click the Site ID(s) arrow and select the sites to use.

4 In the Starting Date field, enter the first day of the period you would like to close. In the Ending 
Date field, enter the last day of the period you would like to close.

5 Leave the Employee ID fields blank to return information on all employees. This gives you a 
complete analysis of the labor tickets submitted during the period. 

6 Make selections in the following sections as appropriate:

Week Beginning – Select Selected Starting Date to set the first day of the first week in the 
report to the starting date specified in the Starting Date field. Select 1st Transaction Date Found 
to set the first day of the first week in the report to the date of the first transaction recorded.

Major Sequence – Select By Employee ID to sort the report by employee ID. Select None to sort 
the report solely by the minor sequence. We recommend selecting By Employee ID.

Minor Sequence – Select the secondary sort for the report in the Minor Sequence section. Your 
choices are:

By Date
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By G/L Account ID

By Resource ID

By Work Order ID

By Department ID

We recommend selecting By Work Order ID so you can trace the labor tickets to a particular 
work order.

Display Date – Select Display by Shift Date to show the shift date on the report. Select Display 
by Transaction Date to use the transaction date.

Determine Overtime – Select the Determine Overtime check box to compute overtime wages 
on the report.

Include Vac/Hol/Sick – Select this check box to include paid leave on the report.

7 Click Ok. 

A/R Invoice Register
Use the A/R Invoice Register to review A/R transactions. This report displays information for both 
project and non-project transactions.

1 From the Receivables menu, select Invoice Entry. 

2 In the Accounts Receivable Invoice Entry window, select File, Print Invoice Register. 

3 In the Print A/R Invoice Register dialog box, click the Site ID(s) arrow and select the sites to use.

4 In the Beg Invoice Date field, enter the first day of the period you would like to close. In the End 
Invoice Date field, enter the last day of the period you would like to close.

5 In the Include section, select the types of invoices to include in the report. Your choices are:

Unpaid

Partially Paid

Paid in full

Void/Cancelled

Credit Memo

Unapplied Cash

You may find it useful to run the report type by type.

6 In the Sort Order section, arrange the sort order for the report by using the up and down arrow 
buttons. For example, to sort the report first by Invoice Date, select Invoice Date, then click the 
Up Arrow button to move Invoice Date to the top of the list.

7 In the Totals section, select the types of subtotals and totals you would like to view. You can select 
none, one or all of the following:

Customer Subtotal
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Currency Subtotal

Site Subtotal

Entity Subtotal

Grand Total

8 Click Ok.

Gross Profit Report
To review revenue and costs for customer orders, run the Gross Profit Report. This report displays 
information for both project and non-project transactions.

1 From the Ledger menu, select Post Manufacturing Journals. 

2 In the Post Manufacturing Journals window, select Reports, Gross Profit. 

3 Do one of these steps:

• To print a standard report, click the Standard tab, and specify this information:

Site ID – If you are licensed to use multiple sites, click the Site ID arrow and select the site for 
which to view G/L Transactions. If you are licensed to use a single site, this field is 
unavailable.

By Accounting Period – Click this option to generate the report by accounting period.

End Date of Accounting Period – Click the Calendar button to select any date within an 
accounting period, or enter the end date in the field provided.

The ending date of the accounting period is automatically determined.

Fiscal Period – The fiscal period is entered when an end date is selected. 

• To print an advanced report, click the Advanced tab. Specify this information:

Report Calendar ID – Click the Report Calendar ID arrow and select the reporting calendar 
to use for the report. 

Fiscal Year – Click the Fiscal Year browse button and select the fiscal year for the report. 

Site ID(s) – Click the Site ID(s) arrow and select the sites to include in the report. When you 
select multiple sites, shared tracking currencies are identified and inserted in the Report 
Currency field. If a shared tracking currency does not exist, “Not Available” is inserted in the 
Report Currency field. If “Not Available” is displayed, clear site selections until a shared 
currency can be identified.

4 In the Print Selection section, specify this information:

Report Currency – Click the arrow beside the Report Currency ID to select a currency from the 
list. If you are printing a standard report, the entity currency associated with the site is inserted. If 
you are printing an advanced report and are printing the report for multiple sites, the drop-down 
list shows the tracking currencies shared by the selected sites. If no shared tracking currencies 
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are found, “Not Available” is inserted. You cannot run the report if a shared tracking currency is 
not found. Clear site selections until a shared tracking currency ID is displayed in the drop-down 
list.

You can view gross profit by order, customer, part, product code, or commodity code. Select one 
of the following radio buttons:

Customer Order ID – Select Customer Order ID to view gross profit for individual orders.

Customer ID – Select Customer ID to view gross profit by individual customer. The report uses 
customer ID to identify the customer.

Customer Name – Select Customer Name to view gross profit by individual customer. The report 
uses customer name to identify the customer.

Part ID – Select Part ID to view gross profit by individual part.

Product Code – Select Product Code to view gross profit by individual product code.

Commodity Code – Select Commodity Code to view gross profit by commodity code.

Click the Starting button to select the first ID, name or code you would like to view in the report. 
Click the Ending button to select the last ID, name, or code you would like to view in the report. 
The IDs, names, or codes you specify, along with all IDs, names, or codes that fall in between are 
displayed.

5 Select the Summary check box to view a summary report. The summary report shows subtotals 
by ID, name, or code. The detailed report shows additional information, such as invoice line 
number.

6 Select Include Receivable Fees to view fee information in the report.

7 Click the View arrow to select an output method for the report. Your choices are view, print, email, 
and file.

8 Click Ok. 

Accounts Receivable Cash Receipts
To review the cash receipts for the period you would like to close, run the Cash Receipts report. This 
report displays information for both project and non-project transactions.

1 From the Receivables menu, select Cash Application. 

2 In the Cash Applications window, select File, Print Cash Receipts. 

3 In the Print Cash Receipts dialog box, click the Bank Account ID arrow and select the bank 
account to use. **All** is selected by default.

4 In the Starting Date field, enter the first day of the period you would like to close. In the Ending 
Date field, enter the last day of the period you would like to close.

5 In the Sort by section, select Payment ID to view the report by payment ID, or Deposit ID to view 
the report by deposit ID.
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6 The Print Active Payments check box is selected by default. If you select Print Void Payments, 
you can deselect the Print Active Payments check box. Select the Summary check box if you 
would like to view a summary report; we recommend leaving the check box blank to view a 
detailed report.

7 Click Ok. 

Uninvoiced Receipt Report Detailed
To make sure that invoices have been entered for all payables for the month, run the Uninvoiced 
Receipt Report - Detail. This report displays information for both project and non-project transactions.

1 From the Payables menu, select Invoice Entry. 

2 In the Invoice Entry window, select File, Print Uninvoiced Receipt Detail. 

3 In the Print Uninvoiced Receipt Detail dialog box, click the Site ID(s) arrow and select the sites to 
use.

4 In the Starting Date field, enter the first date of the period you would like to close. In the Ending 
Date field, enter the last date of the period you would like to close.

5 In the Status section, select the types of invoices you would like to view in the report. For the most 
complete report, select all options. Your options are

Released

Closed

Cancelled

6 In the Sequence section, select the order for the report. You can sort the report by Purchase 
Order ID or Vendor ID.

7 In the Type section, select Summary to view a summary report or Detail to view a detailed report. 
We recommend running a detailed report. The detailed report shows purchase order line detail.

8 Click Ok.

Payment Register
To review the accounts payable transactions for the month, run the Payment Register. This report 
displays information for both project and non-project transactions.

1 From the Payables menu, select Payment Entry.

2 In the Payment Entry window, select File, Print Payment Register. 

3 In the Print Payment Register dialog box, click the Site ID(s) arrow and select the sites to use.

4 In the Starting Date field, enter the first day of the period you would like to close. In the Ending 
Date field, enter the last day of the period you would like to close.

5 In the Sort By section, select the sort order for the report. You choices are:
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Control No

Payment No

Payment Batch No

6 Select the types of payments you would like to view. Your choices are:

Cleared Payments

Uncleared Payments

Void Payments

We recommend selecting both Cleared and Uncleared payments for a complete view of the 
payments for the month.

7 Click Ok. 

Revenue Recognition Transactions Report
The Revenue Recognition Transactions report shows details of your revenue recognition transactions 
for projects.

1 From the Project menu, select Project Revenue Recognition. 

2 In the Project Revenue Recognition window, select File, Print Transactions. 

3 Do one of these steps:

• To print a standard report, click the Standard tab, and specify this information:

Site ID – If you are licensed to use multiple sites, click the Site ID arrow and select the site for 
which to view G/L Transactions. If you are licensed to use a single site, this field is 
unavailable.

By Accounting Period – Click this option to generate the report by accounting period.

End Date of Accounting Period – Click the Calendar button to select any date within an 
accounting period, or enter the end date in the field provided.

The ending date of the accounting period is automatically determined.

Fiscal Period – The fiscal period is entered when an end date is selected. 

• To print an advanced report, click the Advanced tab. Specify this information:

Report Calendar ID – Click the Report Calendar ID arrow and select the reporting calendar 
to use for the report. 

Fiscal Year – Click the Fiscal Year browse button and select the fiscal year for the report. 

Site ID(s) – Click the Site ID(s) arrow and select the sites to include in the report. When you 
select multiple sites, shared tracking currencies are identified and inserted in the Report 
Currency field. If a shared tracking currency does not exist, “Not Available” is inserted in the 
Report Currency field. If “Not Available” is displayed, clear site selections until a shared 
currency can be identified.
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4 Click the arrow beside the Report Currency ID to select a currency from the list. If you are printing 
a standard report, the entity currency associated with the site is inserted. If you are printing an 
advanced report and are printing the report for multiple sites, the drop-down list shows the 
tracking currencies shared by the selected sites. If no shared tracking currencies are found, “Not 
Available” is inserted. You cannot run the report if a shared tracking currency is not found. Clear 
site selections until a shared tracking currency ID is displayed in the drop-down list.

5 In the Transactions section, select the type of transactions you would like to view. We recommend 
running the report twice: once for unposted transactions and once for posted transactions.

6 In the Sequence section, select the sort order for the report. Your choices are by Transaction ID, 
G/L Account ID or by Type, Project ID, Transaction ID.

7 Clear the Current User Only check box to view transactions from all users in the report.

8 Click Ok. 

Deferred Revenue Report (Commercial Revenue Recognition)
The Deferred Revenue report shows revenue recognition transactions for the period. This reports 
displays information for non-project transactions.

1 From the Receivables menu, select Progress Billing Entry. 

2 In the Progress Billing Entry window, click the Site ID arrow and select the site to use.

3 From the File menu, select Print Deferred Revenue Status Report. 

4 In the Print Deferred Status dialog box, specify this information: 

5 In the Starting Date field, enter the first day of the period you would like to close. In the Ending 
Date field, enter the last day of the period you would like to close.

6 In the Customers section, select All Customers to view information for all customers. This 
provides a complete view of the period.

7 In the Orders section, select All Orders to view information for all orders. This provides a 
complete view for the period.

8 In the Sequence section, select a sort order for the report. Your choices are by Order ID or by 
Customer.

9 In the Type section, select Detail. The detailed report provides more granularity to the 
information.

10 Click Ok. 

If there was any commercial revenue recognition for the period, it would appear in the 
Recognized Rev column.
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Milestone Status Report
Use the Milestone Status Report to review progress billings that are ready to be triggered for your 
commercial transactions. 

1 From the Progress Billing Window, select File, Print Milestone Status Report. 

2 In the Print Milestone Status dialog box, specify this information:

3 In the Starting Date field, enter the first day of the period you would like to close. In the Ending 
Date field, enter the last day of the period you would like to close.

4 In the Show Events section, select Ready to Trigger to review events that are ready to be 
processed. If you would also like to see the events that have already been triggered during the 
time period, select the Already Triggered check box as well.

5 In the Customers section, select All Customers to review a comprehensive set of data.

6 In the Sequence section, select the sort order for the report. You can choose to sort the report by 
Order ID or Customer ID.

Click Ok. 

Reports to Assess Costed Transactions
Use these reports to assess the transactions that may be or have been affected by the Costing 
Utilities.

Inventory Valuation Report
Run the Inventory Valuation Report to view a break down of the total value for all parts in your current 
inventory. You should run the report twice: once to review project transactions and once to review 
non-project transactions. To run the report:

1 From the Inventory menu, select the Inventory Valuation Report. 

2 In the Inventory Valuation Report window, click the Site ID(s) arrow and select the sites to use.

3 In the Report Type section, select Show Cost Layer Detail. When you select this option, the Cost 
Layer Detail Options and Transaction Detail Options become available.

4 In the Selection Criteria section, select Part ID if you are running your commercial inventory 
valuation. Select Warehouse ID if you are running your project inventory valuation.

5 If you selected Warehouse ID in step 3, choose a sort order for your report.

Warehouse/Part

Warehouse/Location/Part

Warehouse/WBS/Part

Warehouse/Location/WBS/Part
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6 If you chose Part ID in the step 3, the sort order for the report by default is part ID.

7 Select an option in the Cost Layer Detail Options section. Your choices are:

Show all parts in range

Show parts with zero cost layers only

Show parts w/neg bal cost layers

We recommend selecting Show all parts in range.

8 Click the Print button. 

Work In Process Posted Value
To view the actual posted costs for your work in process, run the Work in Process Posted Value 
report. This report displays information for both project and non-project transactions.

1 From the Eng/Mfg menu, select Work In Process Report. 

2 In the Work In Process Report dialog box, click Print current work in process value for open 
orders. 

3 Click the Site ID(s) arrow and select the sites to use.

4 In the Selection section, select Use Posted Value. The options in the WIP costing method section 
become unavailable.

5 Select Include Active ECN’s for a complete report.

6 Click Ok. 

General Journal Report
To view all general journal transactions, run the General Journal Report. This report displays 
information for both project and non-project transactions.

1 From the Ledger menu, select General Journal Entry. 

2 In the General Journal Entry window, select File, Print General Journals. 

3 Do one of these steps:

• To print a standard report, click the Standard tab, and specify this information:

Site ID – If you are licensed to use multiple sites, click the Site ID arrow and select the site for 
which to view G/L Transactions. If you are licensed to use a single site, this field is 
unavailable.

By Accounting Period – Click this option to generate the report by accounting period.

End Date of Accounting Period – Click the Calendar button to select any date within an 
accounting period, or enter the end date in the field provided.
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The ending date of the accounting period is automatically determined.

Fiscal Period – The fiscal period is entered when an end date is selected. 

• To print an advanced report, click the Advanced tab. Specify this information:

Report Calendar ID – Click the Report Calendar ID arrow and select the reporting calendar 
to use for the report. 

Fiscal Year – Click the Fiscal Year browse button and select the fiscal year for the report. 

Site ID(s) – Click the Site ID(s) arrow and select the sites to include in the report. When you 
select multiple sites, shared tracking currencies are identified and inserted in the Report 
Currency field. If a shared tracking currency does not exist, “Not Available” is inserted in the 
Report Currency field. If “Not Available” is displayed, clear site selections until a shared 
currency can be identified.

4 Click the arrow beside the Report Currency ID to select a currency from the list. If you are printing 
a standard report, the entity currency associated with the site is inserted. If you are printing an 
advanced report and are printing the report for multiple sites, the drop-down list shows the 
tracking currencies shared by the selected sites. If no shared tracking currencies are found, “Not 
Available” is inserted. You cannot run the report if a shared tracking currency is not found. Clear 
site selections until a shared tracking currency ID is displayed in the drop-down list.

5 In the Sequence section, select the order for the report. Your choices are By Account ID, By 
Batch ID and By Batch Type.

6 In the Type section, select Detail. When you select detail, the options in the Detail section 
become available.

7 In the Detail section, select Costing Detail.

8 Click Ok. 

Reports Used to Reconcile the Balance Sheet
This report is used to reconcile project transactions. It corresponds to step eleven in the Closing 
Procedures. The Labor Ticket Report and Project Billing Report are also used to reconcile project 
transactions.

Cash G/L Transactions Report
This report displays information for both project and non-project transactions. To print the Cash G/L 
Transactions Report:

1 From the Cash menu, select Cash Book. 

2 In the Cash Book window, select File, Print G/L Transactions. 

3 Do one of these steps:

• To print a standard report, click the Standard tab, and specify this information:
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Site ID – If you are licensed to use multiple sites, click the Site ID arrow and select the site for 
which to view G/L Transactions. If you are licensed to use a single site, this field is 
unavailable.

By Accounting Period – Click this option to generate the report by accounting period.

End Date of Accounting Period – Click the Calendar button to select any date within an 
accounting period, or enter the end date in the field provided.

The ending date of the accounting period is automatically determined.

Fiscal Period – The fiscal period is entered when an end date is selected. 

• To print an advanced report, click the Advanced tab. Specify this information:

Report Calendar ID – Click the Report Calendar ID arrow and select the reporting calendar 
to use for the report. 

Fiscal Year – Click the Fiscal Year browse button and select the fiscal year for the report. 

Site ID(s) – Click the Site ID(s) arrow and select the sites to include in the report. When you 
select multiple sites, shared tracking currencies are identified and inserted in the Report 
Currency field. If a shared tracking currency does not exist, “Not Available” is inserted in the 
Report Currency field. If “Not Available” is displayed, clear site selections until a shared 
currency can be identified.

4 Click the arrow beside the Report Currency ID to select a currency from the list. If you are printing 
a standard report, the entity currency associated with the site is inserted. If you are printing an 
advanced report and are printing the report for multiple sites, the drop-down list shows the 
tracking currencies shared by the selected sites. If no shared tracking currencies are found, “Not 
Available” is inserted. You cannot run the report if a shared tracking currency is not found. Clear 
site selections until a shared tracking currency ID is displayed in the drop-down list.

5 Select a sequence for the report. Your choices are By G/L Account ID or By Bank Account ID, 
Adj ID.

6 In the Transactions section, select Print Posted Txs to view the transactions you just posted.

7 Clear the Current User Only to view transactions entered by all VISUAL users.

8 Click Ok. 

A/R Aged Receivables
This report displays information for both project and non-project transactions. To print the A/R Aged 
Receivables report.

1 From the Receivables menu, select Invoice Entry. 

2 In the Invoice Entry window, select File, Print Aged Receivables. 

3 In the Print Aged Receivables dialog box, click the Site ID(s) arrow and select the sites to use.

4 In the Receivable Account field, select the account for which you would like to view information. 
Select All to view all accounts.
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5 In the As of Date field, enter the last day of the period you closed.

6 In the Report Type section, select the level of detail for the report. Your choices are Summary, 
Detail, and Detail with payment history.

7 In the Aging basis section, select Invoice Date to start the aging clock from the invoice date. 
Select Due Date to start the aging clock from the due date.

8 In the Sort By section, select the sort order for the report. Select Currency ID to sort the report by 
currency ID. Select Customer ID to sort by Customer ID or Customer Name to sort by customer 
name.

9 In the Invoices section, select All Invoices to view all invoices in the report. To view invoices of a 
particular currency only, select All Invoices of Currency, then click the arrow to select the 
currency.

10 Select the exchange rate for the report. Select Current rate to use the current rate or Invoice 
rate to use the exchange rate as of the date of the invoice. 

11 In the Customers section, select All Customers to view all customer aging. To choose a specific 
customer, select Customer, then click the Customer ID button to select the customer.

12 Click Ok. 

A/P Aged Payables
This report displays information for both project and non-project transactions.

1 From the Payables menu, select Invoice Entry. 

2 In the Invoice Entry window, select File, Print Aged Payables. 

3 In the Print Aged Payables dialog box, click the Site ID (range) arrow and select the site(s) to 
use.

4 In the Payable Account field, select the account for which you would like to view information. 
Select All to view all accounts.

5 In the As of Date field, enter the last day of the period you closed.

6 In the Report Type section, select the level of detail for the report. Your choices are Summary or 
Detail.

7 In the Aging basis section, select Invoice Date to start the aging clock from the invoice date. 
Select Due Date to start the aging clock from the due date.

8 In the Sort By section, select the sort order for the report. Select Currency ID to sort the report by 
currency ID first. Select Vendor ID to sort by Vendor ID or Vendor Name to sort by vendor name.

9 In the Invoices section, select All Invoices to view all invoices in the report. To view invoices of a 
particular currency only, select All Invoices of Currency, then click the arrow to select the 
currency.

10 Select the exchange rate for the report. Select Current rate to use the current rate or Invoice 
rate to use the exchange rate as of the date of the invoice. 
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11 In the Vendors section, select All Vendors to view all vendor aging. To choose a specific vendor, 
select Vendor, then click the Vendor ID button to select the vendor.

12 Click Ok. 

Inventory Balance Report
This report displays information for both project and non-project transactions.

1 From the Ledger menu, select Post Manufacturing Journals. 

2 In the Post Manufacturing Journals window, select Reports, Inventory Balances. 

3 Do one of these steps:

• To print a standard report, click the Standard tab, and specify this information:

Site ID – If you are licensed to use multiple sites, click the Site ID arrow and select the site for 
which to view G/L Transactions. If you are licensed to use a single site, this field is 
unavailable.

End Date of Accounting Period – Click the Calendar button to select any date within an 
accounting period, or enter the end date in the field provided.

The ending date of the accounting period is automatically determined.

Fiscal Period – The fiscal period is entered when an end date is selected. 

• To print an advanced report, click the Advanced tab. Specify this information:

Report Calendar ID – Click the Report Calendar ID arrow and select the reporting calendar 
to use for the report. 

Fiscal Year – Click the Fiscal Year browse button and select the fiscal year for the report. 

Site ID(s) – Click the Site ID(s) arrow and select the sites to include in the report. When you 
select multiple sites, shared tracking currencies are identified and inserted in the Report 
Currency field. If a shared tracking currency does not exist, “Not Available” is inserted in the 
Report Currency field. If “Not Available” is displayed, clear site selections until a shared 
currency can be identified.

4 Click the arrow beside the Report Currency ID to select a currency from the list. If you are printing 
a standard report, the entity currency associated with the site is inserted. If you are printing an 
advanced report and are printing the report for multiple sites, the drop-down list shows the 
tracking currencies shared by the selected sites. If no shared tracking currencies are found, “Not 
Available” is inserted. You cannot run the report if a shared tracking currency is not found. Clear 
site selections until a shared tracking currency ID is displayed in the drop-down list. Leave the 
Starting and Ending Part ID fields blank to view all parts.

5 In the Sequence section, select G/L Account ID. This will make reconciling the report with the 
General Ledger easier.

6 Click Ok. 
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EAC/POC Report
Use this report to reconcile project transactions. To run the report:

1 From the Project menu, select Project Summary Window. 

2 In the Project Summary Window, select File, Print EAC/POC Report. 

3 To generate the report for the project currently selected in the Project Summary window, click 
Current Project. Specify the EAC version to view in the Version ID field.

To generate the report for a different project or range of projects, click Range of Projects. Click 
the Site ID arrow and select the site the use, then specify the projects to view in the Starting 
Project ID and Ending Project ID fields. To view a single project, specify the same project ID in 
both fields. To view all projects, leave both fields blank.

4 In the Filter section, leave the Project Type field blank to view all project types in the report.

5 In the Summary of Actuals and Cost of Goods Sold section, enter any date of the period you 
would like to close in the last day of the period you are closing in the Begin Account Period Date 
and End Accounting Period Date field.

6 Click Ok. 

If the actual amounts do not match the formal amounts, you may want to update your EAC for the 
project.

Printing Project WIP Balance Reports
Use this report to reconcile project transactions. To print WIP balance reports for your non-
commercial projects:

1 From the Ledger menu, select Post Manufacturing Journals. 

2 In the Post Manufacturing Journals window, select Reports, Project WIP Balances. 

3 In the WIP Balance Inquiry for Project window, click the Site ID arrow and select the site to use.

4 In the End Date of Accounting Period field, enter any date within the accounting period you would 
like to view, or click the Calendar button to select a date. The date is adjusted to the last date of 
the period and the Fiscal Period is determined. 

5 In the Report Currency field, enter a currency by clicking the arrow and selecting a currency. You 
can choose from the entity currency or any tracking currency.

6 In the Status section, select the Released Only check box to view information for projects that 
have been released. Clear the check box to view all projects.

7 Select a sequence in the Sort section. The fields in the window change depending upon the sort 
order you choose. The inquiry or report are sorted by the sequence you choose. Your choices 
are:

G/L Account ID

Project ID
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Project Type

8 If you selected G/L Account ID in the Sort section, enter information in the following fields:

Starting Account ID and Ending Account ID - Click the Browse button to select a starting 
account ID and an ending account ID, or enter account IDs in the Account ID fields. The report 
displays information for all the accounts that fall within the range you specify. To print all accounts, 
leave these fields blank.

If you selected Project ID in the Sort section, enter information in the following fields:

Starting Project ID and Ending Project ID - Click the Browse button to select a starting project 
ID and an Ending project ID, or enter project IDs in the project ID fields. The report displays 
information for all the accounts that fall within the range you specify. To print all projects, leave 
these fields blank.

If you selected Project Type in the Sort section, enter information in the following fields:

Starting Project Type ID and Ending Project Type ID - Click the Browse button to select a 
starting project type ID and an ending project type ID, or enter project type IDs in the Project Type 
ID fields. The report displays information for all the project types that fall within the range you 
specify. To print all project types, leave these fields blank.

9 In the Mode section, select Inquiry Only to view the results of your query in the table. Select 
Report Only to output the results of your query as a report.

10 If you select Inquiry Only in step 8, the results of the query appear in the table when you click Ok. 
If a plus sign appears in the Sum column, you can double click the row header to view more 
detailed information. You can continue to drill down to individual transactions.

11 If you select Report Only in step 8, select the output for the report. Click the arrow and choose 
one of the following options from the menu:

Print - Select this option to output the file to a printer.

View - Select this option to see what the printed output looks like before you print it.

File - Select this option to save the WIP Balances Report to a text file. You can edit the report 
using any text editor.

E-mail - Select this option to send the report as an .RTF (rich text file) attachment through your 
electronic mailing system.

12 Select the type of report you would like to view. You can view a summary report, summary with 
sub-totals report, or a detailed report with or without burden detail.

Summary Report - Select the Summary button to output a summary report. The summary report 
by G/L account displays the G/L account ID, the account description, the total debit amount, and 
the total credit amount. The summary reports by project or project type shows the project ID or 
project type ID, project or project type description, status, type, material cost, labor cost, burden 
cost, service cost, and total value. 

Detailed Report - Click the Detail button to view a detailed report. Detailed reports show all of the 
transactions by type flowing in and out of the G/L accounts. The information includes transaction 
ID, transaction date, project ID, and project summary ID along with the debit and credit amount for 
each line item. Detailed reports by project show all the transactions by type for each project. 
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Transactions include purchased materials, WIP issues, WIP labor, vouchers, and inventory 
adjustments. Detailed reports by project type show the same information as detailed reports by 
project ID, only the transactions are shown by project type.

Summary with Sub-Totals Report - Select the Summary w/Sub-Totals button to output a 
Summary with Sub-Totals Report. The summary with sub-totals reports show the same 
information as the summary reports, but the information in broken down by transaction.

Detailed Report with Burden Detail - Select the Detail Report with Burden Detail button to 
view burden detail in the report. You can only print detailed reports with burden detail for project 
IDs and project types. The reports show the same information as the detailed reports, but burden 
costs are broken down by burden category ID.

13 Click OK to output the information. 

PO Accrual Report
Use this report to help reconcile PO accrual. Compare the information in this report to the information 
in the Uninvoiced Receivers Report Detail. Use this report for both project and non-project 
transactions.

1 From the Ledger menu, select Post Manufacturing Journals. The Post Manufacturing Journals 
window appears.

2 In the Post Manufacturing Journals window, select Reports, PO Accruals. 

3 In the Print PO Accrual dialog box, in the Print Selection section, click the Site ID(s) arrow and 
select the sites to use.

4 In the Date in Accounting Period field, specify a date that falls within the period you would like to 
close. The date is adjusted to the last day in the period and populates the Fiscal Period field.

5 Select the Summary check box to view a summary report. Leave the Summary check box blank 
to view a detailed report.

6 Click Ok. 
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